
S01t.- Introducción a la asignatura de  

Ingeniería de Producto Asistido por Ordenador  

(IPAO)  

con  

Catia v5 

y  

SolidWorks. 
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• Presentación Asignatura 
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• Descripción 
La asignatura de ingeniería de producto industrial asistida por ordenador pretende mostrar 
al alumno las herramientas informáticas actuales que permiten verificar el correcto 
funcionamiento y optimizar un diseño de algún tipo de producto industrial. La asignatura es 
transversal enfocando los casos de estudio de cada alumno en función de su optatividad 
elegida de cara a la intensificación del máster. 

Para los eléctricos se analizarán módulos que permiten diseñar el cableado, colocar 
motores, interruptores y todo tipo de circuitería. 

Para los energéticos los casos de estudio se centraran en el estudio de temperaturas, 
dilataciones, transferencia de calor y eficiencia energética. Además se abordará el cálculo 
del consumo energético en la fabricación del producto. 

Para los mecánicos los casos prácticos evaluarán el correcto dimensionamiento de las 
piezas para evitar su fractura, para evitar resonancias, analizar las cargas aerodinámicas, 
permitir el ensamblaje y diseñar la maquinaria adecuada. 

Para los de intensificación de materiales se analizará la posibilidad de definir diferentes 
leyes de material a la hora de simular y se analizará el coste de compra de materiales en 
función del proceso de fabricación elegido llegando a dimensionar los moldes y la inyección 
de plástico como un ejemplo práctico. 

La asignatura pretende dar a conocer al alumno los diferentes módulos disponibles con 
software disponible en el aula y software libre y educacional para descarga del alumno en 
su portátil.  
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• Carga Académica 

Teoría y prácticas en sala IPAO.  

Distribución de la asignatura: 

 ~ 20 [h.] en 20 sesiones teóricas de 1 hora.  

 ~ 40 [h.] en 20 sesiones prácticas de 2 horas. 

  ~3 [h.] de Examen de Marzo.  

Para instalar Catia: 

"\\sdoc2\Asignaturas\Exp_Grafica\DAO\CatiaV5R20_32_Y_64bits\instrucciones.txt"  

Para conseguir SOLIDWORKS seguir las indicaciones de: 

"\\sdoc1\Software\Exp_Grafica\SolidWorks_2013_64bits\sldim\sldIM.exe"  
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• Contenidos 

1.- Introducción a software disponible. 

2.- Configuración e infraestructura. 

3.- Tablas de diseño y parametrización.  

4.- Macros y powercopies. 

5.- Superficies. 

6.- Digitalización y sketch tracing para 

diseño. 

7.- Doblado de chapa. 

8.- Moldes y matrices. 

9.- Inyección plástico (SW) y FDM (Axon) 

10.- Optimización geométrica. 

 

11.- Rigidez estática  

12.- Vibraciones 

13.- Cinética (SW) 

14.- Dilataciones y transferencia de calor 

15.- Fluidodinámica interna y externa (SW) 

16.- Estudios ergonómicos (Catia) 

17.- Costes de fabricación (SW) 

18.- Impacto mediambiental y análisis de 

ciclo de vida (SW) 

19.- Repaso y ejercicios 

20.- Repaso y ejercicios Univ
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• Evaluación 

 Examen-Marzo 4.00p. (NOTA MÍNIMA 5.00) 

 4.00p. (1.0 x 4.00) Ejercicio Catia y SolidWorks.  

 Controles 2.00p. (NOTA MÍNIMA 5.00) 

 2.00p. (1.0 x 4.00) Controles de clase.  

 Trabajos (2) en grupo a entregar el penúltimo día de laboratorios y defender el 
último 2.00p. (NOTA MÍNIMA 5.00) 

 1.50p. (0.75 x 2.00) Documento del proyecto incluyendo justificación, 
despieces, planos y croquis a mano alzada. El documento debe llevar un CD 
adjunto con toda la documentación.  

 0.50p. (0.25 x 2.00) Póster en tamaño A3 del proyecto.  

 Trabajos con Catia y SolidWorks realizados en laboratorios 2.00p. (NOTA 
MÍNIMA 5.00)  

 2.00p. (1.00 x 2.00) Entregar ejercicios de laboratorio.  Univ
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• Normativa 

 La asistencia a clase es obligatoria. Se aceptan 3 ausencias de las sesiones 

programadas.  

 Otras normativas se irán recogiendo y publicando durante el desarrollo del 

curso. 
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• Planificación 
Primer día Semana 1y3 Semana 2y4

inicio fin grA-B grC-D inicio fin grA-B grC-D grA-B grC-D

8.00am 8.15am 8.00am 8.15am

8.15am 8.30am 8.15am 8.30am

8.30am 8.45am 8.30am 8.45am

8.45am 9.00am 8.45am 9.00am

9.00am 9.15am 9.00am 9.15am

9.15am 9.30am 9.15am 9.30am

9.30am 9.45am 9.30am 9.45am

9.45am 10.00am 9.45am 10.00am

10.00am 10.15am 10.00am 10.15am

10.15am 10.30am 10.15am 10.30am

10.30am 10.45am 10.30am 10.45am

10.45am 11.00am 10.45am 11.00am

11.00am 11.15am 11.00am 11.15am

11.15am 11.30am 11.15am 11.30am

11.30am 11.45am 11.30am 11.45am

11.45am 12.00am 11.45am 12.00am

12.00am 12.15am 12.00am 12.15am

12.15am 12.30am 12.15am 12.30am

12.30am 12.45am 12.30am 12.45am

12.45am 13.00am 12.45am 13.00am

13.00am 13.15am 13.00am 13.15am

13.15am 13.30am 13.15am 13.30am

13.30am 13.45am 13.30am 13.45am

13.45am 14.00am 13.45am 14.00am

14.00am 14.15am 14.00am 14.15am

14.15am 14.30am 14.15am 14.30am

García-

IPAO

Odenadore

s

García-IPAO-PRY

N3

García-IPAO

Barberà- 

automática

García-

IPAO

Odenadore

s

Barberà-

automática

N3

García-

IPAO

Odenadore

s

García-IPAO-PRY

N3

Barberà-

automática

N3

Decanato

Barberà-

automática

N3

Barberà-

automática

N3

Barberà-automática

Barberà-

automática

N3

García-

IPAO

García-

IPAO

Barberà- 

automática

García-

IPAO

Odenadore

s

Barberà-

automática

N3
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• Proyectos anteriores 

Proyecto MAZEL - Cajero.  Proyecto EDDADesign - Mando minusvalidos. 

@ Carlos Carrasco 
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• Definición DAO 

DAO son las siglas de diseño asistido por ordenador. Es muy común usar las 

siglas en inglés CAD para Computer Aided Design.  

Definición en “http://www.ascad.es”:  

Conjunto de herramientas informáticas que asisten a ingenieros, arquitectos y a 

otros profesionales del diseño en sus respectivas actividades. El diseño asistido 

por computadora es, además, la herramienta principal para la creación de 

entidades geométricas enmarcadas dentro de procesos de administración del ciclo 

de vida de productos (Product Lifecycle Management), y que involucra software y 

algunas veces hardware especiales. Los paquetes actuales varían desde 

aplicaciones basadas en vectores y sistemas de dibujo en 2 dimensiones (2D) 

hasta modeladores en 3 dimensiones (3D) a través del uso de modeladores de 

sólidos y superficies paramétricas. Se trata básicamente de una base de datos de 

entidades geométricas (puntos, líneas, arcos, etc.) con la que se puede operar a 

través de una interfaz gráfica.  

(sigue página siguiente) 
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• Definición DAO 

(proviene de página anterior) 

Permite diseñar en dos o tres dimensiones mediante geometría alámbrica, esto 

es, puntos, líneas, arcos, splines, superficies y sólidos para obtener un modelo 

numérico de un objeto o conjunto de ellos. La base de datos asocia a cada 

entidad una serie de propiedades como color, capa, estilo de línea, nombre, 

definición geométrica, etc., que permiten manejar la información de forma lógica. 

Además pueden asociarse a las entidades o conjuntos de estas otro tipo de 

propiedades como el coste, material, etc., que permiten enlazar el CAD a los 

sistemas de gestión y producción. De los modelos pueden obtenerse planos con 

cotas y anotaciones para generar la documentación técnica específica de cada 

proyecto. 
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• Otros sistemas asistidos por ordenador 

 CAx (Computer Aided x) Es el nombre que se le da a todo el conjunto de 

disciplinas asistidas por ordenador CAD, CAE, CAS, CAM, etc. 

 CAS (Computer Aided Styling) Conjunto de herramientas informáticas 

orientadas al diseño conceptual de producto. Sirven para sacar el primer esbozo 

de lo que acabará siendo el producto fabricado, haciendo hincapié en el diseño. 

 CAE (Computer Aided Engineering) Conjunto de herramientas informáticas que 

ayudan a los ingenieros en tareas como análisis, simulación, etc.… para ver si el 

producto se ajusta a los requerimientos de dureza, o de seguridad en caso de 

colisión de un vehiculo (por ejemplo). También hay software para la simulación de 

la inyección de plástico en el diseño de un molde, o la simulación de estampación 

de chapa … 

 CAPE (Computer Aided Production Engineering) Las soluciones CAPE son 

herramientas informáticas para la simulación de los procesos de fabricación. 

Contemplan aspectos como la disposición de la maquinaria y el flujo de la materia 

prima. 
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• Otros sistemas asistidos por ordenador 

 CAM (computer Aided manufacturing) Las soluciones CAM son sistemas de 

programación para máquinas herramientas a partir de los datos CAD 

 CAMS (Computer Aided measure system). Las soluciones CAMS son sistemas 

de programacion para maquinas de medicion tridimensional a partir de los datos 

CAD. 

 DMU (Digital MockUp) Es una tecnología o conjunto de herramientas que 

permiten a los ingenieros visualizar un prototipo virtual antes de tener el prototipo 

físico para su validación.  

 PDQ (Product Data Quality) Herramientas informáticas utilizadas para la 

validación de la calidad de los modelos generados en el software CAD. Dentro del 

sector de la automoción, cada grupo obliga a las ingenierias que trabajan para 

ellos un estándar de calidad que han de cumplir, y los softwares que han de 

utilizar para cumplirlos, como podrian ser VALIDAT, Q-Checker, Endcheck… Univ
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• Otros sistemas asistidos por ordenador 

 PLM Product Lifecycle Management (PLM), es el proceso que administra el 

ciclo de vida completo de un producto desde su concepción, pasando por su 

diseño y fabricación, hasta su servicio y eliminación. PLM es una serie de 

capacidades que permiten a una empresa administrar e innovar efectivamente sus 

productos y servicios relacionados a lo largo de su vida económica.  Es uno de los 

cuatro pilares de la estructura ´´TI´´ de una corporación. Todas las empresas 

necesitan administrar la comunicación y la información con sus clientes 

(Administración de la Relación con Clientes o 'Customer Relationship 

Management' - CRM), con sus proveedores (Administración de la Relación con 

Proveedores o 'Supply Chain Management' - SCM) y de los recursos de la 

empresa (Planificación de los Recursos Empresariales o 'Enterprise Resource 

Planning' - ERP). Además, empresas ingenieriles de manufactura deben 

desarrollar, describir, administrar y comunicar información acerca de sus 

productos.  
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• Otros sistemas asistidos por ordenador 

 PDM (Product Data Management): Conjunto de herramientas informáticas 

destinadas a crear y manejar relaciones entre los conjuntos de datos que 

componen un producto, y las almacena en una base de datos. Estos conjuntos de 

datos están formados principalmente por la geometría, diseño, BOM (conjunto de 

materiales) y todos los cálculos asociados a las fases de desarrollo del producto. 

Las herramientas PDM mas importantes utilizadas actualmente son Smarteam (de 

Dassault Systemes) y Winchild (de PTC) 

 

Para más información sobre sistemas CAx visitar “http://www.ascad.es/”.  
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• Justificación estudio CAD. 

Existe una demanda creciente de ingenieros con conocimientos CAD. 

Si hacemos una búsqueda de empleo para Ingenieros en Barcelona en La 

Vanguardia “http://www.servijob.com/” encontramos lo siguiente (búsqueda 

28.09.2007): 

 892 ofertas de ingenieros. 

 870 con la palabra CAD !! 

 2 especifican que sea Catia. 

 11 AutoCAD.  

 3 Solidworks.  

El 20 de Septiembre de 2010 en plena crisis hay 1 oferta CAD, 1 Catia y 1 

SolidWorks ed las 12 plazas de ingeniero en Barcelona. Consulta: 

"http://www.yaencontre.com/empleo/trabajo/filtros_q.catia" Univ
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• Justificación estudio Catia v5. 

Muchas de las grandes empresas usan Catia v5 y fuerzan a los pequeños 

proveedores e ingenierías a usar dicho sistema. Es conocido que una de las 

razones por las que Serra Soladura “http://www.serrasold.com/” consiguió los 

contratos de Airbus es por el uso que hace de Catia v5. 

Empresas que piden uso de Catia v5: 

 SEAT (Grupo VW)  EDAG, ITALDESIGN, BERTRANDT, RUECKER . . . 

 AIRBUS  SERRASOLDAURA 

 JJUAN 

 Mazel 

En UPC el curso no está incluido y se paga aparte fundamento 420€, y el básico y 

el avanzado de 32 horas por 375€. 

Consulta 2.10.201 en http://catedraseat.upc.edu/formacion/cursos/  
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• Justificación estudio SolidWorks. 

SolidWorks ha vendido el Software a más de 300 empresas en la península 

ibérica de las cuales un alto porcentaje está en Cataluña. Además la razón por la 

que las empresas eligen SolidWorks es por su capacidad de aportar decisiones de 

ingeniería en diseño vendiendo la licencia de Simulation y Flow a un 66% de las 

empresas. 

Ejemplo de empresas que piden uso de SolidWorks: 

 FAINSA 

 HENKEL 

 EDDADesign 

 LLEAL 
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• Comparativa sistemas CAD. 

Definiciones de “http://www.ascad.es/”.  

CATIA Software CAD de alto nivel. La versión actual es la 5, refiriéndonos a ella 

como Catia5. A diferencia de la versión anterior (Catia4), Catia5 funciona sobre 

plataforma windows, mientras que Catia4 solo funcionaba sobre estaciones UNIX. 

Pertenece a Dassault Technologies. 

 Pro/ENGINEER Software CAD de alto nivel. La versión actual es la “Wildfire”, la 

versión anterior se llamaba “2001”. Pertenece a PTC (Parametrics Technologies) 

 AutoCAD Software de diseño CAD de la casa Autodesk, muy extendido en 

arquitectura, permite desarrollo tanto 2D como 3D, orientado a desarrollos con una 

exigencia media. El formato de sus archivos es DWG o DXF. 

 Microstation Software de diseño CAD de la casa Bentley Systems, utilizado en 

desarrollos de exigencia media o baja. Su formato nativo es el DGN aunque 

puede leer y escribir en formato AutoCAD (DWG/DXF) 

(sigue página siguiente) 
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• Comparativa sistemas CAD. 

(proviene página anterior) 

 Inventor Software de diseño CAD orientado a la generación de sólidos 

parametrizados. Utilizado para niveles de exigencia media. 

 SolidWorks Software CAD para diseño de sólidos en 3D, para niveles de 

exigencia medio/bajo. 

 VOBES  Sistema CAD de diseño eléctrico que permite la gestión integral del 

desarrollo de cableado. 

 ICEM/Surf Sistema utilizado en diseño de superficies. 

El número de programas CAD disponibles es cada día más extenso y con más 

posibilidades de trabajo. 

Por ejemplo Dassault Systems posee dos programas potentes CAD (Catia y 

SolidWorks y ha comprado un programa puntero de cálculo CAE llamado 

ABAQUS y otro más accesible COSMOS). 
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• Comparativa sistemas CAD. 

Para poder comparar sistemas CAD se suele crear una matriz por temas como en 

“https://www.alibre.com/AlibreLibraries/ftp/inforequest/comparison-checklist-sw.xls” que 

compara Alibre con SolidWorks por temas (ya no está disponible en la web): 

 Precio. 

 Modelado de partes. 

 Esquemas 2D y 3D. 

 Formación de piezas metálicas. 

 Ensamblaje de piezas en conjuntos. 

 Planos. 

 Historial de procesos. 

 Documentación  

 Intercambio de datos CAD . . . 
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• Objetivo asignatura IPAO. 

 Aprender a usar Catia v5 para el diseño de piezas, ensamblajes y creación de planos 

para fabricación de las mismas. 

 Conocer la filosofía de trabajo de un programa paramétrico para optimizar el rendimiento 

en el uso de dichas herramientas. 

 Aprender a trabajar con ficheros de otros estudiantes para simular el entorno de trabajo 

real en el que se trabaja con otros proveedores. Este objetivo se llevará a cabo mediante el 

proyecto. 

 Aprender a estimar los tiempos de realización de trabajaos CAD para poder dirigir un 

equipo de delineantes o aceptar una presupuesto adecuado en el caso de contratar el 

diseño fuera. 
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• Workbenches curso en Catia v5 R19 ( 5+8+6=19 de 99).  

. 
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• Instalación Catia v5 R22 SP4 en SALA DAO. 

Comenzar instalando los prerequisitos desde: 

“InstallDSSoftwareVC9Prerequisites_x86_x64.msi”  
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• Instalación Catia v5 R19 SP5 en SALA DAO. 

Comenzar instalando el servidor de licencias desde: 

"\\sdoc\software\PUBLIC\Exp_Grafica\Catia_V5_R19_sp5\LUM\winintel\arkwin468.exe". 
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• Instalación Catia v5 R19 SP5. 
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• Instalación Catia v5 R19 SP5. 

  

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S01t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 28 

• Instalación Catia v5 R19 SP5. 

Accedemos a instalación de Catia desde 

"\\sdoc\software\PUBLIC\Exp_Grafica\Catia_V5_R19\cd\setup.exe"  
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• Instalación Catia v5 R19 SP5. 
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• Instalación Catia v5 R19 SP5. 

Actualizar el Catia a Service Pack 5 desde: 

"\\sdoc\software\PUBLIC\Exp_Grafica\Catia_V5_R19\sp5\INTEL\startspk.exe"  
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• Instalación Catia v5 R19 SP5. 

  

Aceptar, OK, cerrar Catia y volver a abrir. 
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EJEMPLO DEFINICIÓN RETROVISOR: MOTIVACIÓN 
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EJEMPLO DEFINICIÓN RETROVISOR: ESTUDIO MERCADO 

 

   . 
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DESPIECE PROPUESTO 
1.- Varilla con esfera y rosca de M8 (experiencia muestra  

mejor métrica fina izquierda y derechas). 

2.- Pieza de goma cubre varilla. 

3y4.- Carcasas de plástico (experiencia dice mejor 

PA-GF para stress cracking). 

5.- Tornillo de presión 

6.- Espejo 

7.- Tuerca    

PIEZAS A ELIMINAR 

8.- Plaqueta de apriete. 

9.- Tapeta. 

10,11.- Dos de los tres tornillos originales 

NUEVA 

8.- Chapa doblada similar a plaqueta apriete 
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PLIEGUE DE CONDICIONES SIMPLIFICADO 

 

1. El retrovisor ha de pesar menos que el mostrado como referencia para un espejo de 

iguales dimensiones. 

2. El retrovisor se ha de ajustar a diseños en papel de espejo (Parámetro C) y modelos a 

escala (Parámetro D) realizados por el diseñador de la empresa. 

3. El retrovisor se ha de desmontar y montar para reparación de algún componente. 

4. El retrovisor se ha de poder doblar con una fuerza de 100[N] (Parametro F). 

5. El retrovisor se ha de mantener estable con desplazamiento inferiores a 1mm a 

velocidades de 120 [km/h] (Parámetro V). 

6. El retrovisor ha de tener frecuencias propias por encima de 40 [Hz] para evitar 

acoplamientos por resonancia.  

7. Las piezas de plástico se han de poder inyectar en menos de 1 segundo con espesor 

2mm (Parámetro E). 
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PESOS DE REFERENCIA 

 

TOTAL:  202.76 gr. 

 

1.-  69.21 gr. 

2.- 21.98 gr. 

3,4,6.- 90.72 gr. 

5,10,11.-   3.93 gr. (3x1.31) 

7.-   4.70 gr. 

8.-   6.10 gr. 

9.-   6.12 gr. 

Suma: 202.76 gr.  
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DISEÑOS 

 

A la hora de diseñar el conjunto hay partes que necesitan incorporar un cierto diseño 

atractivo y otras que se pueden medir con pie de rey y se pueden obtener de tablas de 

elementos normalizados. Por ejemplo de la tuerca M8 vemos que la barra es de d=8mm. 
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Dibujamos encima de los Croquis del diseñador para ir definiendo nuestras piezas. Esta 

tarea es fácil para piezas planas o sencillas en 3D. Como ejemplo copiaremos el espejo. 
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Para la carcasa del espejo necesitamos usar un escáner 3D para intentar copiar la 

geometría que requiere el diseñador. 
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Finalmente cogemos un elemento normalizado de tornillería y tuerca. 
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A la hora de definir el apriete del plástico con la cabeza esférica consultamos la 

documentación. 
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CÁLCULOS FLUIDOS 

 

Antes de iniciar el cálculo de fluidos vamos a hacer una estimación de las fuerzas 

considerando el conjunto similar a un cilindro de radio 50mm y longitud 200mm.  

Primero calculamos el número de Reynolds  

Re=dvd/m=1.2*33.33*0.1/(1.827e-5)=2.1e5 

Con este número estima el coeficiente de Drag CD=1 

Finalmente calculamos la fuerza como: 

FD=CD*0.5*d*v2A=1*0.5*1.2*33.332*(0.1*0.2)=13.33[N] 

  

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S01t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 43 

CÁLCULOS FLUIDOS 

 

A 

  

El coeficiente aerodinámico conseguido 

mejora el de un cilindro. 
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CÁLCULO RESISTENCIA Y 
DILATACIONES 

Antes de comenzar con el cálculo de conjunto se suele 

comenzar por analizar las piezas de manera individual 

para ver si están bien dimensionadas. 

Para comenzar se somete la barra a 100[N] en la rótula 

esférica empotrando en la zona roscada. 

El resultado teórico es: 

MFlexión:100*0.11=11[N.m], smax_f=Mr/I=4Mf/(pr3) 

MTorsión:100*0.06=6[N.m], smax_t=Mr/I=2Mt/(pr3) 

Total: smax=2/(pr3)√((2Mf)
2+(Mt)

2)=14.5/r3. 

Para r=4[mm] estamos al límite smax=226.5[MPa] 

En cuanto a la fabricación se requiere: 

R>r(1/emax-1),  

para emax=10% R>9r, para emax=20% R>4r, 
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Realizando un primer cálculo se comprueba que hay 

zonas muy tensionadas en el empotramiento con los 

que la pieza ya está bastante optimizada en peso.  

Los valores superan ligeramente a los valores teóricos 

debido a las concentraciones de tensiones en el 

empotramiento. 
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Continuamos analizando la barra con mejor malla y mirando también los desplazamientos. 

Tras analizar los resultados se continúa con el acero actual que soporta 206[MPa] sin 

necesidad de encarecer con otro acero o tratamientos superficiales o térmicos. Nos 

aseguraremos que la rótula dobla con 100[N] para evitar roturas. 

En el caso de 

elegir un acero 

más resistente 

hay que 

aumentar el 

radio de doblado. 
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CÁLCULO RESISTENCIA Y DILATACIONES 

 

Con el fin de comprobar que se mantiene el apriete cuando el calor implica que el plástico se 

dilata más que el acero se pasa a realizar una simulación de dilataciones térmicas. 
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El desplazamiento máximo debido a la dilatación se produce en la punta con un valor de 

21 micras. No se  

prevén problemas de pérdida 

de interferencia en rótula. 
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CÁLCULO VIBRACIONES 
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MOLDES Y FABRICACIÓN 

 

Para comenzar el proceso de definir los moldes y otros 

procesos de fabricación utilizaremos de inicio la barra 

roscada definiendo un plano final y plano industrial paso 

a paso.  
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MOLDES Y FABRICACIÓN 

 

En el paso a paso definimos etapa inicial y final de cada máquina.  

E
x
p
e
ri
e

n
c
ia

 d
ic

e
 e

s
 

b
a
ra

to
 e

s
ta

m
p
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fo
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a
 

b
o
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MOLDES Y FABRICACIÓN 

 

Para definir los moldes es necesario incluir ángulo de desmoldeo. 
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MOLDES Y FABRICACIÓN 
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MOLDES Y FABRICACIÓN 
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PROYECTO FINAL 

 

x  
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Uno de los objetivos del proyecto era bajar 

el peso de 202.7 gr. El diseño actual es de 

142.7gramos. 

 

Por supuesto la falta de experiencia 

implica la necesaria realización de algún 

prototipo para comprobar que todo 

funciona correctamente. 
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Fotos de moldes prototipo. 
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• Grupos. 

Grupo F[N] V[km/h] E[mm] Croq.[-] Dig.[-] 

1 160 110 2.4 A180 A 

2 150 105 2.3 B160 B 

3 140 100 2.2 C180 C 

4 130 95 2.1 D160 D 

5 120 90 2.0 E180 E 

6 110 85 1.9 F160 F 

7 100 80 1.8 G170 G 

8 90 75 1.7 H150 H 
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• Modelos 3D. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S01t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 61 

• Grupos teoría. 

   

9 a 11 Barberà  

gr A y B semana 1 y 3 

gr C y D semana 2 y 4 

 

12.30 a 14.30 Barberà 

gr A y B semana 2 y 4 

gr C y D semana 1 y 3 

grA_1 Alsina Puertas, Alex

grA_1 Andreu de Beascoa, Maria

grA_2 Aparicio Corbella, Jordi

grB_5 Banzo Vila, Ignasi

grA_2 Blanch Fernández, Francesc

grA_2 Comas Barceló, Nil

grB_6 Cortiñas Villazon, Ignacio

grA_1 Duran Colls, Cristina

grA_3 Esteban Brugarolas, Loreto de

grB_6 Fernández Martínez, Guillermo

grB_6 Gassó Querol, Guillem

grA_3 López Espinós, Jan

grB_7 Muñoz Payán, Raúl

grB_7 Murias Closas, Aser

grB_7 Pastor Montellà, Sergi

grA_4 Planasdemunt Hospital, Ignasi

grB_8 Pont i Farré, Xavier

grB_5 Ramos Ferrer, Xavier

grA_4 Riera Golobart, Sergio

grB_8 Ros Matas, Luis

grB_8 Socías Alemany, Concepción

grA_4 Soldevila Aguado, Ignacio

grC_1 Aróstegui González, Carles de

grD_5 Batlle Sánchez, Borja

grC_1 Boquera Viñals, Salvador

grD_5 Calderón Romero, Eduard

grD_5 Carroggio Cabestany, Guillermo

grD_6 Esplugas Miró, Enric

grC_2 Farré Valentí, David

grC_2 Molinas Moya, Santiago

grD_6 Murcia Hernández de Herrera, Rafael

grC_3 Noguera Oliach, José María

grC_2 Oriol Segura, Josep

grC_3 Pintó Batista, Camila

grC_3 Ponjoan Serra, Jordi

grD_7 Rodríguez Rodríguez, Pablo

grD_7 Rull Trinidad, Josep

grD_8 Simón Sanz, José Antonio

grC_4 Solà Roca, Martí

grC_4 Torres Solanilla, Irene

grD_8 Valls Serra, Oriol

grD_8 Vives Sanjuan, Marc
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• Grupos proyecto retrovisor. 

   
grD_1 Carroggio Cabestany, Guillermo

grC_1 Farré Valentí, David

grC_1 Pintó Batista, Camila

grD_1 Simón Sanz, José Antonio

grC_1 Torres Solanilla, Irene

grA_2 Alsina Puertas, Alex

grB_2 Banzo Vila, Ignasi

grA_2 Comas Barceló, Nil

grB_2 Gassó Querol, Guillem

grB_2 Pont i Farré, Xavier

grB_2 Ramos Ferrer, Xavier

grC_3 Aróstegui González, Carles de

grC_3 Molinas Moya, Santiago

grB_3 Murias Closas, Aser

grC_3 Oriol Segura, Josep

grC_3 Ponjoan Serra, Jordi

grC_3 Solà Roca, Martí

grD_4 Batlle Sánchez, Borja

grD_4 Murcia Hernández de Herrera, Rafael

grD_4 Rodríguez Rodríguez, Pablo

grD_4 Valls Serra, Oriol

grD_4 Vives Sanjuan, Marc

grA_5 Aparicio Corbella, Jordi

grA_5 Duran Colls, Cristina

grA_5 Esteban Brugarolas, Loreto de

grB_5 Muñoz Payán, Raúl

grA_5 Planasdemunt Hospital, Ignasi

grA_6 Blanch Fernández, Francesc

grB_6 Cortiñas Villazon, Ignacio

grB_6 Fernández Martínez, Guillermo

grA_6 López Espinós, Jan

grB_6 Ros Matas, Luis

grC_7 Boquera Viñals, Salvador

grD_7 Calderón Romero, Eduard

grD_7 Esplugas Miró, Enric

grC_7 Noguera Oliach, José María

grD_7 Rull Trinidad, Josep

grA_8 Andreu de Beascoa, Maria

grB_8 Pastor Montellà, Sergi

grA_8 Riera Golobart, Sergio

grB_8 Socías Alemany, Concepción

grA_8 Soldevila Aguado, IgnacioUniv
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• EVALUACION  

13.00 NOTA  

1.00 CD y papel presentación del documento con poster en A3. 

0.50  Espejo como croquis. 

0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.50 Ergonomía (C)  

0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.50 Logo empresa moto pegado en carcasa. 

0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.50 Módulo extra no explicado en clase  

0.50 Módulo extra no explicado en clase  

0.50 Módulo extra no explicado en clase  
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• Resumen.  

 Presentación de la asignatura y el profesor. 

 Presentación de la documentación existente. 

 Introducción a CAx. 

 Petición de instalación de SolidWorks2012 en portátiles. 

 Instalación de Catia v5 R19 y R20. 
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• Resumen.
 Definición de proyecto para el curso actual y tareas
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 “File -> Send to -> Directory”: Para asegurarnos que guardamos toda nuestra 
información necesaria en un único directorio. MUY IMPORTANTE a la hora de 
entregar los ejercicios. Si me llega el plano sin la pieza no podré visualizarlo.

• Gestión de menús “File”.
 “File -> Save Management”: Para visualizar que ficheros se han modificado y 
decidir que queremos guardar.
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• Gestión de menús “File”.
 “File -> Desk”: Para visualizar si los ficheros se han cargado correctamente y 
poder arreglar los cambios.

Negro descargado

Rojo no encontrado
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Esta opción se puede hacer para toda una serie de ficheros en “Background” desde “Tools -
> Options -> Utility -> CATDUAV5”. Nota: El “Batch Monitor” puede tardar unos segundos en 
aparecer.

• Gestión de menús “File”.
 “File -> Desk”: Para arreglar ficheros importados se les puede pasar un chequeo 
e intentar limpiar desde “Desk -> CATDUAV5”.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 6

• Gestión de menús “File”. Directorios.
Es importante establecer la configuración de Catia para que permita usar directorios. En las 
grandes empresas no se usan directorios. Se usan nombres de proyecto que se asignas 
como DLNames. Por ejemplo en SEAT existen un DLName SE250 para el Ibiza, AU416 
para el Audi Q5 ... Para el curso trabajermos con directorios desde “Tools -> Options 
-> General -> Document -> Folder”.
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• Gestión de menús “Edit”. 
A parte de las opciones comunes de copiar (Ctrl+C) y pegar (Ctrl+V), deshacer 
(Ctrl+Z) y rehacer (Ctrl+Y) hay que destacar las siguientes opciones:

 “Paste special” Permite muchas opciones dependiendo del Workbench en el que 
nos encontremos. Si estamos n “Assembly”
permite insertar componentes como 
resultado con lo que se pierde toda la 
información del árbol.

 “Search” para buscar elementos u 
operaciones dentro del árbol. Se usa por 
ejemplo para esconder todos los elementos 
determinados.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 8

• Gestión de menús “View”. 
El menú básico de vistas activa el árbol, la geometría y el 
compás tal y como vemos en la figura. La expansión del árbol
la podemos controlar desde este menú.

Además podemos controlar el zoom, rotaciones y movimientos.
Estas opciones de vista también están en la barra inferior. Con
el ratón estos movimientos se consiguen:

 Rotación: Apretar Ratón Central, Apretar Ratón Izquierdo, Girar pieza con los 
dos apretados. El centro de la rotación se elige con el botón central del ratón.

 Zoom: Apretar Ratón Central, Apretar Ratón Izquierdo, Soltar Ratón Izquierdo, 
Mover arriba y abajo con central apretado.

 Pan – Movimiento: Apretar Ratón Central, Mover con central apretado.

Es útil definir las vistas y usar la vista normal a la superficie seleccionada.
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• Gestión de menús “View” 2. 
Con la opción “View” -> “Render Style” -> “Perspective” hay varias formas de 
moverse por el modelo con “View” -> “Navigation”.

 Se aconseja el uso de “View” -> “Render Style” -> 
“Parallel” que sólo permite “Examine” para 
navegación. El resto de opciones necesitan de 
habilidad del usuario para no perderse dentro 
de la pieza.

 Para los estilos se puede pasar de sólido a alámbrico con el “View” -> “Render 
Style”. 
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• Gestión de menús “Insert”. 
El menú “Insert” depende del Workbench activo.

Sketch

Assembly

Part
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• Gestión de menús “Tools”. 
 “Tools” -> “Image” -> “Capture” para guardar imágenes que 
podemos ir insertando en el proyecto. Para imágenes 3D se 
recomienda usar pixelado mientras que para secciones es 
mejor usar formato vectorial pues se puede escalar sin empeorar.

 “Tools” -> “Formula” para parametrizar el dibujo.
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• Gestión de menús “Tools” 2. 
 “Tools” -> “Macros” para definir acciones que podemos repetir y editar con Visual 
Basic.

Para ejecutar comandos sobre muchos ficheros en el “Background”:

 “Tools” -> “Utility” -> “CatDuaV5” para arreglar errores del modelo.

 “Tools” -> “Utility” -> “Downward Compatibility” para poder grabar en formatos de 
Catia v5 anteriores al nuestro hasta Catia v5R6.

 “Tools” -> “Utility” -> “Batch-dxf-igs-step” para pasar a 
formato standard. Recomendado “iges” para 3D y 
“dxf/dwg” para planos.

 “Tools” -> “Customize" -> "Toolbars" -> y elegir "restore all contents" y "restore position"

 “Tools” -> “Customize" -> Definir favoritos: 
Part Design, Assembly Design, Drafting, 
Generative Shape Design.Univ

ers
ity
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• Gestión de menús “Tools” 3. 
Para las opciones hay muchos submenús.

Lo más interesante es saber hacer reset y luego 
configurar todo lo marcado en rojo:

 “Tools” -> “Options” -> “General” Todo es interesante 
excepto “Devices”. Comprobar tenemos P2. P1 es un 
básico como SolidWorks y P3 es un avanzado no 
a la venta para Airbus.
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• Gestión de menús “Tools” 4. 
 “Tools” -> “Options” -> “General” -> "General". Cambiar a “No automatic Backup” 
para que Catia no consuma recursos. 

 “Tools” -> “Options” -> “General” -> "General". Desactivar “Drag and Drop for 
Copy and Paste”.

 Tools” -> “Options” -> “General” -> "Help". Definir la ruta de los fichero del help 
"\\sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online". 2011 no disponible. SE 
puede ver en intranet 
//sdoc2/Asignaturas/Exp_Grafica/Catia_v5_R19doc/B19doc/English/online/CATIA_P3_default.htm

 “Tools” -> “Options” -> “General” -> “Document” -> "linked document location". 
Sólo las 4 primeras opciones "Yes" y resto desactivado.

“Tools” -> “Options” -> “General” -> “PCS”. Cambiar a número de “undo” que 
queremos que guarde Catia por ejemplo a 10 pasos.

 “Tools” -> “Options” -> “General” -> “Display”. Activar el "tree show/no show"Univ
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• Gestión de menús “Tools” 5. 
 “Tools” -> “Options” -> “General” -> “Display” -> ”Performance” 3D a 0,2mm por 
segmento y 2D 0,02mm por segmento, "level of detail" -> "static" puesto a cero.

 “Tools” -> “Options” -> “General” -> “Display” -> "Visualisation". Poner el color de 
fondo oscuro si no lo está.

 “Tools” -> “Options” -> "General" -> "Compatibility". Para pasar ficheros a otros 
formatos.
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• Gestión de menús “Tools” 6. 
 “Tools” -> “Options” -> "General" -> "Parameters" -> "Knowledge". Activar "with 
value" and "with formula".  

“Tools” -> “Options” -> "General" -> "Parameters" -> "Units". Comprobar "mm". 

“Tools” -> “Options” -> "General" -> "Parameters" -> "Meas.Tools" -> 
"Aut.Update". Activar "Part" y "Product".
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• Gestión de menús “Tools” 7. 
 “Tools” -> “Options” -> “Infrastructure” -> "Product Structure" -> "Tree 
Customisation".  Cambiar "Parameters" y "Relations" a "Yes".
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• Gestión de menús “Tools” 8. 
 “Tools” -> “Options” -> “Infrastructure” -> "Part infrastructure" -> "General". 
Activar "Keep link with selected objects" y "Confirm when creating a link".

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 19

• Gestión de menús “Tools” 9. 
 “Tools” -> “Options” -> “Infrastructure” -> "Part infrastructure" -> "Display". Marcar 
todas las opciones en "Display in specification tree" y "checking operations when 
renaming" elegir "Under the same tree node".

 “Tools” -> “Options” -> “Infrastructure” -> "Part infrastructure" -> "Part Document". 
Desactivar "Enable Hybrid Design".

 "Tools -> Options -> Mechanical Design -> Drafting -> Layout tab" para definir 
lugar de macros de planos. Por defecto: "C:\Archivos de programa\Dassault 
Systemes\B19\intel_a\VBScript\FrameTitleBlock\" sustituir por 
\\sdoc2\Asignaturas\Exp_Grafica\DAO\CATDrawing-formatos\ o un directorio local en que 
copiemos este de sdoc2.
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• Gestión de menús “Window”. 
Con el menú “Window” podemos pasar de un modelo a otro.
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• Gestión de menús “Help”. 
“Help” no está instalada en la sala DAO. Se disponen de varias configuraciones de 
ayuda:

 El “Help” básico son 4 CD que se activan desde Catia con F1. Ahora el help está 
copiado y accesible desde "\\sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online"

 Existe un Help más potente llamado “Companion”. 
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• Menú Superior. 
Se repasa en clase el documento de infraestructura de GEDAS-ASCAD en el que 
se vuelven a repasar todos los menús.
 Start: Selección del workbench o taller de trabajo (sólidos, superficies, análisis, 
planos, etc...).
 EnoviaV5: Para acceder a bases de datos.
 File: Selección y clasificación del archivo de trabajo (new, open, save, ...).
 Edit: Herramientas de uso común en todos los entornos de trabajo (undo, copy-
paste, links, ...).
 View: Herramientas de visualización (render style, hide-show, ...).
 Insert: Herramientas comunes y propias de cada entorno de trabajo.
 Tools: Herramientas de configuración y personalización del entorno de trabajo 
(customize, options, search order, ...).
 Analyze: Herramientas de análisis y medición (a nivel de product).
Window: Organización y visualización de los diferentes archivos con los que 
estamos trabajando.
 Help: Arranque de la ayuda y documentación adjunta.Univ
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• Barras de herramientas. 
Las barras de herramientas colocadas a la
derecha dependen de cada Workbench.

• Comandos por teclado. 
Ubicada en la parte inferior derecha de la 
pantalla, permite la introducción por teclado de 
las diferentes funciones, estas deben ir 
precedidas por “c:”. Los comandos disponibles 
se pueden consultar desde “Tools” -> 
“Customize” -> “Commands”.

A
ss

em
bl

y

S
ke

tc
h

S
ur

fa
ce

D
ra

fti
ng

P
ar

t

D
M

U

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 24

• Mensajes de ayuda. 
En la parte inferior izquierda de la pantalla aparece un mensaje que indica la 
acción, aparentemente más lógica, que a continuación se debe ejecutar, o aquella 
que una función determinada requiere.

Situándose con el puntero, sobre cualquier icono, se puede saber de qué 
herramienta se trata. De la misma manera situándose sobre cualquier función o 
elemento del árbol muestra información sobre ésta.

En la foto nos indica que para hacer un círculo basándonos en el centro espera 
que escojamos un puno para definir dicho centro.
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• Área Geométrica. 
Área de desarrollo del trabajo, donde se encuentra, a parte del modelo y todos los 
elementos de referencia creados, el árbol de especificaciones, el compás y los 
planos XY, YZ y ZX que definen los ejes de coordenadas en el punto (0,0,0) y que 
aparecen en todo archivo por defecto.

• Árbol de especificaciones. 
Situado por defecto en la parte izquierda de nuestra pantalla, presenta una 
estructura ramificada en la que se reflejan todas las operaciones realizadas en el 
diseño. Esta ramificación responde a la dependencia de los diferentes 
componentes.

Se organiza en diferentes grupos según la información contenida: Partbody, Body, 
Geometrical set, Constraints, Aplications, Parameters y Relations.

Para cambiar de manipular Árbol a Geometría basta con clickar 
con el ratón en la rama del árbol.
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• Compás. 
Situado en la parte superior derecha del área geométrica, representa los tres ejes 
de coordenadas.

Su orientación por defecto es la de los ejes del modelo. Esta orientación puede 
ser editada, así como el plano de privilegio, XY por defecto.

Conocimiento de la orientación de nuestro trabajo en cualquier momento. Nos 
ayuda a controlar la visualización del modelo por pantalla y al desplazamiento de 
estos.

Al ajustar el compás a una figura podemos moverla y rotarla. Para 
actualizar la posición considerando las restricciones hay que 
actualizar (Ctrl+U).

Si queremos mover la pieza considerando las restricciones mantener apretado 
“Shift”.
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• Uso del ratón. 
Botón central: desplazamiento dinámico.

Botón central + izquierdo: rotación dinámica. El centro de rotación se
define con un clic del botón central sobre cualquier elemento.

Botón central +/- izquierdo: zoom dinámico.

• Menú contextual. 
Herramientas para tratar los diferentes elementos o 
funciones del documento:

Botón derecho sobre los elementos del árbol o sobre 
una entidad bidimensional o tridimensional del área de 
geométrica.
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• Menú contextual de introducción de 
datos. 
Botón derecho sobre algunas celdas que requieren 
la introducción de datos. (Cuadros de diálogo de 
funciones, constraints, selección de elementos de 
referencia, ...)Ofrece diversas opciones que facilitan 
la introducción o creación de datos.

• Copiar o desplazar elementos. 
Se pueden cortar o copiar ‘products’, ‘parts’ 
y funciones, tanto desde el árbol como 
seleccionando la propia entidad.

Seleccionar y arrastrar elemento con el botón 
izquierdo → cut/paste.

Seleccionar + Crtl y arrastrar elemento con el botón 
izquierdo → copy/paste..Univ
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• Manipulación del compás. 
Rotación o desplazamiento dinámico del documento sobre un determinado eje o 
plano.

Desplazar o rotar elementos o funciones determinadas. Situar compás sobre 
elemento, seleccionar elementos a desplazar y mover compás en la dirección 
necesaria.

Del mismo modo se pueden copiar elementos, si se mantiene apretada la tecla 
Ctrl.

Hay que tener en cuenta la historia del elemento que se quiere desplazar o 
copiar, al hacerlo se pueden perder vínculos o relaciones necesarias para 
reproducir la geometría.

El compás se puede editar para manipular sus movimientos de forma controlada 
a través de “Edit” sobre el compás con el botón derecho del ratón. 
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• Iconos - Componentes. 
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• Iconos – Elementos de referencia. 
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• Iconos – Organización Geometría 2D. 

• Iconos – Organización Geometría 3D. 
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• Gestión de documentos
Hay varias opciones para ver los documentos relacionados.

 “Edit” -> “Links”

 “File” -> “Desk”: Color blanco: Ficheros cargados correctamente, Color negro: 
Ficheros no cargados en la sesión, pero relacionados con los ficheros cargados o 
o Color rojo: Ficheros no encontrados.Univ
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• Tipos de vínculos
 Vínculos de Posición:

Los vínculos de posición definen el posicionamiento de piezas o subensamblajes 
dentro de un ensamblaje.

 Instance: Un Product o un Part esta insertado dentro de otro Product, 
también entre un Process y el Product o Part a mecanizar.

 Shape : Cuando se inserta un fichero de tipo Model o CGR, que son 
ficheros solo de visualización.

 Document: Se crea entre un Process y el Product o el Part a mecanizar.
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• Tipos de vínculos-2
 Vínculos de Diseño en Contexto:

Los vínculos de contexto definen qué relaciones se establecen entre una pieza y 
un contexto (conjunto donde se encuentra insertada). Este tipo de vínculos se 
almacena y actúa hacia niveles superiores (desde la part hacia otra part o 
product).

 Import: Este tipo de vínculo almacena la información de qué elemento/Part 
se está usando como referencia externa al fichero Part activo.

 Context: Un vínculo de tipo Import siempre debe llevar implícito en qué 
Product root se ha creado el mismo. Un vínculo de tipo context almacena en 
qué Product se ha creado este vínculo Import.

Al trabajar en contexto (Import, Context), el vínculo sólo existirá dentro del 
Product donde ha sido creado, con lo cual solo se actualizará en el Product. Si se 
abre el documento fuera del contexto no se puede actualizar el archivo.
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• Tipos de vínculos-3
 CCP: El vínculo de tipo CCP es el resultado de hacer un Copy + Paste 
Special / As Result with link desde una Part “referencia” a una Part “destino”. 
Se crea cuando las dos Parts no están insertadas dentro de un Product.

Al establecer un vínculo del tipo CCP, al abrir el modelo donde hemos hecho el 
“Paste”, nos encontraremos con la siguiente situación:

Esto nos indica que el documento donde se ha hecho el “Copy” no está cargado. 
Desde “Edit” -> “Links” observamos que el documento no está cargado y lo 
podemos solucionar cargándolo. Se puede cargar correctamente o necesitar una 
sincronización y actualización (Ctrl+U).
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• Tipos de vínculos-4
 Vínculos de plano. 

En esta sección se define los tipos de link que se pueden establecer entre un 
plano o Drawing y otros elementos.

 Viewlink: Son los que se establecen entre un Drawing y un Product / Part / 
Model (proyectado en el plano). Esta información se almacena en el Drawing.

MML: El vínculo de tipo MML se puede crear si se realiza un Copy / Paste 
de un ditto (o instancia de un detail) entre dos Drawings.
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• Modificación de ubicación de documentos
Hay varias opciones de cambiar la ubicación de documentos.

 “Save As”: Cuando se trata de una única pieza, no contenida en ningún 
conjunto ni vinculada con otras piezas, se modificará su ubicación con la 
herramienta.

 “Save Management”: Cuando se trate de un documento Part que contenga 
cualquier tipo de enlace, no se modificará su ubicación de forma aislada, deberá 
ser modificada desde el Product, es decir, abriendo el conjunto en el que fue 
creado dicho enlace, para que CATIA pueda redireccionarlos. Lo mismo sucederá 
con un documento Product que contenga enlaces con otro Product superior. 

 “File” -> “Send To”: Esta opción está especialmente creada para la creación de 
copias de seguridad de proyectos completos. Empaquetando todos aquellos 
documentos vinculados al proyecto dentro de un directorio.
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• Ensamblajes con posicionamiento. 
Hasta ahora hemos visto la posibilidad de ir insertando objetos (Parts o Products) 
en un ensamblaje y luego definir la posición mediante “inserte” -> “Existing 
Component”. Ahora miraremos otras opciones.

“Insert” -> “Existing component With Position”

Esta opción no nos aporta muchas ventajas 
respecto a la definicón de restricciones una 
vez insertados los componentes.
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• Ensamblajes por repetición. 
Podemos repetir componentes y posicionarlos usando “Insert” ->
“Fast Multi Instantation” (Ctrl+D). Por defecto nos hace copias separadas 
25mm. Para cambiar el perfil o patrón de las copias hay que editar “Insert” ->
“Define Multi Instantation” (Ctrl+E). 

Esta herramienta no permite hacer otras operaciones como matricial.

• Cambios de dirección en alineaciones “Coincidence”. 
La herramienta más común a usar el la de alinear. Si al alinear dos objetos la 
orientación no es la deseada se puede editar el “Constraint” para cambiar la 
orientación. Este cambio no es posible si se usa “Contact”.
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• Otras restricciones en ensamblajes.
 Contact : Es un acceso directo de la restricción “Coincidence”.

 Offset : Coloca los dos elementos seleccionados a la distancia offset 
que se define.

 Angle : Coloca los dos elementos seleccionados con una orientación 
que cumpe el ángulo que se define.

 Fix : Fija la posición de la pieza seleccionada.

 Fix together : Fija las piezas que se seleccionan, en la posición que 
estén relativa que estén entre ellas.

 Quick constraint : Crea la primera restricción que es posible (según la 
lista de prioridades definida en el smart move) con las geometrías que se 
han seleccionado.
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 Flexible / Rigid : Por defecto los 
subconjuntos son rígidos, es decir, las 
parts que lo forman se mueven en 
bloque si se está a un nivel superior 
distinto al subconjunto. En el caso que 
se quieran mover separadamente se 
tiene que hacer este 
subconjunto flexible. 

 Change constraint: Para 
cambiar el tipo de restricción.

 Reuse Pattern: Para repetir las 
piezas con restricciones usando una 
operación matricial usada en la parte. 

• Otras restricciones en ensamblajes.
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• Desplazamiento de componentes.
Se pueden mover componentes sin modificar restricciones.

 Manipulate: Desplazamiento y rotación respecto a los ejes de 
coordenadas del ensamblaje. (Respetando restricciones/sin respetar 
restricciones).

 Snap: Desplazamiento y rotación tomando como referencia 
entidades de los mismos componentes.

 Explode: Explosión de componentes.
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• Desplazamiento de componentes sin interferir.
 Manipulation on clash: Al manipular cualquier elemento detecta 
la colisión entre componentes.

• Análisis.
Permite analizar el ensamblaje y extraer información del mismo:

 Bill of material: Listado de materiales. Saca el listado de piezas 
ensambladas.

 Constraints: Análisis de restricciones aplicadas.

 Degrees of Freeddom: Análisis de dependencias de 
componentes y restricciones.

 Análisis de dependencias.
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• Ensamblaje de un motor. 
Durante esta sesión se pretende aplicar lo aprendido en ensamblajes para montar 
las restricciones necesarias para conseguir el movimiento de un motor.
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• Colocar la el pistón en posición más alta. 
Para colocar el pistón en posición más alta lo podemos intentar de varias formas.

 Primero hay que colocar el pistón aproximadamente en la posición más alta.

 Luego podemos hacer que el pistón esté en la posición más alta por ejemplo a 
base de alinear el eje cigüeñal-biela con la superficie media de culata.

 Para poder mover el pistón hacia arriba primero hay que desactivar el Offset 
entre eje cigüeñal y culata.

 Para acercarnos al tope de culata podemos usar el movimiento detectando 
interferencias “Clash”. Podemos mover el pistón 
respetando las restricciones hasta que se detecte 
el contacto con la culata.
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• Medir distancias para saber distancia cigüeñal-culata 
mínima. 
Una vez tenemos 
el pistón en contacto 
con la culata podemos 
mirar la distancia 
mínima a la que tiene 
que estar la culata 
del cigüeñal.

A esa distancia hay 
que añadirle aprox.
1mm para permitir la 
dilatación del pistón
sin golpear culata.
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• Restablecer la distancia cigüeñal-culata. 
Una vez hemos medido la distancia cigüeñal-culata la podemos activar para 
posteriormente ajustar al valor que deseamos.

Pasamos también a desactivar el “Constraint” entre eje de cigüeñal y plano medio 
de culata para que el motor pueda seguir girando.

• Cálculo del volumen desplazado. 
Calcular el volumen desplazado es relativamente fácil pues se calcula como el 
área de pistón por su carrera.

Primero 
hallamos
el área 
A=242=
1809.6 mm2. 
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• Cálculo carrera. 
Para calcular la carrera lo más fácil es medir la distancia entre eje de cigüeñal y eje 
de biela-cigüeñal. Como la distancia es de 17 mm el recorrido o carrera es de 
2x17=34 mm.

El volumen por tanto es de 1809,6 x 34 = 61525 mm3. (0,061 litros, 61 cm3)
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• Cálculo volumen no compresible. 
Para calcular el volumen que queda entre pistón y culata podemos hacer otro 
“Body” en la culata y 
proyectar las líneas 
sobre un Croquis para 
hacer una revolución.

Con dicho volumen 
generado comprobamos 
que se trata de 
5685 mm3.

Con el pistón arriba el ratio 
de compresión es:
(5685+61525)/ 5685 =11.8

A partir de aquí se puede 
jugar con la posición del 
cigüeñal respecto a culata para tener el ratio de compresión necesario.Univ
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• Cálculo volumen no compresible considerando culata y 
pistón. 
Una opción para calcular el volumen es usar las secciones del conjunto montado.

Para ello guardamos la sección como
CATPART para trabajar en ella.

Comprobamos que el volumen es
4594mm3 en lugar de 5685 mm3 y el 
ratio (4594+61525)/ 4594 =14.5
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• Crítica a los números calculados. 
Siempre se ha de ser crítico con los números que calculamos.

Podemos buscar información sobre ratios de compresión en motores y comprobar 
los siguiente:

 Ratio diesel aprox. 20.

 Ratio gasolina aprox. 11

 Ratio efectivo de motor de 2 tiempos es inferior al teórico ya que una parte del 
volumen escapa por las lumbreras. Por lo tanto podemos pensar que el diseño 
puede hacerse a un ratio aprox. de 14.

Nosotros hemos obtenido un ratio de 11.8 sin considerar el pistón y de 14.5 
considerando el pistón a contacto con la culata. Parece ser que no vamos mal 
encaminados. 
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• Posición de pistón para tener ratio “r”. 
Para conseguir un ratio “r” debemos bajar el pistón una distancia “d” tal que:
r=(4594+61525+d*1809.6)/(4594+d*1809.6) d=(61525+4594*(1-r))/(1809.6*(r-1)).

Para tener un ratio de 1.47 hay que desplazar el eje del cigüeñal 69mm hacia 
abajo.

Falta comprobar que el pistón en su posición baja no se salga de la culata.

No se puede bajar tanto.

Es posible calcular ratio 
máximo (14.5) y mínimo con

la distancia inferior.

Posición inferior con 
contacto superior

Posición inferior para 
r=1.47Univ
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• Entorno de SW comparado con Catia. 
SolidWorks plantea de inicio tres tareas básicas en lugar de las muchas que 
plantea Catia. Realizar una pieza, un ensamblaje o un plano.

Tarea Catia SolidWorks
Pieza *.CATPart *.SLDPRT

Ensamblaje *.CATProduct *.SLDASM
Plano *.CATDrawing *.SLDRW
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• Configuración SolidWorks
Ejecutar SW por primera vez.
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Para evitar confusiones vamos a 
pedir a SW que todos tengamos 
los menús en inglés. De esta 
manera se facilita mucho el uso 
ya que, por ejemplo, los iconos 
están ordenados en orden 
alfabético inglés y cuesta más 
encontrarlos en castellano. 

Para ello ir a "herramientas" -> 
"opciones" y seleccionar menús 
en inglés.

Hay que reiniciar para que el 
cambio tenga efecto.

• Configuración de idioma de SW. 
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• Activar otros complementos. 
Para activar otros complementos que nos permitan 
hacer cálculos, rutas de cables . . . hay que 
activarlos. Se recomienda desactivar todos por 
defecto para iniciar SW cargando el mínimo la 
memoria. Cuando sea necesario utilizarlos ya se 
activaran.
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Si no hay un documento 
abierto tan sólo accedemos a 
"System Options".

Abrir por ejemplo un plano.

• Configuración de propiedades de documento. 
Cuando se trabaja con / para una empresa se nos puede pedir que trabajemos con 
una cierta configuración de documento. Por ejemplo que se vean las roscas 
sombreadas o las líneas de cambio de tangencia. Para configurar un documento 
concreto hay que abrir un documento y editar las "tools" -> "options" -> "document 
properties".
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• Guardar diferentes configuraciones. 
Una vez hemos introducido todos los cambios de configuración requeridos por 
nuestro cliente guardamos el fichero como "template". Cerramos el fichero y 
abrimos uno nuevo si activamos "advanced" nos saldrá nuestra configuración.

Se recomienda guardar todos los archivos "template" en la misma carpeta
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• Configuraciones existentes. 
En la carpeta de  \\sdoc hay las distintas configuraciones que utilizaremos durante 
el curso.

\\sdoc\software\PUBLIC\Exp_Grafica\DI\Configuracion-SW

Copiar estos ficheros y directorios en el directorio en que tengáis instalado 
SolidWorks que puede ser algo como:

"C:\Archivos de programa\SolidWorks"

Alternativamente los podéis colocar en un directorio diferente que tengáis 
controlado no va a cambar.
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• Cambiar directorios de configuraciones existentes. 
Podemos definir SolidWorks para cargar las configuraciones desde un lugar 
común. Para ello hacer "Tools" -> "Options" -> "System Options" -> "File locations" 
y añadir el directorio desde donde queremos cargar nuestros templates.

Primero borramos los 
archivos "template" que hay.
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• Cambiar directorios de configuraciones existentes. 
Los distintos tipos de documentos que utilizaremos (Part, Assembly, Drawing) los 
guardamos en la pestaña de "Document Templates".
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• Cambiar directorios de configuraciones existentes. 
Ponemos nuestras configuraciones en BOM Templates y en Sheet Formats
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• Cambiar directorios de configuraciones existentes. 
Finalmente ponemos el Material Databases.
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• Ayuda en SolidWorks. 
Una manera muy práctica de aprender SW es hacerlos tutoriales guiados. Se 
acceden desde "Help" -> "SolidWorks Tutorials".

Además tenemos siempre la posibilidad de acceder al "Help" desde cualquier 
comando.
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• Ejemplo de Ensamblaje SW. 
Abrimos un ejemplo de un ensamblaje "Excentrica.SLDASM" podemos examinar 
como está montado.

\\sdoc\software\PUBLIC\Exp_Grafica\DAO\S06t\S06_ejercicio

Ensamblaje *.SLDASM

Relaciones entre piezas

Piezas *.SLDPRT

Pieza fija
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• Análisis de relaciones. 
Analizamos las relaciones existentes. 

Relación
suprimida
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• Movimiento de piezas. 
Podemos mover la pieza de dos formas, una libremente y la otra en un movimiento 
de rotación.

Sin embargo si hacemos "Move 
Component" con "Physical Dynamics" 
entre las piezas que nos interesa al mover 
se detectan los contactos y las piezas se 
arrastran.
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• Estudio de movimiento
Podemos realizar una simulación de como se mueve el mecanismo.

Finalmente clicamos sobre el botón play. Se puede guardar como película la animación.Univ
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• Planos
Para poder realizar un plano del explosionado es necesario hacer primero una 
configuración de explosionado. Vamos al ConfigurationManager y con el botón 
secundario apretamos sobre la configuración Predeterminada. 
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• Planos
Se puede realizar el explosionado de dos maneras distintas. La primera es dejar 
que SW realice el explosionado solo.
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• Planos
La segunda opción es mover cada componente por separado y conseguimos la 
posiciones que mas nos gusten.
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• Planos
Tenemos que poner las líneas del explosionado para cada uno de los 
componentes montados juntos.
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•Planos
Creamos un nuevo 
documento de dibujo e 
insertamos la vista 
explosionada.
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•Planos
Si queremos cambiar la escala del dibujo 
vamos a propiedades del documento.

También cambia la escala en el cajetínUniv
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•Planos
Si no queremos que hacer un plano 
de la vista explosionada vamos a las 
propiedades del "Drawing View".
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•Planos
Agregamos la tabla de materiales.
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•Planos
Finalmente numeramos cada "Part".
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•Guardar
El mejor método para guardar es el "Pack and Go…".
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• Menú Superior. 
Dependiendo de que tarea o archivo tengamos abierto los menús varían pero en 
general:
 File: crear un nuevo archivo, abrir alguno existente, guardar o imprimir.
 View: diferentes opciones de visualización.  
 Tools: herramientas para dibujar, ensamblar, hacer cálculos, etc.
 Help: ayuda y tutoriales.
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• Barras de herramientas. 
Las barras de herramientas dependen 
de. Se pueden poner en la área de 
trabajo: "View->Toolbars" y las podemos 
colocar donde queramos.

• Comandos por teclado. 
Para conocer los comandos disponibles 
e incluso crear nuevos en el menú: 
Tools->Customize… ¨keyboard¨ A

ss
em

bl
y

S
ke

tc
h

S
ur

fa
ce

D
ra

fti
ng

Fe
at

ur
e
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• Mensajes de ayuda. 
En la parte inferior izquierda de la pantalla aparece un mensaje que indica la 
acción que se realiza en ese momento. Si se está diseñando una "Part" te indica si 
ésta esta completamente definida o no, igual cuando se hace un "Assembly" y un 
"Drawings".

Situándose con el puntero, sobre cualquier icono, se puede saber de qué 
herramienta se trata. De la misma manera situándose sobre cualquier función o 
elemento del árbol muestra información sobre ésta.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 84

• Área de trabajo. 
Área de desarrollo del trabajo, donde se encuentra, a parte del modelo y todos los 
elementos de referencia creados, el árbol de especificaciones, los ejes de 
coordenadas, y el punto (0,0,0).

• FeatureManager design tree. 
Situado por defecto en la parte izquierda de 
nuestra pantalla, presenta una estructura 
ramificada en la que se reflejan todas las 
operaciones realizadas en el diseño. Esta 
ramificación responde a la dependencia de los 
diferentes componentes.

Sigue el orden con el que realizamos las 
operaciones.
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• PropertyManager.
Esta área es la que aparece al apretar la segunda pestaña en el panel a la 
izquierda de el área de trabajo. Se abre cuando se seleccionan entidades u 
operaciones ya definidas o cuando estamos realizando alguna operación.

• ConfigurationManager.
Se encuentra en la tercera pestaña del 
panel izquierdo. Su utilidad es crear, 
seleccionar y ver las configuraciones 
múltiples de piezas y ensamblajes en 
un documento.
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• Uso del ratón. 
Rueda central: zoom dinámico.

Botón central: rotación dinámico.

Control + Botón central: desplazamiento dinámico.

Botón derecho + desplazamiento: comandos rápidos. Para 
configurarlo "Tools->Customize…->Mouse gestures".

• Menú contextual. 
Herramientas para tratar los diferentes elementos o 
funciones del documento: botón derecho sobre los 
elementos del árbol o sobre 
una entidad bidimensional o tridimensional del área de 
geométrica.
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• Iconos – Geometría de referencia.

•Plane: representación de un plano.

•Axis: representación de un eje.

•Coordinate System: representación de un sistema de coordenadas.

•Point: representación de un punto.

•Mate Reference: relaciones de referencia, utilizadas si se utilizan componentes 
similares que se reemplazan regularmente
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• Standard Mates.
Los vínculos de posición definen el posicionamiento de piezas o suben samblajes 
dentro de un ensamblaje. Existen tres:

 Standard mates

 Advanced mates

 Mehcanical Mates
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• Standard mates.
 Coincident: posiciona las caras, planos, bordes u combinaciones de éstos, 

para que compartan el mismo plano infinito.

 Paralel: posiciona las piezas seleccionadas para que permanezcan a una 
distancia constante separadas la una de la otra.

 Perpendicular: posiciona las entidades seleccionadas a un ángulo de 90º la 
una de la otra.

 Tangent: posiciona las piezas seleccionadas tangentes el uno del otro (al 
menos un elemento debe ser cilíndrico, cónico o esférico).
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• Standard mates
 Concentric: posiciona las piezas seleccionadas compartiendo el mismo línea 

central.

 Lock: bloquea la posición del elemento.

 Distance: posiciona los elementos seleccionados la distancia especificada.

 Angle: posiciona los elementos seleccionados formando el ángulo 
especificado.

 Mate alignment: para que los elementos estén alineados o anti-alineados.
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• Advanced mates
 Symetric: fuerza dos elementos similares a ser simétricos a una cara o plano.

 Width: centra un elemento en una cavidad.

 Path Mate: posiciona un punto de un componente en una trayectoria.

 Linear/Linear Coupler: establece una relación entre la movimiento de un 
componente con el movimiento de otro.

 Limit: permite mover componentes entre un rango de valores de distancia o 
ángulo.
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• Mechanical mates
 Cam (leva): fuerza un cilindro, plano o punto a ser coincidente o tangente a 

una serie de caras tangentes.

 Gear (engranaje): fuerza dos componentes a rotar relativamente uno al otro 
con los ejes seleccionados.
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• Mechanical mates
 Hinge (bisagra): limita el movimiento entre dos 

componentes a un grado de libertad de rotación.

 Rack and Pinion (piñón i cremallera): el movimiento linear 
de un elemento (rack) causa un movimiento rotatorio a el 
otro elemento y viceversa.
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• Mechanical mates
 Screw (tornillo): obliga dos componentes a ser concéntricos 

y además añade una relación de movimiento entre la 
rotación de un elemento y la translación del otro, pitch 
(paso).

 Universal Joint: la rotación de un componente (el eje de 
salida) respecto su eje es realizado por la rotación de otro 
componente (el eje de entrada) respecto su eje.
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• Insertar componentes con patrón
Estas opciones sirven para copiar componentes que ya están en el ensamblaje 
con relaciones de posición.

 Linear Component Pattern: sirve para copiar componentes que deben estar 
colocados siguiendo una matriz lineal.

 Circular Component Pattern: para copiar componentes que están posicionados 
en una matriz circular.

 Featur Driven Component Pattern: para copiar elementos cuya posición siguen 
una operación hecha anteriormente.

 Mirror Components: sirve para copiar elementos que son simétricos respecto 
un plano.
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• Ensamblaje de un motor. 
Durante esta sesión se pretende aplicar lo aprendido en ensamblajes para montar 
con las restricciones necesarias motor para conseguir que se mueva 
correctamente. Las partes se pueden sacar de \\sdoc:

\\sdoc\software\PUBLIC\Exp_Grafica\DAO\S08t\S08t_ejercicio
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• Ensamblaje de un motor. 
Si utilizáis la versión de SW anterior no se pueden abrir estas piezas. Entonces se 
deben importar de la carpeta:

\\sdoc\software\PUBLIC\Exp_Grafica\DAO\S08t\S08t_igs

Antes de importar se deben modificar las opciones de importación.
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• Ensamblaje de un motor. 
Se debe seleccionar "Show IGES 
levels" para que se vean en 
estructura de árbol.
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• Ensamblaje de los componentes. 
Primero tenemos que fijar uno de los componentes, lo más lógico es que sea la 
culata ya que es el único componente que no se mueve.

Seguidamente vamos ensamblando todos los componentes.

Al querer ensamblar la biela con el pistón vemos que nos falta un bulón para 
unirlos. Por lo tanto se va a crear.
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• Diseño del bulón. 
Para empezar debemos saber cuanto miden los 
agujeros por donde tiene que pasar. En el menú de 
"Tools" encontramos la herramienta de medir. Con 
ella medimos las dimensiones que debe tener y lo 
creamos. 

Podemos crear una Part directamente en el Assembly o 
podemos crear una Part y luego insertarla.
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• Ensamblaje. 
Ahora ya podemos acabar de hacer el ensamblaje de las piezas. Para ello 
necesitamos saber la distancia entre el eje del cigüeñal i la culata.
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• Ensamblaje. 
Pondremos la parte superior del pistón en contacto con la parte inferior de la 
cámara de combustión.

Luego alinearemos la biela y el cigüeñal. 
Éste es el PMI.

Ahora suprimimos las dos restricciones 
anteriores, que no nos sirven y colocamos 
la distancia entre los planos del cojinete y 
la culata.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S02t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 104

• Ensamblaje. 
Si movemos el cigüeñal 
veremos que el motor se 
mueve correctamente.
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• Ensamblaje. 
Ahora vamos a colocar la otra cigüeñal y el cojinete.

Los posicionaremos simétricos a los 
otros dos utilizando el plano de la 
biela.
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• Ensamblaje. 
Añadimos una configuración que será el punto 
muerto superior.

Es importante marcar la casilla de 
suprimir nuevas relaciones y 
operaciones ya que no queremos que 
lo que hagamos sea permanente en 
el modelo principal
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• Ensamblaje. 
El punto muerto superior lo hacemos poniendo la biela y el cigüeñal alineados.

Haremos otra 
configuración para el 
punto muerto inferior.
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• Cálculos. 
Para calcular la carrera lo más fácil es medir la distancia entre eje de cigüeñal y eje 
de biela-cigüeñal. Como la distancia es de 17 mm el recorrido o carrera es de 
2x17=34 mm.
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• Cálculos. 
Para calcular el volumen se puede medir el área de la cabeza del cilindro y 
multiplicarlo por la carrera.

El volumen por tanto es de 1809,6 x 34 = 61525 mm3. (0,061 litros, 61 cm3)
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• Cálculo volumen no compresible considerando culata. 
Para calcular el volumen que queda entre pistón y culata podemos hacer un 
"Sketch" en la cara de la culata proyectando las líneas.
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• Cálculo volumen no compresible considerando culata.
Creamos una nueva "Part" y copiamos y pegamos el nuevo "Sketch". Lo editamos 
para poder realizar un extrusión con revolución. 
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• Cálculo volumen no compresible considerando culata.
Finalmente medimos el volumen del nuevo sólido con Tools->Mass properties…

Con dicho volumen generado comprobamos 
que se trata de 5685mm3.

Con el pistón arriba el ratio 
de compresión es:
(5685+61525)/ 5685 =11.8

A partir de aquí se puede jugar con la posición 
del cigüeñal respecto a culata para tener el 
ratio de compresión necesario.
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• Cálculo volumen no compresible considerando culata y 
pistón.
En vez de hacer el "Sketch" sólo con la culata haremos lo mismo con culata y 
pistón en el punto muerto superior.
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• Cálculo volumen no compresible considerando culata.
Calculamos el volumen.

El volumen que ocupa es de 4966mm3. Vemos 
que hay una diferencia entre este y el otro, 
5685mm3

Con el pistón arriba el ratio 
de compresión es de 13.3.
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• Crítica a los números calculados. 
Siempre se ha de ser crítico con los números que calculamos.

Podemos buscar información sobre ratios de compresión en motores y comprobar 
los siguiente:

 Ratio diesel aprox. 20.

 Ratio gasolina aprox. 11

 Ratio efectivo de motor de 2 tiempos es inferior al teórico ya que una parte del 
volumen escapa por las lumbreras. Por lo tanto podemos pensar que el diseño 
puede hacerse a un ratio aprox. de 14.

Nosotros hemos obtenido un ratio de 11.8 sin considerar el pistón y de 14.5 
considerando el pistón a contacto con la culata. Podemos decir que los cálculos 
realizados son suficientemente buenos. 
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• Explosionado. 
Otra configuración que 
haremos será poniendo la 
otra culata para así tener 
el motor completo y luego 
haremos un explosionado 
de ésta.
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• Planos. 
El primer plano será el explosionado con la lista de piezas. 
Podemos escoger que configuración queremos en al 
cuadro de dialogo al insertar un modelo.

Se puede ver que no hay peso en la casilla del plano 
debido a que los componentes no tienen asignado ningún 
material ya que están importados con un iges.
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• Planos. 
Haremos otro plano en el que pondremos las posiciones inferior y superior junto a 
la predeterminada.

Primero insertamos la vista general.

Elegimos una vista y luego de las 
configuraciones ya existentes 
ponemos la inferior y la superior
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• Planos. 
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• Creación de estructura de ficheros de proyecto.
 Definir dónde se van a guardar los ficheros de proyecto y los nombres a utilizar.

 Comenzar pieza, ensamblaje y plano de proyecto poniendo en la misma carpeta 
el croquis y digitalizado del grupo de proyecto.

 Intentar dibujar la pieza eje doblado y roscado
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• Resumen.
 Pinceladas de cada Workbench disponible en Catia que vamos a usar en este 
curso.

 Durante este proceso se muestra la organización de los ficheros de croquis -> 
extrusiones -> partes -> montajes -> restricciones -> planos.

 Inicializar las configuraciones en el caso de desajustes de configuración.

 Entender la importancia de la gestión de ficheros y nombres.

 Menú “Edit”, “View”, “Insert”, “Tools”, “Window”, “Help”.

 Introducción a problemática de Croquis y relación con colores blanco, verde y 
magenta.

 Entorno y configuración de SW.

 Principios básicos de ensamblajes y planos en SolidWorks.
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• Resumen.
 Repaso infraestructura de Catia v5.

 Comentarios a los vínculos y a como se reemplazan.

 Análisis diferentes iconos que nos podemos encontrar en Catia v5.

 Restricciones en ensamblajes.

 Repeticiones de restricciones en ensamblajes.

 Ensamblajes de sub-productos como flexibles.

 Manipulación de ensamblajes.

 Análisis de interferencias y distancias.

Posicionamiento de piezas hasta conseguir contacto.

 Generación de volúmenes a partir de piezas existentes.

 Redimensionamiento de posiciones para conseguir características 
especificadas. Univ

ers
ity
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• Resumen.
 Repaso infraestructura de SW.

 Comentarios a los vínculos y a como se reemplazan.

 Análisis diferentes iconos que nos podemos encontrar en SW.

 Restricciones en ensamblajes.

 Repeticiones de restricciones en ensamblajes.

 Ensamblajes de sub-productos como flexibles.

 Manipulación de ensamblajes.

 Análisis de interferencias y distancias.

 Posicionamiento de piezas hasta conseguir contacto.

 Generación de volúmenes a partir de piezas existentes.

 Redimensionamiento de posiciones para conseguir características 
especificadas. Univ
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ity
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• Repaso última sesión. 

 Infraestructura y montaje de un motor. 
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• Ejercicio práctico.  

Como ejercicio práctico se puede 

hacer un tornillo y tuerca de los que 

si sabemos sus parámetros. 

~6+2*M 
~0.7*M 

~1.73*M 

~0.15*M 
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• Realizar las piezas de la figura curso 2012-2013.  

Empezaremos con parametrización.  
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• Realizar las piezas de la figura curso 2010-2011.  

Empezaremos con parametrización.  
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• Realizar las piezas de la 
figura.  

Para iniciar el trabajo vamos a crear las 

siguientes piezas tal y como indica la figura. 

Realizaremos el ensamblaje de dichas 

piezas. 

Primero hacemos la pieza bloque y luego la 

pieza centrador.  

Al empezar las piezas definimos los 

parámetros L y D y cada vez que demos 

una cota le vamos adjudicando los 

parámetros.  

Para ver los parámetros hacer 

Tools - Options como se explica en 

S02t 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S03t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 7 

• Comprobación tornillo.  

Antes de continuar vemos si hay tornillos de 

estas medidas a nuestra disposición.  

~0.7*M 

~1.73*M 

~0.15*M 
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• Comprobación taladro.  

Antes de continuar vemos si el agujero a 

taladrar cumple.  

pasantes 
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• Comenzar con parámetros.  

Empezamos a poner los parámetros editando ecuaciones para cada cota u 

operación. Cuidado con las unidades. Si se suma un número hay que dar 

unidades.   
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• Ensamblaje de todas las piezas.  

Realizamos el ensamblaje de todas las piezas usando la matriz para los 

centradores y fijando el bloque.   

Una vez definido el ensamblaje añadimos parámetros a nivel del producto. 
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• Parámetros de pieza como ensamblaje.  

Hacemos que los parámetros de la pieza sean los mismos que el ensamblaje con 

lo que sincronizaremos piezas.   

Al hacerlo los parámetros asociados 

aparecen con un birrete que indica 

que están dominados por otro 

parámetro. 
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• Cambiar parámetro.  

Si cambiamos un parámetro podemos ver como cambian todas las cotas al hacer 

un "update - Ctrl-U".  

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S03t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 13 

• Crear tabla con nuestros parámetros.  

Creamos la tabla de todos los parámetros que nos interesen para hacer 

configuraciones: "User parameters" L y D más algún parámetro "string" como 

nombre de fichero.   
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• Añadir variables desde editor de texto.  

Podemos ir añadiendo variables desde el editor de texto. Al crear la tabla de 

diseño los parámetros D y L del ensamblaje también tienen el birrete ya que están 

dominados por la tabla. 
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• Dominio de la tabla.  

Se puede añadir un parámetro del tipo "integer" para dominar la tabla y asignarlo a 

la configuración de tabla. podemos decir que "N" tenga un rango entre "1" y el 

máximo de variantes.  
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• Pasar tabla de "txt" a "excel".  

Una manera cómoda de trabajar con nuestras variantes es hacerlo con tablas 

Excel. Copiamos el contenido del "txt" en el Excel. Podemos poner marcos, 

colores, notas, ecuaciones . . . una vez acabado leemos la tabla excel.  

Lo más rápido es trabajar con ficheros de texto ya que Catia no intenta abrir Excel 

para leer filas y columnas. 
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• Información en el plano.  

Finalmente podemos crear el plano para una variante y añadir la tabla de variantes 

en el plano. 
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• Tutorial SW. 

Las tablas de diseño son muy 

útiles para crear bibliotecas de 

piezas que tienen la misma 

forma pero que sus 

dimensiones no, por ejemplo 

tornillos. 

En SW hay un tutorial que 

explica como hacer tablas de 

diseño. 

Es recomendable hacerlo. 
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•Tablas de diseño. 

Vamos a crear dos tablas de diseño den SW. Crearemos dos piezas: bloque y 

centrador. 
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•Bloque. 

Aquí ya definiremos las variables. 

Realizamos el Sketch y, una vez 

puestas éstas dos cotas con el 

botón secundario clicamos  Link 

Values. 

A la cota de 4 le ponemos D y a la de 10 L Univ
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•Bloque. 

En el FeatureManager se puede ver que se ha añadido una carpeta llamada 

Equations y en el Sketch se puede ver un símbolo de relación al lado de las 

cotas. 

Si clicamos en Edit Equation podemos ver las dos relaciones/variables que 

hemos creado. 
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•Bloque. 

Añadimos un Fillet al cual le ponemos una ecuación como cota. 

Podemos ver que además de modificarse la 

dimensión de la cota aparece un símbolo de 

ecuación que nos indica que esta cota viene 

dada por una ecuación. Univ
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•Bloque. 

Se hacen dos simetrías para obtener el cuerpo completo y se añaden dos 

ecuaciones. La longitud horizontal es de 6*L y la vertical es de 4*L. Finalmente 

se realiza una extrusión. 
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•Bloque. 

Para poder visualizar las cotas en todo momento debemos activar el Show 

Feature Dimensions en el la carpeta de Anotaciones den el Feature Manager y 

el View activar el All Annotations y Dimensions Names en el menú de View. 
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•Bloque. 

Extruimos la base. La dimensión de la extrusión también le ponemos una 

ecuación (2*L). 

También realizamos un Chamfer en la base de 6 mm a 45º. 

Perforamos un agujero redondo con una profundidad de 1.1*L concéntrico con el 

radio de fillet. 
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•Bloque. 

Finalmente realizamos los 

otros tres agujeros con un 

Linear Pattern. Dónde la 

dirección en el lado largo 

es 6*L-4*D y en el corto es 

4*(L-D). 
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•Tabla de diseño. 

Añadimos una tabla de diseño. Situados en el ConfigurationManager la 

añadimos en Insert>Tables->Design Table… 

Debajo de Source, seleccionar "Blank" 

para insertar una tabla vacía. 

En Edit Control, seleccionar "Block 

model edits that would update de 

design table" para que así no esté 

permitido cambiar el modelo si se 

cambiala tabla de diseño. 

En Options solo tener activado "Warn 

when updating design table" para que 

así si cambiamos el modelo no cambie 

la tabla y que nos avise cuando ésta se 

actualice. Univ
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•Tabla de diseño. 

Se abre una hoja de Excel. Con la celda B2 seleccionada hacemos doble click en 

la cota L y seguidamente con la celda C2 seleccionada hacemos lo mismo con la 

cota D. 

Ahora podemos copiar el contenido de el fichero Tabla_bloque.txt en la hoja de 

Excel. 
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•Tabla de diseño. 

Finalmente apretamos fuera de la tabla de Excel y nos aparece un aviso de que 

se ha creado una tabla de diseño con las diferentes configuraciones. Todas ellas 

estan en la pestaña de configuraciones. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S03t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 31 

•Tornillo. 

Ahora dibujaremos el dibujo. También aquí definiremos dos variables L (10 mm) 

y D (4 mm). Para el diámetro de la circunferencia del hexágono la fórmula es 

2*D y para la altura es 0.7*D. 
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L@Extrude2 D@Sketch1 

Torn_10_4 10 4 

Torn_12_4 12 4 

Torn_12_5 12 5 

Torn_14_5 14 5 

Torn_14_6 14 6 

Torn_16_6 16 6 

Torn_16_7 16 7 

Torn_18_7 18 7 

Torn_18_8 18 8 

Torn_20_8 20 8 

Torn_20_9 20 9 

Torn_22_9 22 9 

•Tornillo. 

Creamos una tabla de diseño con 

estos valores. Los valores están en el 

archivo "Tabla_tornillo.txt". 
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•Ensamblaje. 

Vamos a realizar el ensamblaje. Primero ponemos el bloque y después un 

tornillo. El tornillo. 
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•Ensamblaje. 

Para ensamblar los otros tornillos vamos a utilizar la herramienta de ensamblaje 

Feature Driven Component Pattern. Sirve para posicionar elementos si hemos 

hecho alguna Feature Driven. La única condición es que debemos poner el primer 

componente con la Feature que hemos copiado con el Pattern. 
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• Tabla de diseño. 

Primero realizamos un Sketch dónde vamos a dibujar dos líneas donde vamos a 

crear las variables L y D. 
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• Tabla de diseño. 

Tenemos que relacionar las dimensiones L y D creadas con las de las 

piezas. Crearemos 4 ecuaciones de igualdad en el Assembly. 
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• Tabla de diseño. 

Creamos una tabla de diseño 

donde los dos parámetros sean la 

L y la D del Sketch creado 

anteriormente. 

L@Sketch1 D@Sketch1 

Tabla_10_4 10 4 

Tabla_12_4 12 4 

Tabla_12_5 12 5 

Tabla_14_5 14 5 

Tabla_14_6 14 6 

Tabla_16_6 16 6 

Tabla_16_7 16 7 

Tabla_18_7 18 7 

Tabla_18_8 18 8 

Tabla_20_8 20 8 

Tabla_20_9 20 9 

Tabla_22_9 22 9 Univ
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ity
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• Tabla de diseño. 

Si probamos las distintas configuraciones podemos ver que varian tanto el tornillo 

como el bloque. 
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• Planos. 

Vamos a realizar los planos de las piezas. Primero vamos a editar la tabla de 

diseño. Insertamos una fila en la parte superior, ocultamos las filas y 

columnas que no queremos que se vean y editamos las que si. 
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• Planos. 

Abrimos un plano y ponemos las vistas que creamos necesarias. 
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• Planos. 

Vamos a colocar las medidas. Para ello colocamos las cotas normalmente y en el 

cuadro de diálogo del PropertyManager en Dimension Text ponemos manualmente 

la cota con las variables. 
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• Planos. 

Insertamos la tabla de diseño. 

Para ello seleccionamos una vista 

y con el botón secundario 

insertamos la tabla. Luego la 

colocamos donde queramos. 
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• Planos. 

Realizamos los planos del tornillo el bloque y del conjunto. 
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• Roscas métricas. 

Para acabar vamos ver la parametrización de un agujero roscado de M5. 
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• Roscas métricas. 

Al ver todas las dimensiones comprobamos que parametrizar un agujero roscado 

es una tarea mucho mas elaborada. Si se quiere hacer se pueden mirar las 

ecuaciones en los apuntes de Diseño industrial de segundo. 

\\sdoc\software\PUBLIC\Exp_Grafica\DI\di_09102c.ppt.pdf 
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• Trabajo en clase.  

Se solicita la creación de piezas para ensamblar tipo Lego. 

Se pide iniciar el trabajo pensando en los requisitos de la construcción. 
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• Trabajo en clase.  

Crear los parámetros para definir la operación base que se repetirá luego 

matricialmente. 

Poner los nombres de manera automática. 

Comprobar que cambiando los parámetros cambia la forma básica. 
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• Trabajo en clase curso 2013-2014 grupo1.  

. 
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• Trabajo en clase.  

Colocar  

nombres  

automá- 

ticamente. 
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• Figura base.  

Para crear la pieza una posibilidad es pensar en una unidad de un pin que se 

repite un número de veces e una dirección y otro número de veces en otra 

dirección. 

4x2 2x2 
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• Empezar con Fichero inicial.  

Hay que preparar el fichero inicial. 

1.- “Start” -> “Mechanical Design” -> “Part Design” *Nota: Desactivar “Enable 

Hybrid Design” para no mezclar Workbenches de sólidos y superficies. 

2.- Guardar el fichero con “File” -> “Save” -> “Lego_NxM.CATPart” 

3.- Colocarse en el nombre de la Part para editarlo y cambiarlo 

por “Lego_NxM”. 
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• Croquis para cubo.  

Para empezar la figura haremos la base cuadrada. 

1.- Ir al menú de Croquis “Sketch”. 

2.- Seleccionar un plano un plano para trabajar el Croquis (en el árbol o en el 3D). 

3.- Revisar las opciones de “Sketch”. 

4.- Dibujar el cuadrado  

usando el botón 

específico de rectángulo. 
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• Croquis para cubo 2.  

Como tenemos activadas las restricciones geométricas el rectángulo se ha 

impuesto las condiciones de dos lados horizontales (H) y dos verticales (V). Estas 

restricciones se pueden seleccionar y eliminar. 

El rectángulo inicial es de color blanco pues no está  

definido-restringido. Si seleccionamos el cuadrado lo 

podemos mover y cambiar de tamaño pero no  

dejará de ser un rectángulo pues se mantiene la 

restricción de paralelismo. 

5.- Usamos las herramientas de acotación para  

fijar el rectángulo. Hay que delimitar los lados y  

la posición del rectángulo respecto al centro para 

conseguir que esté definido y pase de color  

blanco a verde.   
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• Croquis para cubo 3.  

6.- Para ayudarnos en la creación nos creamos unos ejes que dejamos se ajusten 

a los centros de los lados del rectángulo (Muestran un color azul cuando pueden 

engancharse). 

7.- Hacemos un punto como 

la intersección de los dos ejes 

que nos servirá para referenciar 

otros componentes. 

8.- Definimos el punto por 

el árbol para que tenga  

coordenadas (0,0) 
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• Croquis para cubo 3.  

9.- Finalmente le decimos a este punto que esté 

fijo (Fix) y comprobamos nuestro Croquis pasa  

a estar de color verde. 

Todos estos pasos son más fáciles si el  

rectángulo lo hacemos con su centro y  

fijamos dicho centro. Borrar toda la geometría anterior 

y probar esta variante. 

1.- Escoger “centered rectangle” y dejar que el centro 

se enganche al (0,0). 

2.- Poner dos cotas y comprobar que hemos hecho 

menos operaciones. 
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• Croquis para cubo 4.  

Podemos añadir más cotas para comprobar que a Catia  

no le gusta definir en exceso pues luego ante una  

modificación se ha determinar que cota se ha de respetar. 

Catia muestra esta problemática poniendo la cota y  

elementos afectados de color  

magenta. 

Las cotas las podemos editar  

haciendo doble click sobre 

ellas. Si cambiamos una  

cota ahora Catia no podrá  

reconstruir el Sketch. Es  

necesario eliminar las cotas  

definidas en exceso o definir 

la cota como de referencia que 

aparecerá entre paréntesis. 
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• Salir de Croquis para Extruir.  

Para hacer el 3D hay que salir del Croquis. 

Una vez hemos salido comprobamos que  

estamos de vuelta en el Workbench de  

“Part Design” y buscamos la opción PAD para extruir nuestro 2D y hacer un 3D. 

Editamos la altura que queremos extruir y si el Croquis no está seleccionado lo 

seleccionamos del árbol. 

De esta forma tenemos nuestro  

primer sólido. Podemos proceder 

a guardar el fichero con “File” ->  

“Save”. 
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• Modificación del color.  

Si el color grisáceo que tiene la pieza por defecto nos hace confundir con colores 

blancos, verdes, azules, magenta o naranjas usados durante las selecciones 

podemos cambiarlo seleccionado en el “Part Body” -> “Propiedades” y escogiendo 

un color tipo marrón.  
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• Croquis saliente superior.  

1.- Para hacer el saliente superior hay que entrar de nuevo  

en croquis y seleccionar la cara superior del cubo para  

trabajar en ella. 

2.- Seleccionamos el círculo con centro y dejamos que se  

enganche en el (0,0). 

3.- Al dar dimensión al diámetro del círculo ya queda  

perfectamente definido  

(color verde). 
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• Extrusión saliente superior y redondeo.  

1.- Salimos del Croquis. 

2.- Hacemos el PAD como hicimos para el cubo. 

3.- Aprovechamos para redondear las aristas 

del saliente con la opción “Fillet”. 

4.- Seleccionamos las aristas a redondear  

con el radio deseado. 
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• Vaciado entrante inferior.  

1.- Entramos en Croquis seleccionando la base 

del cubo. 

2.- En lugar de hacer el Croquis proyectamos la 

arista de la parte superior. 

3.- Salimos de Croquis y hacemos un Vaciado  

(Pocket) de la parte inferior. 
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• Redondeo aristas vaciado inferior.  

1.- Entramos en la opción de redondeo para las aristas del Pocket inferior para 

finalizar nuestra unidad repetitiva. 

2.- Volver a hacer “File” -> “Save” (En curso 2010-2011 se suple por opción 

SHELL) 
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• Operación repetición matricial.  

1.- Entramos en la operación de repeticiones matriciales para repetir  

en N columnas y M filas nuestra unidad funcional que hemos llamado  

PIN. Primero escogeremos las repeticiones en una dirección y luego 

en la otra dirección. 
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• Redondeo final.  

1.- Entramos en la operación redondeo y seleccionamos tan sólo las cuatro caras 

laterales. 

Comprobamos en el árbol 

las operaciones que hemos 

realizado y finalmente  

guardamos el fichero. 
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• Opción Multi-pad.  

La manera más rápida de hacer este proceso es 

usar una extrusión múltiple. Para ello hacemos en 

un mismo Croquis el cuadrado y el círculo y al 

salir de Croquis elegimos el Multi-pad. 

Esta opción reconoce las diferentes regiones a 

extruir dentro de Croquis pudiendo dar diferentes 

alturas. 
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• Resultado 2010-2011.  
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• Opción piezas sin agujeros inferiores.  

Otra posibilidad de pieza Lego es la que contempla que la parte inferior sea hueca 

y las piezas se mantengan por la presión de las paredes laterales. 
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• Introducción a Assembly.  

Para iniciar el montaje de las piezas hay que iniciar el módulo de ensamblaje e ir 

montando las diferentes piezas en éste. 

1.- “Start” -> “Assembly Dessign” 

2.- “Cambiar el nombre del producto de “Product1” a “Lego_ensamblaje” editando 

las propiedades del product con el botón derecho del ratón. 

3.- Guardar el fichero con “File” -> “Save” con  

nombre “Lego_ensamblaje.CATProduct”. 

4.- Introducir piezas en el ensamblaje haciendo  

“Insert” -> “Exising component”. Para completar 

la acción hay que seleccionar el Product en el 

que queremos insertar nuestro componente. 
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• Insertar componentes.  

Una vez que ya hemos seleccionado el 

Product nos saldrá la ventana para elegir 

componentes. 

5.- Seleccionar la pieza que queremos 

insertar. Repetir la operación con las otras 

piezas.  
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• Duplicar componentes.  

Una vez que ya hemos insertado los componentes 

que deseamos los podemos ir duplicando haciendo  

copiar y pegar (copy-paste).  

1.- Seleccionar componente y hacer “Ctrl+C” ó  

“Edit” -> “Copy”. 

2.- Seleccionar el “Product” y hacer “Ctrl+V” ó  

“Edit” -> “Paste”. 

En la figura apreciamos que hay dos piezas (la 2x2  

y la 4x2). De la 2x2 hay dos copia 2x2.1 y 2x2.2 y de 

la 4x2 hay 3 la 4x2.1, 4x2.2 y 4x2.3. 

Para poder ver las piezas podemos hacer un  

explosionado. Sin embargo la mejor manera es usar 

el compás. Podemos hacer que el compás se 

enganche a los objetos seleccionando de manera 

automática. 
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Si no usamos el “Snap Automatically” hay que mover el compás sobre la pieza. 

Para poder mover el compás hay que colocar el ratón sobre el punto rojo del 

compás. Una vez que se está sobre la pieza hay que seleccionar una cara o la 

pieza por el árbol. 

• Mover componentes.  

Usando el compás podemos mover y girar las piezas. 
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• Cambiar colores para facilitar visibilidad.  

Para facilitar la comprensión del conjunto podemos cambiar los colores de las 

piezas ensambladas. 

Para cambiar los colores: 

1.- Colocarse sobre la pieza ensamblada en el árbol 

y con el botón derecho del ratón abrir las propiedades. 

2.- Dentro del menú “Graphic” podemos cambiar el  

color. 
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• Fijar posición primera pieza.  

Para facilitar la comprensión del conjunto podemos 

cambiar los colores de las piezas ensambladas. Para 

ello siempre hemos de comenzar por fijar una pieza de 

manera que las otras las iremos posicionando respecto 

a ésta. 

Para fijar usamos el menú “Insert” -> “Fix” ó desde el 

componente con el botón derecho. 

Al haber introducido una restricción ya aparece en el 

árbol el apartado de “Constraints”. 
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• Fijar piezas inferiores.  

Para ajustar las piezas empezamos por definir  

un contacto entre dos paredes. 

1.- Seleccionar el “contacto” y las dos caras 

que queremos que estén en contacto. 

Cuando se ha definico una restricción el 

modelo no se actualiza automáticamente. Para 

actualizar posiciones hay que usar el botón con 

forma de espiral que ha aparecido en la parte 

inferior derecha.  

Como esta función es muy habitual tenemos el 

acelerador (Ctrl+U). 

2.- Seleccionamos “alinear” para acabar de 

ajustar las dos primeras piezas inferiores.  Univ
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• Fijar piezas superiores.  

Para ajustar las piezas empezamos por definir  

un contacto entre base y parte superior. 

1.- Seleccionar el “contacto” y las dos caras 

que queremos que estén en contacto. 

2.- Alinear los ejes de los salientes (pins). 

Hacen falta dos pares. 

3.- Actualizar el modelo (Ctrl+U). 
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• Comprobar grados libertad.  

Para comprobar si nuestro modelo está bien 

ligado podemos hacer varias cosas. 

1.- Con el botón derecho del ratón sobre el 

componente editar los grados de libertad de 

dicho componente. 

2.- Con el Compás sobre el componente 

moverlo con el “Shift” apretado. Si no lo 

podemos mover es que está fijo. De esta 

manera podemos animar mecanismos. 
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• Comprobar interferencias.  

Para comprobar si tenemos interferencias 

podemos usar herramientas de análisis. 

1.- Seleccionar el “Product” 

2.- Abrir “Analyze” -> “Clash” 

3.- Elegir “Contact+Clash” para ver contactos y 

penetraciones. 

4.- Hacer “Apply” para investigar  

los resultados. 

5.- Acabar con “OK” para que  

los resultados cuelguen del  

árbol. 
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• Hacer secciones.  

Otra herramienta muy utilizada para visualizar 

el ensamblaje es el ir moviendo una sección. 

1.- Seleccionar el “Product” 

2.- Abrir “Analyze” -> “Sectioning” 

3.- Hacer la sección usando un “Geometrical 

Target”. 

4.- Adaptar el tamaño de la sección a la zona 

que nos interesa. 

5.- El resultado de la sección colgará del árbol 

y se podrá exportar para informes. 
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• Introducción a planos 

El objetivo de la práctica es introducir el tema de creación de planos. Para ello 

usaremos las piezas que hemos ido creando y el montaje que hemos hecho con 

ellas. 

1.- Abrir una pieza. 

2.- Abrir el Workbench Drafting para creación de planos. 

3.- Seleccionar el formato de hoja que queremos usar y  

el número de vistas que queremos crear. Por defecto  

se aconseja crear las seis proyecciones diédricas más  

el isométrico.  

4.- Modificamos la escala desde la hoja creada con 

el botón derecho del ratón sobre “Sheet.1”. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S03t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 83 

• Mover las vistas y copiar cajetín 

1.- Podemos mover las vistas arrastrándolas con el ratón. Hay una vista principal 

que en el caso por defecto es la vista frontal que domina-arrastra al resto de vistas. 

2.- Podemos borrar las vistas que no consideremos necesarias. 

3.- Para insertar el cajetín podemos abrir un documento que con el marco y los 

elementos de cajetín que nos interesen y colgarlo del árbol de nuestro plano. 
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• Plano Pieza 

El plano pieza finalizado ha de incluir toda la información para su fabricación. 
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• Plano Montaje 

El plano de montaje ha de incluir información para entender el montaje. 
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• Trabajo en clase día 1 curso 2012-2013.  

. 
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• Resumen. 

 Introducción la problemática de los Croquis para que queden bien definidos. 

 Operaciones de extrusión (Pad), vaciado (Pocket), copiado matricial (rectangular 

pattern) y redondeo (Fillet). 

 Primera pieza. 

 Parametrización y ecuaciones de nombre. 
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• Espejo. 

Creamos el espejo y montamos la estructura de proyecto. 

Creamos una pieza vacía para la carcasa que ensamblamos y dentro del 

ensamblaje creamos un sketch creando links al espejo. 

Lo mismo con la  

carcasa superior. 
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• Inicio proyecto. 

Creamos los planos de proyecto y guardamos la estructura de plano, ensamblaej y 

piezas. 
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• Resumen de puntuación alcanzada. 
0.10 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.00 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

0.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

0.10 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

0.00 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.00 de 0.50 Ergonomía (C)  

0.00 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

2.00 de 13.00 Total 

0.8 horas de dedicación 
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• Resumen. 

 Realización de tablas de diseño con Catia y parámetros dentro de un 

ensamblaje. 

 Realización de tablas de diseño con SolidWorks y utilización de parámetros en 

Parts y Assembly 
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• Repaso última sesión. 

 Tablas de diseño. 
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• Grabar una macro.  

Si empezamos a grabar una macro luego podemos editarla para ver los comandos 

utilizados. A modo de ejemplo abrimos un producto cualquiera y vamos a mover y cambiar 

los colores de las dos primeras piezas.  
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• Editar una macro.  

Una vez se han cambiado los colores paramos la macro y la editamos.   

Comprobamos que se ha escrito una serie de datos pero falta 

precisamente el cambio de color. Univ
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• Ejecutar una macro.  

Volvemos a quitar los colores y actualizamos el modelo a la posición inicial. Ejecutamos la 

macro y comprobamos que no cambian los colores pero si mueve las piezas.   
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• Ejemplo de cambio de colores.  

Una vez que vemos que algunas cosas no somos capaces de hacerlas grabando la macro 

directamente y otras sí analizamos un ejemplo de cambio de colores.   
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• Ayuda sobre funciones de macros.  

Para ver las órdenes a usar en las macros hay que acceder a menús según temática.   

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S04t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 8 

• Ayuda sobre funciones de macros.  

Una vez dentro de la ayuda se pueden consultar ejemplos para ver como se puede hacer el 

script con variables.   
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• Ejemplos de macros facilitadas por Ferran López .  

Se han entregado una serie de macros que permiten: 

 Otros 

• BoundingBox.CATScript Para calcular volumen prismático de caja en la que 

colocar una pieza. 

• colors_general.CATScript: Para cambiar los colores de todos los niveles de un 

ensamblaje. 

• colors_1nivel.CATScript: Para cambiar colores tan sólo de las piezas de primer nivel. 

 Hide-show: muchas macros para ocultar una serie de entidades. 

 Puntos-Excel: Macros para insertar puntos de Excel o exportarlos de Catia a Excel. 

 Simetrías: para hacer simetrías de todas las piezas y dar nombres. 

 TIFF: para pasar todos los planos a tiff. 

 v4-v5: para pasar todos los ficheros de Catia v4 a v5. 
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• Ejemplos de caja contorno.  

Se ejecuta la macro seleccionando previamente la pieza part que tenga unos ejes de 

referencia (insert - axis). 
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• Ejemplos de simetría .  

Se ejecuta la macro seleccionando previamente el product. 

 

Algunas macros para funcionar correctamente necesitan 

herramientas adicionales como lenguaje perl. Univ
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• Ejemplos de hide-show.  

Se ejecuta la macro seleccionando previamente el product. 
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• Ejemplos de tiff.  

Abrimos un plano con varias hojas y se ejecuta la macro. 

 

Se comprueba que tan sólo ha creado una página y no 

todas las hojas como era de esperar. 
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• Ejemplos de v4 a v5.  

En la sesión de DMU hay un ejemplo en Catia v4. Con el script lo traducimos a Catia v5. 

Este script ha quedado anticuado pues 

con la R19 se puede abrir directamente 

el *.model de v4. Univ
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• Ejemplos de hoja Excel a Catia.  

Colocamos un fichero Excel con nombres de puntos y coordenadas x,y,z. Creamos una 

pieza. Entonces ejecutamos la macro. 

 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S04t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 16 

• Ejemplos de hoja Catia a Excel.  

Movemos los puntos en Catia y exportamos el set geométrico que contenga los puntos a 

Excel. 

 Con Project no funciona y por tanto hay 

que pasarlos a puntos. 
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• Ejemplo de Macro de Jordi Martorell.  

Como ejemplo de maros se adjunta unas fotos del programa que genera los ficheros para 

hacer en Catia una arteria, sus moldes incluyendo el CNC, ficheros para impresoras 3D y 

ficheros para cálculo.   
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• Ejemplo de Macro de Jordi Martorell.  

 .   
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• Ejemplo de Macro de Jordi Martorell.  

La macro creada por Jordi Martorell dentro de su PFC genera los ficheros Catia de 

geometría pero también los moldes y su mecanizado.   
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• Crear botón para una macro.  

Primero creamos una barra y luego el botón.   
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• Duplicate geometrical set.  

Al hacer un powercopy de un set geométrico nos pedirá todos los inputs de los que 

depende.  Creamos un set para lo que queremos copiar en las posiciones de los inputs 

necesarios para ese input. 
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• Duplicate geometrical set.  

 Como primer ejemplo copiamos sets geométricos en las posiciones nuevas.   
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• Powercopies.  

Una manera más interesante de trabajar es hacer copias de un fichero o body usando una 

plantilla definida. Vamos a hacer un ejemplo para mostrar las ventajas. Creamos una pieza 

que tenga un sólido de diseño y creamos un set geométrico para el input necesario para el 

powercopy.  
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• Powercopies.  

Una vez acabado se recorta con operación booleana y el documento se guarda.  
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• Powercopies.  

Una manera más interesante de trabajar es hacer copias de un fichero o body usando una 

plantilla definida.   
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• Powercopies.  

Continuamos definiendo propiedades.   

Vacío pero se puede ligar 

tabla de diseño por ejemplo. 
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• Powercopies.  

Después de completar el proceso en el árbol aparece el powercopy.   
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• Powercopies.  

Una vez definido el powercopy tan sólo hay que colocarlo en posiciones nuevas. En un 

nuevo fichero necesitamos el body y los puntos y direcciones para insertar.   
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• Powercopies.  

Cuando se ha elegido la posición se puede elegir cambiar los parámetros.   
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• Estructura catálogos.  

Podemos crear una estructura de catálogo.  
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• Catálogo como tabla de diseño.  

También se pueden poner catálogos como tablas de diseño. La primera columna 

se ha de llamar "PartNumber" y ha de incluir el nombre del fichero para generar 

desde el catálogo. 
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• Insertar piezas en un catálogo.  

Vamos insertando piezas o ensamblajes en un catálogo.  
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• Búsqueda de ficheros.  

Para encontrar los ficheros de catálogos hay que jugar con las carpetas de las 

opciones.  
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• Ejemplo de tornillo.  

Creamos el tornillo con parámetros.  
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• Insertamos el tornillo en el catálogo.  

Una vez generados se insertan.  
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• Insertamos vistas de detalle en catálogo.  

Si creamos un logo en un plano lo podemos hacer como vista de detalle en un 

catálogo.  
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• Copiar detalles en planos.  

Una vez tenemos los detalles en el catálogo se pueden insertar en los planos.  
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• Inicio powercopy de rosca.  

Creamos un ejercicio de un powercopy de roscas para convertirlo en catálogo. 

Creamos una rosca en un fichero y creamos el powercopy con la información 

necesaria para realizarla. Como ejemplo rápido: "Rosca_para_catalogo.CATPart" 
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• Continuamos con la definición de parámetros .  

Además de los parámetros de entrada podemos colocar nombres a dichos 

parámetros y publicar otros para hacer la copia interactiva. 
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• Estudiar el fichero.  

Se aconseja estudiar el fichero y mirar la visibilidad de curvas.  

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S04t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 41 

• Colocar la rosca como powercopy.  

Si abrimos la "Botella_para_roscar.CATPart" le podemos insertar el powercopy de 

rosca. Ejemplo acabado "Botella_rosca_powercopy.CATPart". 
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• User features.  

Si no queremos dar la posibilidad a nuestro cliente de que modifique nuestra 

geometría en lugar de darles un powercopy le podemos dar un user-feature. 

Realiza las mismas preguntas que el powercopy y alguna más referente a 

documentación. 
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• Resultado de User-feature.  

El resultado de copia cuelga de la botella "Botella_rosca_user_feature.CATPart". 

Ahora tan sólo se pueden cambiar los parámetros que publiquemos y no se puede 

ver como se construye la rosca. 
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• Catálogos.  

Una vez definido el powercopy o user-feature se puede colocar en un catálogo. 

Una vez guardado en un catálogo se pueden insertar roscas desde el catálogo. 
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• Catálogos.  

Desde el catálogo las operaciones son las mismas. Un ejemplo rápido se 

encuentra en "Botella_rosca_catalogo.CATPart". 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S04t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 46 

• Copiar toda la información para proveedor.  

Si queremos que el catálogo funcione en otro ordenador se necesita la misma 

estructura.  
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• Ejercicio para casa.  

Incluir ecuaciones en el Powercopy y User_feature para poder hacer radios 

mayores. Ahora el radio de 3mm falla ya que la hélice está redondeada con radios 

de 5mm y este parámetro no se ha pasado en el Powercopy. Este fichero será 

necesario para el examen. 
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• Macros. 

Una macro es un conjunto de comandos que se pueden aplicar con un único clic. 

Pueden automatizar casi todas las tareas que se puedan realizar en el programa 

que se esté utilizando. Principalmente sirven para realizar acciones muy 

repetitivas. 

Las macros se encuentran en el menú: Tools -> Macro 
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• Grabar una macro.  

Si empezamos a grabar una macro luego podemos editarla para ver los comandos 

utilizados.  

Primero apretamos el botón "Record/Pause Macro". 

Realizamos una extrusión de un cuadrado cualquiera, dejando el Sketch 

totalmente definido. Una vez acabado apretamos el botón de "Stop Macro". 
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• Grabar una macro.  

Ahora nos pide guardar la macro. Es recomendable que se guarden todas las 

macros en una misma carpeta.  

Se pone el nombre Extrusión01_S12t, la extensión es *.swp.  

Ahora abrimos una nueva pieza, clicamos en el botón de "Run Macro" y 

escogemos la macro creada antes. 

Se puede ver como se realizan las acciones anteriores automáticamente. Se 

ponen las cotas que se quieran. 
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• Editar una macro.  

Apretamos el botón "Edit Macro" y se abre Microsoft Visual Basic, con el código 

que corresponde a la macro editada. 

Aquí podemos editar la macro. Cambiaremos las dimensiones del cuadrado 

extruido y la dimensión de la extrusión. 
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• Editar una macro.  

En la línea debajo de Set myDimension = Part.Parameter("D2@Sketch1"), dónde 

pone: "myDimension.SystemValue = 0.08252888887653", cambiamos el número 

por 0.05 . 

Hacemos lo mismo con la línea de debajo de: "D2@Sketch1" y ponemos 0.05. 

Finalmente en el sexto parámetro del FeatureExtrusion, ponemos 0.05. 
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• Editar una macro.  

Hay que tener en cuenta que las dimensiones que escribimos al editar una macro, 

están en metros. Por lo tanto si tenemos configurado el SW en milímetros hay que 

ponerlo concorde. 

Ahora si abrimos una nueva pieza y ejecutamos la macro automáticamente creara 

un cubo de 50x50x50 milímetros (cuando pide las dimensiones presionar 

directamente la tecla Enter). 
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• Grabar una macro.  

Seleccionamos una cara del cubo y apretamos el botón Record y realizamos un 

agujero. 

Una vez hecho apretamos el botón Stop. 

ADVERTENCIA: al hacer Skecth para una macro hay que tener en cuenta el 

origen de coordenadas ya que cuando se repita la acción va a utilizar el miso. Univ
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• Grabar una macro.  

Finalmente nos pide guardar la macro, le ponemos Agujero_redondo y lo 

guardamos en una carpeta que tengamos controlada. Ahora seleccionamos una 

cara del cubo y apretamos el botón de ejecutar macro. Automáticamente realiza el 

agujero programado en la cara seleccionada. 
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• Ejemplos: muelle.  

Dibujamos un círculo cualquiera en un Sketch y ejecutamos la macro 

"macro_spring.swp". 
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• Macros ya existentes. 

Existen un montón de macros ya existentes que se pueden bajar de internet. 

Vamos a ver algunas que se encuentran en: 

http://www.3dcontentcentral.es/macros.aspx 
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• Macros ya existentes. 

Existen un montón de macros ya existentes que se pueden bajar de internet. 

Vamos a ver algunas que se encuentran en: 

http://www.3dcontentcentral.es/macros.aspx 
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• Macros ya existentes. 

Existen un montón de macros ya existentes que se pueden bajar de internet. 

Vamos a ver una de SKF (hay que registrarse para poderlas bajar). 
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• Macros ya existentes. 

Escogemos un cojinete. 
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• Macros ya existentes. 

Escogemos para qué programa queremos bajar el archivo. 
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• Macros ya existentes. 

El archivo que hemos bajado es un *.swb. En solidworks con una Part en blanco 

abierta ejecutamos esta macro. Debemos especificar donde queremos que guarde 

esta pieza. 
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• Macros ya existentes. 

Si vamos a editar la macro podemos ver la complejidad que pueden llegar a tener. 
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• Resumen. 

 Creación de macros en Catia v5 y SolidWorks. 

 Creación de Powercopies. 

 Creación de catálogos. 
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• Lego. 

Continuamos con las piezas de lego. 

No ha dado tiempo pues la clase es muy densa. 
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• Proyecto. 

Continuamos con el proyecto creando el marco inferior del espejo usando links y pensando 

en el desmoldeo. Para el espejo  

enseñamos usamos el módulo “Shape” –> “Sketch 

tracer” desde un ensamblaje. Para ello tenemos 

una foto en formato jpg, nos colocamos en una 

vista como la “top”, con visualización de materiales 

y nos preocupamos de tener la escala correcta. 
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• Proyecto. 

Comenzamos la varilla y la colocamos en el ensamblaje. 
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• Resumen de puntuación alcanzada. 
0.10 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.10 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

0.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

0.00 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.00 de 0.50 Ergonomía (C)  

0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

2.00 de 13.00 Total 

0.8 horas de dedicación 
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• Repaso última sesión. 

 Macros. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S05t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 3 

• Botella.  

Como ejemplo de la 

metodología de trabajo 

con superficies vamos a 

trabajar haciendo la 

siguiente botella. 

Primero hemos de 

empezar por definir las 

dimensiones para crear 

las curvas en las que 

nos vamos a apoyar 

para ir trabajando. 
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• Planos y curvas.  

Creamos tres planos 

paralelos a la base y 

realizamos tres secciones de 

paso y un par de curvas guía. 

Por facilidad se entregan los 

Croquis. 

 

1. z18 2. z226 

3. Guía izq. 4. Guía der. 

5. z161 
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• Preparación secciones para “Multisection”.  

Antes de intentar juntar las secciones tenemos que trabajar con ellas para que todas tengan 

el mismo número de puntos. Para ello usamos la proyección de puntos. 

La parte superior tiene sólo dos puntos mientras las otras dos secciones tienen cuatro 

puntos. Le añadimos pues dos puntos como proyección a esta parte superior. 
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•“Multisection”.  

Una vez tengamos las 

secciones de paso y las 

guías preparadas podemos 

crear nuestra primera 

superficie. 

Al finalizar la superficie le 

pedimos que nos cree 

curvas en los límites inferior 

y superior con “Boundary”. 
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• Curvas paralelas 

Podemos crear la curva 

paralela a los límites de 

nuestra superficie usando 

“Parallel curve”. 

Luego podremos rellenar las 

paralelas. 

Antes cerramos las 

secciones creando líneas y 

usando el comando “Join”.  
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• Rellenar con “Fill” 

Rellenamos la curva cerrada creada con el comando 

“Fill”.  

Para rellenar usamos las curvas límite de las superficies 

y las líneas que hemos creado para cerrar. 
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• Parte del cuello del tapón con “Extrude” 

Para hacer la parte del cuello podemos usar una extrusión. 

Al hacer la extrusión nos pedirá una dirección de extrusión. 

Cuando usábamos “Sketch” 2D la dirección de extrsión por 

defecto era la normal al plano del “Sketch”.   
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• Juntar todas las superficies 
con el comando “Join” 

Para facilitar el trabajo posterior juntaremos 

todas las superficies creadas hasta el 

momento con el comando “Join”. Ahora 

elegimos superficies mientras que en 

operaciones pasadas habíamos juntado 

curvas. 
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• Redondeo de cantos con “Edge-Fillet” 

Una vez definida la forma básica ya podemos hacer 

redondeos de las aristas que nos interesen. 

El redondeo de la parte inferior lo haremos definiendo un 

punto en el centro de la arista y seleccionando junto a los 

extremos los tres puntos.  
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• Recortes mediante “Sphere” + “Trim”. 

Para poder hacer los entrantes definimos un croquis para fijar los 

centros. 

Realizamos una esfera con este centro y pasamos a recortar 

nuestra superficie con esta esfera usando “Trim” y al acabar 

redondeamos las aristas surgidas. 
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• Completar la simetría con “Symmetry” 

Para completar las superficies usamos el comando  

“symmetry”. 

Una vez realizada la simetría hacemos un “set” geométrico nuevo. En ese “set” 

juntamos las dos mitades mediante el comando “Join”. 
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• Añadir el espesor 

Finalmente pasamos de “Generative Shape Design” a “Part 

Design” para añadir el espesor a nuestra pieza. 

Como comprobación podemos mover una sección en “DMU” 

o hacer el plano. 
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• Plano 

Al crear el plano en 

lugar de rallar la 

sección le podemos 

dar un color de 

relleno. 
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• Optimización 

Como optimización 

se permite jugar con 

las cotas de los 

planos para intentar 

cuadrar el volumen 

a 1 litro. 
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• Introducción a superficies.  

Para completar las presentaciones de 

“workbenches” realizada en la sesión S01t tan 

sólo quedaba pendiente introducir el tema de 

superficies. 

Para entrar a superficies comenzaremos por: 

“Shape” -> “Generative Shape Design”. 

De esta forma se crea una “Part” y por tanto la 

extensión de los ficheros será “CATPart” pero 

no hay nada en PartBody, sólo Geometriacl Set.  
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• Help de superficies.  

Si entramos al Help de superficies veremos que 

el tema es muy amplio. 

También podemos comprobar que el número de 

iconos de superficies es muy grande. 
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• Ejercicio de introducción.  

Hacer dos planos para trabajar en ellos. 

Hacer un croquis en cada plano. (Por 

ejemplo que el segundo croquis sea un 

“offset” del primero) 

Hacer una “multisección” entre ambos 

planos. 

Comprobamos que en el árbol toda la 

geometría está dentro de “Geometrical Set” 
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• Ejercicio de introducción.  

Para crear los planos podemos usar la 

opción de “multi-point&planes”. 

De esta forma con un “sketch o curva” inicial 

tenemos varios planos para ir trabajando. 
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• Ejercicio de introducción.  

Crear un “Offset” de la superficie creada. 

Crear un tercer y cuarto plano entre los 

dos anteriores. 

Partir las superficies con “Split”. 

Juntar las superficies de nueve con “Multi-

section”. 

Redondear las nuevas aristas con “Fillet”. 
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• Ejercicio de introducción.  

Crear una curva suave en la base en la 

que creamos un plano de apoyo. Esta 

curva se usará como guía. 

Crear un barrido con “Sweep” -> “Explicit” 

cogiendo un extremo y la curva guía. 

Si no hemos tenido cuidado con la guía no 

coincidirán los extremos. 

Por lo tanto lo que podemos hacer es 

cortar y volver a unir superficies. 
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• Ejercicio de introducción.  

Crear una simetría de la superficie creada. 

Para ello tendremos que recortar el final 

de tubo para que sea plano y que la 

simetría quede bien unida. 
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• Modificación con “Affinity”.  

Podemos modificar una perfil aplicando un 

escalado con diferentes escalas en los tres 

ejes. 

Una vez cambiado el perfil hay que editar 

la operación de superficie y reemplazar el 

perfil utilizado. 

Hay que tener cuidado con el orden de las 

operaciones. Al elegir los puntos de origen 

en el perfil hay que seleccionar puntos del 

perfil para no caer en problemas de 

dependencia al escoger puntos de la 

superficie que queremos modificar. 
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• Histórico de 
construcción.  

Para ver un árbol de la historia de la 

geometría existe un icono específico. 

Con este icono podemos investiga la 

historia de un elemento concreto. 

De esta manera podemos ir viendo 

las dependencias de una zona 

concreta e ir modificando el gráfico 

para añadir otras zonas. 
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• Resumen. 

 Ejemplo práctico del método de trabajo usado en superficies. 

 Operación “Join”. 

 Operación “Project”. 

 Operación “Parallel curve”. 

 Operación “Fill”. 

 Operación “Extrude”. 

 Operación “Sphere”. 

 Operación “Trim”. 
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• Introducción a superficies.  

Tutorial de superficies.  
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• Botella.  

Como ejemplo de la 

metodología de trabajo 

con superficies vamos a 

trabajar haciendo la 

siguiente botella. 

Primero hemos de 

empezar por definir las 

dimensiones para crear 

las curvas en las que 

nos vamos a apoyar 

para ir trabajando. 
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• Planos.  

Creamos tres planos 

paralelos a la Planta a las 

siguientes distancias: 

• 18 mm 

• 161 mm 

• 226 mm 
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• Secciones.  

Dibujamos estos Sketches en 

el plano indicado 

z18 z226 
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• Curvas.  

Creamos dos curvas en dos Sketch distintos en el plano Alzado. 

Tienen que ser coincidentes con los extremos de los dos Sketch dibujados. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S05t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 34 

• Sección central.  

Realizamos este Sketch en el plano z161 
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• Sección central.  

Para definirla completamente tenemos que hacer coincidir los extremos con las curvas, 

para hacerlo utilizamos Pierce. 
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• Multisection. 

Para crear una superficie que se adapte a todos los perfiles hechos utilizamos 

Lofted Surface. 

En profile seleccionamos los Sketch hechos en los planos paralelos a la Planta y en 

Guide Curves los hechos en el plano Alzado.  
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• Extensión. 

Extendemos el fondo de la botella con Extend Surface hasta el plano de la 

Planta. 
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• Relleno de superficie. 

Cerraremos la parte inferior de la botella Para ello primero realizaremos un 

Sketch en la parte inferior con la misma forma que el culo de la botella.. 
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• Relleno de superficie. 

Haremos la primera parte del cuello de la botella. 
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• Extrusión de superficie. 

Para hacer la parte del tapón extruiremos una superficie. Para ello 

realizaremos un Sketch en la parte superior y extruiremos la suferficie. 
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• Knit Surfaces. 

Debemos unir todas las superficies para así facilitar las operaciones 

posteriores. Para eso utilizaremos la herramienta Knit Surface. 

Cuando unimos superficies debemos tener en 

cuenta la Knitting Tolerance ya que esta marca 

cuando se pueden unir superficies o no. 
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• Fillet. 

Vamos a realizar un Fillet 

de radio variable en la 

parte inferior de la 

botella.. 

Los radios son de 16 mm en los 

extremos y de 4 mm en la parte 

central, se deben poner a mano 

sobre la zona grafica. 
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• Recortes. 

Para realizar los entrantes primero definimos dos Sketch en el plano Alzado. 
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• Revolución. 

Ahora realizamos una revolución de los Sketch. 
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• Recortes. 

Restaremos la dos superficies hechas a la botella. Para ello tendremos que 

realizar dos Trims. 
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• Fillet. 

Vamos a realizar un Fillet de radio constante (4 mm) en los entrantes. Primero 

hay que realizar un Knit surface con todas las superficies. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S05t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 47 

• Mirror. 

Realizamos la otra parte de la botella con la herramienta Mirror. Como plano de 

cogemos el alzado y en Bodies to Mirror seleccionamos todas las superficies 

realizadas. 
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• Thicken. 

Le vamos a dar un grosor de 2 mm hacia el exterior. 
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• Plano 

Al crear el plano en lugar de 

rallar la sección le podemos 

dar un color de relleno. 
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• Sustainability 

Vamos a realizar el estudio de sostenibilidad de la 

botella. Para más información se puede realizar el 

tutorial que hay en la ayuda de SW. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S05t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 51 

• Sustainability 

Este complemento evalúa el impacto ambiental y la sostenibilidad del modelo en 

éstas áreas: 

• Huella de carbono. 

• Consumo de energía. 

• Acidificación del aire. 

• Eutrofización de las aguas. 

Se calcula basándose en éstos parámetros: 

• Material. 

• Proceso  y lugar de fabricación. 

• Transporte y uso. 

• Vida del producto. Univ
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• Sustainability 

Activamos la herramienta de sustainability en el menú Tools, "Sustainability…". 

Lo primero que haremos es establecer unas condiciones básicas de fabricación: 

• Material: Seleccionamos el material del que está fabricado, PET. (apretamos 

Set Material). 

• Manufacturing: Seleccionamos el proceso de fabricación y dónde se produce, 

Injection Molded, Europe. 
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• Sustainability 

• Transportation and Use: Seleccionamos dónde se exporta el producto y dónde 

se utiliza. 

• Finalmente clicamos sobre el botón de Set "Baseline". 

 

Volvemos al apartado Materia 
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• Sustainability 

Ahora, en el apartado de Material, seleccionamos "Find Similar". Buscamos un 

material con una densidad parecida y un módulo elástico superior. 

Seleccionamos un material, un proceso de fabricación y aceptamos. 

Observamos que los gráficos de la parte inferior del panel varían. En gris se encuentra 

graficado el PET y encima el nuevo material. 
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• Sustainability 

Podemos variar las distintas opciones que tenemos, como la región de 

fabricación y la de uso. Vemos como los gráficos se van actualizando. 

Una vez realizados todos los cambios, se 

puede generar un informa automático 

clicando sobre el botón "Generate 

Report".  

Nos generar un informe con los datos de 

sustanibilidad. 
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• Resumen. 

 Ejemplo práctico del método de trabajo usado en superficies. 

 Operación “Lofted Surface”. 

 Operación “Extend Surface”. 

 Operación “Filled Surface”. 

 Operación “Extruded Surface”. 

 Operación “Knit Surface”. 

 Operación “Revolved Surface”. 

 Operación “Trim Surface”. 

 Operación “Mirror”. 

 Módulo Sustainability. 
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• Entregable. 

Se pide a los alumno la botella sólida con la rosca de la clase anterior. 
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• Proyecto. 

Se continuará el proyecto creando la tuerca en SolidWorks, exportando y 

montando en Catia. 
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• Resumen de puntuación alcanzada. 
0.10 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.10 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

0.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.00 de 0.50 Ergonomía (C)  

0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

2.30 de 13.00 Total 

1.4 horas de dedicación 
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• Repaso última sesión. 

 Trabajo con superficies y creación de una botella. 
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La digitalización se utiliza básicamente para Ingeniería Inversa 

 Ingeniería Inversa: Utilizada para digitalizar 

productos y transformarlos en modelos CAD 

3D con las siguientes operaciones: 

 Digitalizado: Obtener una nube de puntos 

del modelo físico.  

 Procesado de  la información digitalizada: 

 Generar malla triangular o tetraédrica a 

partir de la nube de puntos. 

 Optimizar y corregir manual y/o 

automáticamente esta malla. 

  Generar curvas y/o superficies a partir de 

la malla.  
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Técnicas de digitalizado: 

De contacto físico Ópticas 
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Esquema típico de trabajo: 

Escáner 
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Estrategias 

Untrimmed 

surfaces  
Surfaces with  

added fillets 

Trimmed 

surfaces 

DIGIT 

Mesh data 

including fillets Segmentation 

CAD 

DIGIT 
CAD 

Mesh data with 

mechanical 

shapes 

Basic shape 

recognition and 

recovery 

Free form 

Mesh data 

Characteristic line 

creation 

Surface reconstruction 

DIGIT CAD 
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Estrategia de trabajo en CATIA 

Malla          Nube de puntos                                                         

Lista de puntos 

independientes 

desde digitalizado 

Pieza real 
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 Tratamiento de la información digitalizada. Nube de puntos, o archivo stl en bruto, 

que debemos tratar 

Información parcial típica por la cantidad de puntos 

adquiridos durante la digitalización. Puede ser 

necesario filtrar y corregir la información recibida: 

•Filtrar los puntos  

•Generar la malla 

•Corregir la malla 
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Acciones complementarias para corregir la malla: 
 

•Podemos “sacar” geometría alámbrica a 

partir de seccionar la malla o de dibujar 

curvas de apoyo o de guía. 

 

•Debemos rehacer aquellas zonas que no se 

han captado bien si no tenemos la opción de 

obtener un digitalizado de mejor calidad. 
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Caso práctico de generación de superficies a partir de digitalizado 
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Control de calidad – Comparativa CAD 

•Se compara la superficie versus el digitalizado para evaluar el nivel de corrección 

de la reconstrucción. 

•También sirve para comparar la pieza real fabricada versus el modelo CAD. 
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• Edición de digitalización y reconstrucción de superficies   

Para trabajar con información proveniente de digitalización de superficies, en CATIA, se 

utilizan los workbenches: Digitized Shape Editor y Quick Surface Reconstruction 
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En el Workbench Digitized Shape Editor la organización de las herramientas 

sigue la secuencia propuesta en las estrategias de trabajo típicas 
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• Digitized Shape Editor.  

Iniciamos el Workbench “Digitized Shape Editor” y comprobamos que el fichero a 

generar será un CATPart. 
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• Importando geometría.  

Primero vamos a importar la geometría digitalizada. 

Para ello usamos el icono de importar y seleccionamos el fichero del Help: 

\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\dseug_C2\samples\Carmirror1.cgo_ascii 

El formato de este ejemplo es ASCII-CGO. 

Seleccionar estadísticas y hacer un “Update” con lo 

que se nos informará del número de puntos de la  

nube que estamos leyendo y una estimación del  

tiempo de lectura de tantos puntos. 
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• Eliminar puntos error.  

Como resultado de la digitalización hay una 

serie de puntos que son erróneos. Podemos 

cambiar el tamaño de la caja a importar 

moviendo las flechas de cada cara. 

Finalmente hacemos “Apply” y “OK” para 

importar la nube de puntos en nuestro 

modelo. 

Comprobamos que tenemos un set 

geométrico en el árbol de nuestra Part del 

que cuelga la nube de puntos. 
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• Crear una malla de la nube 
de puntos.  

Una manera de ver una superficie es ir 

haciendo triángulos d la nube de puntos 

digitalizados. Para ello seleccionamos 

“Mesh Creation” en 3D de la nube 

importada. Automáticamente se calcula una 

distancia para determinar que puntos son 

vecinos entre sí. Al hacer “Apply” se crea 

una malla inicial de triángulos. 

Sin embargo algunas zonas han quedado 

con huecos. 
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• Rellenar vacíos 
aumentando distancia 
entre vecinos.  

Para corregir el error de huecos 

vamos aumentando la distancia entre 

puntos para formar más triángulos. 

Si deseleccionamos los triángulos, 

cambiamos a “Flat” y escondemos los 

puntos tendremos una mejor 

visualización. 

Para finalizar hacer “OK”. 

Probar con “Flat” 
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• Chequear la malla.  

Para corregir los posibles errores partimos de un pequeño informe inicial. (El icono 

está muy abajo, escondido.) 

ERROR: non-manifold edge 
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• Búsqueda errores de manera visual.  

Podemos buscar los errores de manera visual. Para ello seleccionamos la malla que 

nos interese y con el click derecho desplegamos el menú en el que escogemos  

“properties” 
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• Triángulos en aristas.  

En algunos cambios de curvatura los triángulos producen un efecto no deseado. 

Para solucionarlo cambiamos la manera de ir haciendo triángulos. Conseguimos 

mejorar algo el canto pero el límite está en los puntos digitalizados. 
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• Limpiar triángulos defectuosos.  

Para resolver los problemas detectados con triángulos defectuosos usamos el 

“Mesh Cleaner”. Seleccionamos nuestra superficie y hacemos “Analyze”. De esta 

forma se detectan cinco vértices y una arista colapsada. 

También inspeccionamos lados de  

triángulo muy largos. 
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• Borrar triángulos defectuosos y rellenar.  

Al hacer “Apply” sobre cada defecto nos va borrando los triángulos que lo formaban 

y por tanto la superficie queda claramente agujereada. 

Para rellenar usamos “Fill Hole”. En principio el tamaño del agujero a rellenar ha de 

ser suficiente para rellenar los huecos entre triángulo pero no muy grande como 

para que llene agujeros de la pieza. En el caso de error ir limpiando y rellenando 

hasta cerrar todos los huecos. 
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• Crear curvas en aristas libres.  

A partir de los triángulos podemos ir creando curvas que nos servirán para hacer las 

superficies. Primero buscamos los límites de la figura escaneada.  
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• Crear curvas en superficies.  

Al igual que hemos creado curvas para los límites el escaneado podemos hacer lo 

propio para los límites de una zona plana. 

Mover el plano para crear la curva en la zona de interés. Activar la creación de 

curvas.  

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S06t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 26 

• Mallado con programa exterior.  

Generalmente los programas de digitalización ya nos dan un mallado y por tanto no 

es necesario este primer paso de ir creando la malla. 

Como ejemplo del formato que nos da el digitalizador que disponemos guardamos 

nuestro documento con formato “stl” usando “Save as”. 

Cerramos el fichero y empezamos  

“Start” -> “DMU Navigation” para insetar  

el fichero “stl”.   

Una vez insertado lo podemos seccionar 

pero todavía no es posible trabajar con él  

para hacer superficies y modificaciones. 
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• Generación de superficies.  

Para la generación rápida de superficies vamos a hacer el tutorial “Quick Surface 

Reconstruction”. Para ello empezamos este “Workbench” y usamos de nuevo el 

“Hybrid Design”. Comprobamos que generamos un “CATPart”. 

Abrir el fichero 

\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\qsrug_C2\samples\GettingStarted01.CATPart  
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• Crear curva para extender pieza.  

Primero creamos una curva para poder hacer la simetría al igual que hacíamaos con 

el “Workbench” anterior. Después de hacer “Apply” podemos introducir puntos para 

ir dividiendo la curva en trozos picando sobre ella. 
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• Crear superficie extendida.  

Juntamos las curvas en una sóla con “Join” y el resultado  

lo movemos con “Translate” 15mm en Z hacia abajo. 

Unimos las curvas para crear una superficie intermedia 

usando el “Multi-section”. Ya tenemos la primera superficie 

creada. 
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• Reconstruir la malla .  

Primero vamos a crear planos usando tres puntos existentes. Para ver  

los iconos de geometría de referencia hacer 

 “View” -> “Tools” -> “Wireframe”  

y seleccionar el plano. 

Ir creando arcos de paso para varias  

secciones. 
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• Curva 3D.  

Para curvas especiales podemos usar la creación de curvas 3D.  

Por ejemplo para la huella de la zona superior. 

Hacemos una curva que busque los contornos 

con “Clean Contour”. 
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• Reconstruir superficie.  

Hacemos “Power-fit” de la malla con la curva límite creada  

y ponemos el radio a 10mm. 

Así podemos hacer todas las superficies. 
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• Ayuda a digitalización con Dr.Picza.  

1.- Colocar la pieza bien fijada en la máquina de escanneo. 

2.- Abrir Dr.Picza3. 

3.- Encender la máquina. 

4.- Ejecutar SCAN 

5.- Hacer vista previa de la pieza. 

6.- Cambiar los parámetros de valores por milímetro. Elegir entre rotatorio o por 

planos. Hacer una estimación del tamaño del fichero y del tiempo de escaneo. 

7.- Escanear la pieza. 

8.- Chequear resultado de escaneo. Primero cambiar visualización: puntos -> 

estructura -> sombreado -> bordes. 

9.- Redigitalización: escaneado fino de una zona, línea o puntos. Univ
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• Ayuda a digitalización con Dr.Picza.  

10.- Crear malla con Dr. Picza. Existe la posibilidad de ir rellenando agujeros como 

en Catia pero con menos control. Mejor lo hacemos en Catia. 

11.- Si hay agujeros rellenos que no han de estar se pueden vaciar desde el botón 

con forma de asa de una taza. 

12.- Exportar los resultados a ficheros para CATIA. Podemos exportar desde tan 

sólo la nube de puntos hasta el fichero arreglado con triángulos. Un formato usado 

en SEAT es el “stl”.  

13.- Abrir el fichero desde “3D Editor” en que aparecen 4 vistas de la pieza. Antes 

de pasar a “3D Editor” escaneamos la figura por planos pues dura más tiempo y lo 

dejamos escaneando mientras trabajamos con “3D Editor”. Primero hacemos un 

corte-sección. Con esta operación se hace un “split” de Catia de la superficie por 

un plano y por tanto la superficie queda dividida en 2 superficies. 

14.- Mover superficies. Las superficies se pueden mover, girar y escalar 

modificando la pieza original. Las superficies también se pueden seleccionar y 

borrar. 
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• Ayuda a digitalización con Dr.Picza.  

Practicamos en clase la digitalización de una lata o cualquier otro objeto opaco 

pero no negro. 
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• Automatic Surface: Car body rapid prototype surfacing.  
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•Open: Automatic_Surface.CATProduct 
•Import the digit data 

- Navigate to Digitized Shape Editor workbench 

• Right click over the geometrical set named 
‘digit data import’ and select Define In Work 
Object from the contextual menu. 

• Select Import  from the Cloud Import toolbar. 

• Select the concept_car.stl file from standard 
Windows Dialog box. Catia recognizes 
automatically the file format as .stl  

• Select Update Update to display the cloud of 
points along with its bounding box.  

• Selecting the Statistics check box will allow 
you to get information in the statistics 
window (number of points, 
dimensions…note: 1/5 scale model) 

• Use Apply then OK to create the Cloud 
Import entity 

 

• Step 1: Digit Import & Editing.  
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• Create the mesh 
- Create facets on the cloud of points using the 
active points 

• Select the concept_car.1 entity that you 
have just created. 

• From the Mesh Toolbar choose Mesh 
Creation icon 

• Type the Neighborhood value of 
6.405mm.This was found as the optimal 
value for this mesh to close unwanted 
holes. Although it creates some unwanted 
non manifold edges that can be deleted in 
the following steps. 

• Click Apply then Ok to create the mesh. 

• Select the Mesh_creation.1 entity that has 
just been created then select the Mesh 
Cleaner icon 

• Select Analyze to displays the stats on 
defects of the mesh 

• Select the defects type you want to erase, 
and eventually the color you want to 
display it with 

• Click Apply to erase the defects. Catia 
fixes the defects that it found. However 
there may be some imperfections that 
need to be resolved by hand. 

 
 

• Step 2: Mesh Creation.  
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 Cleaning the mesh 

- Deletion of corrupted /duplicated triangles, triangles 

with inconsistent orientations, non manifold edges 

vertices, isolated triangles, triangles with long edges 

and filling of holes. 

• Select the Mesh_creation.1 then select the 

Cloud Display icon. Select to display Triangles 

and Non-manifold edges.   

• Click the Remove icon on the Cloud Edition 

toolbar. Select Pick Mode and Triangle Level to 

select and delete the non manifold elements. 

• The Removal and Mesh Cleaner process cause, 

in turn, holes to be created in the mesh. These 

can be filled using Interactive Triangle Creation 

& ….. 

• Fill Hole commands. After each mesh cleaning 

process, we can come back to use the Mesh 

Cleaner function to check the integrity again. 

• Step 3: Cleaning Mesh.  
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Improve the quality 

- Flip Edge & Mesh Smoothing  

 

• Select the Flip Edges icon and the mesh  

• Enter 2 as the value of Depth 

• Click Apply then OK to validate. 

 

• Select the Mesh smoothing icon 

• Select single effect and leave the default 

value of 0.5 Coefficient,  

• Click Apply then OK. The cumulative 

deviation statistic is displayed 

• Step 4: Improving Edges.  
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• Creation of the Automatic Surface 
- Rapidly Surface the mesh in one shot with a class B 
finish. 

• Change Workshop to Quick Surface 
Reconstruction and select the Mesh Smoothing.1 
entity that you have just created. 

• Select the Automatic Surface icon from the 
Surface Creation toolbar. 

• Use setting of: 

 Mean Surface Deviation (0.5mm) 

 Adjust Surface Detail to 1000  

 Enable Free Edge Tolerance of 1 mm  

 Default Target Ratio of 90%  

 - and select Preview 

• Accept the computation limit warning notifying you 
that the combination of parameters could not be 
calculated. This does not mean the computation 
failed but the Target ratio of measured points with 
a surface deviation under the Mean surface 
deviation value could not be obtained. 

• Selecting the More button displays; details of the 
process and options to control the display of 
surface deviations.  

• Click OK to accept the surface or input new 
parameters to adjust the result.  

 

 

 

 

 

• Step 5: Automatic Surface.  
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Modify input parameters adapted to required precision. 

• Hide the Mesh Smoothing.1 entity to display only the 

Automatic Surface.  

•  The Symmetry of this surface is created using the 

command from the Transformations Toolbar. 

• Returning to select the Mesh Smoothing.1 entity, again 

select the Automatic Surface icon Use settings of: 

 Mean Surface Deviation 0.1mm 

 Adjust Surface Detail to 4000  

 Enable Free Edge Tolerance of 1 mm  

 Default Target Ratio of 100%  

 - and select Preview. 

• Accept the computation limit warning again and select 

OK to compute the result. 

• Applying a Material to the surface, such as the DS 

Light Blue paint scheme allows us to pick out the 

definition and compare the shape detail enhancement 

around detailed objects. The increased of the Surface 

Detail value from 500 to 4000 can be noticed in the 

resulting surface’s respect of mesh details, such as 

around the light cluster and door post.  

• Step 6: Modify Surface.  
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• Resumen. 

 Hemos visto como arreglar puntos digitalizados y crear malla a partir de ellos. 

 Hemos visto las bases para reconstruir superficies a partir de malla digitalizada. 

 Se ha intentado reproducir el trabajo de digitalización de una pieza con Pizca. 
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• Scan to 3D. 

Como esta función de SW se pueden utilizar datos cualquier scaner 3D (puntos de 

malla o nube de puntos) para convertirlos en una superficie o sólido. 

El procedimiento es simple: 

1. Abrir el archivo con los datos (malla o nube de puntos). 

2. Preparar la malla utilizando la herramienta "Mesh Prep Wizard". 

3. Seccionar la malla utilizando la herramienta de "Section View". 

4. Dibujar curvas en 2D Sketch o 3D Sketch que sigan la forma de la malla. 

5. Crear superficies utilizando las curvas. 

6. Utilizar las herramientas Trim y Knit en las superficies creadas. 

7. Crear el modelo sólido. 
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• Ayuda módulo.  
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• Activación módulo.  

Activar el módulo de ScanTo3D   
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• Ejercicio lata.  

Abrimos directamente el archivo "lata_vertical.txt" y seleccionamos el Mesh Prep 

Wizard… 
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• Ejercicio lata.  

En la primera pantalla se selecciona la nube de puntos de la que queremos realizar 

la malla. 

En la segunda Point Clound Orientation se puede escoger el origen de 

coordenadas de la malla. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S06t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 50 

• Ejercicio lata.  

En la siguiente pantalla se puede escoger la cantidad de puntos anómalos que se 

quieren quitar automáticamente, si movemos la barra podemos ver en la zona 

grafica los puntos que quitan. 

Arreglamos la malla. Para ello en Exraneous Data Removal borramos los puntos 

anómalos. 
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• Ejercicio lata.  

En Simplification se establece la 

simplificación que se quiere reduciendo 

el numero de puntos de la malla. Si 

movemos la barra vemos que el número 

de puntos varía. 

En la pantalla Smoothing se establece la 

suavidad que tendrá la malla. Moviendo 

la barra podemos ver el efecto. La 

suavedad se puede modificar de una 

forma global o localizada. 
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• Ejercicio lata.  

En la pantalla Fill holes se rellenan los agujeros que hay en la malla, en nuestro 

caso sólo rellenaremos el pequeño. 

Con esto ya hemos acabado de crear la malla. Podemos presionar el tick y 

tendremos la malla hecha o siguiente para empezar con el Surface Wizard. La 

herramienta surface Wizard és útil cuando el modelo es sencillo y simétrico en 

algunos planos, no es nuestro caso. Univ
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• Ejercicio lata.  

Ahora seccionamos la lata como creamos, creamos planos dónde queramos 

dibujar un Skecth dónde seguiremos la forma de la lata. 
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• Ejercicio lata.  

Para conseguir la forma mas parecida posible con la de la lata utilizamos la 

herramienta de Spline. 
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• Ejercicio lata.  

Lo mejor es realizar varios Skecth 

perpendiculares al plano alzado que 

servirán como curvas guía. 
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• Ejercicio lata.  

Tenemos que hacer coincidir las 

secciones con las curvas guía 

utilizando la herramienta Pierce. 
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• Ejercicio lata.  

Con la herramienta Surface Loft. En Profiles seleccionamos la secciones 

paralelas al plano Alzado y el Guide curbes las otras cuatro. 
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• Ejercicio lata.  

Utilizamos el Deviation Analysis que calcula el ángulo entre caras creadas y la 

nube de puntos. Una vez realizado el cálculo se puede generar un informe. 
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• Ejercicio lata.  

Si el análisis de desviación no sale satisfactorio se pueden modificar los Sketch 

pertinentes hasta que los resultados sean los deseados. 

Finalmente eliminamos la nube de puntos y nos quedamos sólo con la superficie 

creada. 
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• Ejercicio lata.  

Se pueden generar las superficies de forma automática. Para ello cuando se 

finaliza el Mesh Prep Wizard… Se utiliza la herramienta Surface Wizard…   
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• Ejercicio lata.  

Se pueden generar las superficies de forma automática. Para ello cuando se 

finaliza el Mesh Prep Wizard… Se utiliza la herramienta Surface Wizard… 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S06t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266   P. 62 

• Ejercicio lata.  

En la siguiente paso se pueden seleccionar dos opciones: 

• Automatic creation: realiza un proceso de un solo paso para crear un modelo 

solido. 

• Guided creaton: realiza un proceso de varios pasos para crear superficies, 

permite mas control sobre éstas. Ésta opción es buena cuando se tienen 

superficies analíticas o cuando se tiene mas control sobre superficies. 

Escogemos la Automatic creation. 
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• Ejercicio lata.  

Finalmente ajustamos la resolución de la superfície. A mayor detalle más 

parecido será el detalle de la superficie creada. 
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• Ejercicio Muela.  

Podemos realizar los mismos pasos con el digitalizado de una muela. La única 

diferencia es que se abre directamente un archivo *.stl. Éstos archivos utilizan 

una malla de pequeños triángulos sobre las superficies para definir la forma del 

objeto. 
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• Resumen. 

 Hemos visto como arreglar puntos digitalizados y crear malla a partir de ellos. 

 Hemos trabajado con superficies para reproducir el objeto digitalizado. 

 Hemos analizado la diferencia entre el sólido/superficie creado y el digitalizado. 
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• Lego. 

Continuamos con el juego de lego ensamblando las piezas. 
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• Proyecto. 

Para el proyecto construyo la goma como la varilla. 
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• Resumen de puntuación alcanzada. 
0.10 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.10 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

0.20 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.00 de 0.50 Ergonomía (C)  

0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

2.50 de 13.00 Total 

1.8 horas de dedicación 
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• Repaso última sesión. 

 Digitalización e ingeniería inversa. 
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• Doblado de piezas de chapa.  

Una posibilidad de fabricación de piezas es usar el doblado. Para entender las 

limitaciones de este proceso hay que tener en cuenta el material a doblar. En Catia 

estos parámetros los introducimos como espesor de pieza y radio mínimo a doblar.  

Para un material que rompe al 20% podemos hacer un Radio según las 

ecuaciones de deformación R>t/0,4=2,5t. 

*En producción el radio es el  

interior (Rb=R-t/2) 
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Material Soft Hard 

Aluminium 0 6t 

Beryllium copper 0 4t 

Brass, low-leaded 0 2t 

Magnesium 5t 13t 

Austenitic steel 0,5t 6t 

Low-alloy steel 0,5t 4t 

Titanium 0,7t 3t 

Titanium alloys 2,6t 4t 

Fracture Strain R  Rb  

5% 10t 9.5t 

10% 5t 4.5t 

20% 2,5t 2,0t 

50% 1t 0.5t 
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• Doblado de piezas de chapa.  

Estos parámetros, radio y espesor, se han de introducir en el módulo de Catia de 

doblado de chapa. 
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• Doblado de piezas de chapa.  

Además de la relación entre espesor y radio de doblado hay que definir como se 

cortan las paredes para evitar que estén en contacto evitando así puntos de inicio 

de corrosión. 

log(min(100,max(20*`Sheet Metal Parameter.1\Bend Radius`,`Sheet Metal Parameter.1\Thickness`)/`Sheet Metal Parameter.1\Thickness`))/log(100)/2 
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• Doblado de piezas de chapa.  

Con los parámetros definidos ya podemos empezar a crear una pieza empezando 

por un “Sketch” y crear la primera pared de la pieza. 
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• Doblado de piezas de chapa.  

Una vez se ha definido la primera pared podemos ir levantando las paredes 

laterales. Al hacerlos podemos decir que la pared quede levantada con el ángulo 

de doblado. 
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• Doblado de piezas de chapa.  

Como resultado de la limitación entre paredes a doblar puede que la geometría 

cambie sin que sea nuestro propósito. Hay que vigilar estos cambios. 

También podemos hacer extrusiones  

de perfiles abiertos. 
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• Doblado de piezas de chapa.  

En el caso de tener paredes sin el radio de doblado podemos añadir dicho radio a 

posteriori. Para final de pieza se pueden elegir varias formas de acabar como por 

ejemplo el engrapado (Hem) de a figura. 
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• Doblado de piezas de chapa.  

Otra posibilidad de trabajar es hacer la pieza plana y reproducir los doblados 

usando “sketch” con líneas que definen la posición del elemento que fuerza la 

pieza a ser doblada. 
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• Doblado de piezas de chapa.  

Dentro de este módulo podemos introducir también las operaciones en las que se 

introducen agujeros. 

Las aristas no dobladas se pueden redondear dentro de este “workbench”. 
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• Doblado de piezas de chapa.  

En este módulo se reconoce la posibilidad de que algunas zonas no sean dobladas 

e incluyan una pequeña “buña” para aportar rigidez. 
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• Doblado de piezas de chapa.  

Podemos ir desdoblando caras para ver la 

pieza plana de una en una, o de golpe 

poniendo la pieza entera plana. 

También podemos comprobar si hay un 

problema de interferencias en el doblado  

con “check overlapping”. 
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• Doblado de piezas de chapa.  

Si la pieza se ha creado desde este “workbench” podemos hacer el plano de la 

pieza y que una de las vistas sea la pieza original a recortar para posteriormente 

doblar. Otra forma es pasar la información de la pieza desdoblada (plana) como 

DXF. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



 IPAO S07t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 (Guillermo Reyes)  P. 15 

• Doblado de piezas de chapa.  

Si la pieza no se ha creado desde este “workbench” podemos abrirla e intentar 

reconocer las caras. Como ejemplo guardamos la pieza como “stp” y la cerrramos. 

Abrimos un nuevo “Generative Sheetmetal Design” y hacemos “file” -> “open” del 

“stp” creado. Una vez reconocidas las paredes se puede desplegar. 
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• Doblado de piezas de chapa.  

Si la pieza no está bien diseñada para ser trabajada como doblada no podremos 

desdoblarla. 
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• Doblado de piezas de chapa en SolidWorks.  

Tutorial de doblado de chapa. ... 
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• Doblado de piezas de chapa.  

Una posibilidad de fabricación de piezas es usar el doblado. Para entender las 

limitaciones de este proceso hay que tener en cuenta el material a doblar. En Catia 

estos parámetros los introducimos como espesor de pieza y radio mínimo a doblar.  

Para un material que rompe al 20% podemos hacer un Radio según las 

ecuaciones de deformación R>t/0,4=2,5t. 

*En producción el radio és el  

interior (Rb=R-t/2) 
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Material Hard Soft 

Aluminium 0 6t 

Beryllium copper 0 4t 

Brass, low-leaded 0 2t 

Magnesium 5t 13t 

Austenitic steel 0,5t 6t 

Low-alloy steel 0,5t 4t 

Titanium 0,7t 3t 

Titanium alloys 2,6t 4t 

Fracture Strain R  Rb  

5% 10t 9.5t 

10% 5t 4.5t 

20% 2,5t 2,0t 

50% 1t 0.5t 
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• Chapa doblada.  

Para hacer el ejercicio vamos a utilizar un material que tiene un espesor de 1.5 mm 

y una Fracture Strain del 20%, 

Esto implica que el radio de doblado R es de 3.75 y el radio interior Rb es de 3 

mm. 
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• Chapa doblada.  

Primero realizamos este Sketch y lo extruimos 100mm con la Thin Feature 

activada a 1.5 mm. 
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• Chapa doblada.  

Convertimos el sólido en chapa doblada. Seleccionamos la cara que queda fija y 

luego apretamos sobre Collect all bends, que selecciona todos los doblados 

automáticamente. Hay que modificar las opciones a un espesor de 1.5 mm y un 

radio de 3 mm. 
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• Chapa doblada.  

Insertamos una pestaña con la herramienta Edge Flange. Seleccionando la arista 

superior de la parte trasera de la base. De una longitud de 92mm y con la opcion 

de Bend Ouside activada. 
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• Chapa doblada.  

Insertamos una pestaña otra pestaña, con otra 

herramienta: Base Flange/Tab. Con esta opción la 

tenemos que dibujar un Skecth.  

Fijaros que dejo una distancia de 4.5 mm entre la 

pestaña lateral y el Sketch. Ésta distancia es la 

necesaria para el doblado de la pestaña y que ésta 

entre en contacto con la pestaña lateral. 
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• Chapa doblada.  

Insertamos otra pestaña con la misma herramienta en la pestaña lateral. 

Finalmente copiamos las dos pestañas utilizando un Mirror Entities. 
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• Chapa doblada.  

Doblamos las dos pestañas de la pestaña inferior con la 

herramienta Sketched Bend, en la que hemos de realizar 

una línea por donde queremos doblar. El doblad se hace 

hacia afuera. 
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• Chapa doblada.  

Doblamos las dos pestañas que nos quedan del mismo modo. 
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• Chapa doblada.  

Finalmente doblamos la última pestaña. 
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• Chapa doblada.  

Si se ha realizado bien el doblado se puede comprobar como queda la chapa 

cuando no esta doblada utilizando la herramienta Flatten. 
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• Chapa doblada.  

Finalmente realizamos los agujeros de ventilación. 
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• Chapa doblada.  

Ahora realizamos el plano. Para insertar la chapa sin doblar, 

seleccionar Flat pattern en la Orientation. También hay que 

clicar en la opción de Import annotations. 

Finalmente se editan las anotaciones de doblado y se acota el 

plano. 
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• Chapa doblada.  

También se puede realizar todo el ejercicio con la herramienta Edge Flange pero 

hay que ir en cuenta con el orden en el que se realizan los plieges. El orden debe 

ser el mismo que haríamos nosotros para doblar la chapa. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



 IPAO S07t 

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 (Guillermo Reyes)  P. 33 

• Resumen. 

 Introducción al módulo de doblado de chapa. 

 Creación de planos de chapa antes de doblado. 
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• Lego. 

Continuamos con los planos. 
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• Proyecto. 

Realizamos la chapa  

doblada para el proyecto. 
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• Proyecto. 

Realizamos la chapa doblada para el proyecto. 
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• Proyecto. 

Documentamos 
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• Resumen de puntuación alcanzada. 
0.10 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.10 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

0.40 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(extra). 

0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S). 

0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.00 de 0.50 Ergonomía (C)  

0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

2.70 de 13.00 Total 

2.0 horas de dedicación 
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• Repaso última sesión.
 Doblado de chapa.
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• Help sobre Moldes y 
matrices. 
En esta sesión vamos a ver unas 
pinceladas de los módulos de 
moldes y matrices disponibles 
“Mold Tooling” y “Core and Cavity”, 
ambos dentro de “Mechanical 
Design”.

Primero empezamos por el módulo 
de cavidades que nos permite 
analizar una pieza para ver que 
zonas se pueden desmoldear y que 
zonas necesitan una deslizadera.
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• Moldes y matrices. 
Como una primera aproximación a las 
piezas creadas usando moldes o matrices 
vamos a introducir el Workbench de “Core 
& Cavity Design”.

Primero creamos un ensamblaje e 
introducimos una “Part” llamada “Pieza”.

Hacemos activa la pieza (azul) y 
activamos el “Workbench” de “Core & 
Cavity Design”.
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• Importar pieza. 
La geometría de la pieza se supone que se ha hecho con el módulo más apropiado 
para la pieza, por ejemplo, “Part Design”. Ahora lo que haremos es importar la 
geometría en nuestra “pieza”. Como ejemplo usamos la del tutorial:

\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\ccvug_C2\samples\GettingStarted.CATPart .
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• Definir dirección de desmoldeo. 
Para poder hacer el molde es necesario definir en que dirección vamos a cerrar y 
abrir dichos moldes o matrices. Esta dirección se le conoce como dirección de 
desmoldeo o “pulling direction”.

Se deplega un menú que se autocompleta al seleccionar la “pieza”. A partir de 
ahora las caras verdes tocan a “cavity” y las granates a “core”.
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• Partes con otra dirección (deslizaderas). 
Si nos fijamos en la pieza veremos que hay zonas que no son ni verdes ni 
granates. Estas zonas necesitan otra dirección de desmoldeo y por tanto la 
introducción de correderas u otros artilugios en el molde.

Ángulo demasiado vertical para desmoldearNecesidad de corredera para agujero.
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• Definición de correderas. 
Para poder desmoldear puede ser que necesitemos correderas. Hay que definir por 
tanto como mover dichas correderas (slider).

Para tener la dirección arrastrar el compás sobre la pared en la que está el agujero 
y una vez la pared pasa de violeta a ocre bloquearla. 

Seleccionar las caras del agujero que todavía están de color cian.
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• Explosionado de las caras. 
Para visualizar mejor como ha ido eligiendo caras para cada dirección de 
desmoldeo podemos hacer un “explode”.

Comprobamos que las direcciones han quedado guardadas en el árbol.
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• Cambiar caras de zona. 
Si por alguna razón nos interesa que una cara esté en otra zona se puede cambiar 
con “transfer”.
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• Dividir caras para facilitar división molde. 
Puede ser de nuestro interés el dividir caras para facilitar el trabajo con las dos 
partes del molde (línea de partición). Para ello tenemos funciones que ya hemos 
visto trabajando con superficies como creación de curvas y “split”. Para el molde 
existe “Split Mold”.

Es mejor seguir las particiones por plano de página siguiente.
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• Dividir caras por plano. 
Para crear un plano hacemos un sketch en un plano perpendicular a la dirección 
de desmoldeo. Es aconsejable trabajar dentro del “Set” “Other.1”.
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• Completar división. 
Podemos ir completando superficies hasta cerrar la superficie de división. Para ello 
dentro de “Parting” nos permite hacer extrusiones y “multisection”.
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• Juntar superficies con “aggregate”. 
Podemos juntar las superficies generadas y que no forman parte de “core”, “cavity” 
ni “slider”.
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• Comprobar las aristas libres. 
Para comprobar la partición y todas las partes analizamos las aristas libres 
“boundary”. Podemos hacer una arista al elegir la superficie que ha salido del 
“aggregate-join” o la arista. Si escogemos la superficie nos creará dos curvas, la 
interior y la exterior.
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• Comprobar orientación de caras. 
Para comprobar la orientación de las caras disponemos de un icono que las puede 
ir invirtiendo. Este proceso se ha de hacer antes de diseñar las cavidades pues 
ahora cambiaría las zonas.
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• Crear caja que encierra a pieza. 
Para crear el molde o matriz empezamos por crear la caja que encierra a la pieza.

Conviene dar más tamaño que no el exacto de buscar los límites.
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• Diseño de moldes. 
Una vez hemos hecho el análisis y decidido que hemos minimizado el número de 
deslizaderas pasamos a introducir el módulo de creación de moldes.
En el Product insetar la pieza:
\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\mtdug_C2\samples\Split\GettingStarted01.CATPart
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• Crear el molde.
Para crear el molde disponemos de un menú de varias placas. Las placas tinen 
funciones diversas, desde fijación hasta eyección.
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• Molde de catálogo.
Los parámetros de molde los podemos tener guardados en catálogos. En este caso 
escogemos el catálogo de moldes de la figura. Dentro de l catálogo podemos editar 
parámetros.
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• Separar “Cavity” y “Core”.
Primero separamos los moldes para “core” y para “cavity”.
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• Visualizar división realizada.
Si jugamos con “hide/show” veremos el molde realizado hasta el momento.
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• Insertar componentes en molde.
Para completar el molde hay que insertar componentes como inyectores, canales de 
refrigeración, resistencias de calentamiento . . .

Para ello tenemos diversos iconos. 
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• Añadir pin eyector.
Al igual que las guías 
podemos añadir un pin 
eyector.
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• Añadir pin eyector.
Acabamos diciendo hasta donde tiene que llegar el pin eyector.
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• Crear punto de inyección “Gate”.
Para crear la pieza hay que inyectar a través de una puerta “Gate”.
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• Definir entrada a molde.
Definimos los parámetros de boca de inyección.
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• Optimización de forja y fundición. 
Muy parecido a los procesos de inyección que vimos en la semana pasada 
tenemos los procesos de fundición y forja en que también hay que definir 
moldes/matrices.

Usaremos la pieza del tutorial:
\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\cfoug_C2\samples\GettingStarted.CATPart. 
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• Optimización de forja y fundición. 
Primero vemos que ya se han hecho una serie de superficies para definir:

- Límite entre superior e inferior: “Surface” ->

- Límite superior: “Miscellaneous” -> “Sketch” + “Extrude”

- Ángulo: “Yellow surface” -> “Extract” + “Blend”.

A estas superficies le vamos a añadir otras que sellen el conjunto añadiendo el 
ángulo de desmoldeo necesario.
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• Ángulo de desmoldeo con Draft. 
Para facilitar el trabajo de creación de ángulo de desmoldeo existe el icono “Draft”. 
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• “Functional molded part”. 
Ya que la información de forja y fundición es escasa 
vamos a continuar con más módulos de inyección de 
los que se puede aplicar el conocimiento a fundición.

Entramos en “Functional Molded Part”. 
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• Creación de sólido inyectado. 
Para este ejemplo usaremos el teléfono del tutorial:
\\Sdoc\software\PUBLIC\Exp_Grafica\DAO\Help_Catia_Online\online\fm1ug_C2\samples\Phone.CATPart . 

Al abrir el fichero vemos las curvas del diseño a partir del cual vamos a hacer la 
pieza con este nuevo “Workbench”.
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• Edición de propiedades. 
Al crear la pieza sólida se han ido creando propiedades en el árbol que podemos 
editar. Empezamos por el espesor de lámina (shell). Editamos las propiedades con 
“doble click”. 

Seleccionamos la cara inferior
para quitar.
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• Vaciar-hundir pieza. 
Para hacer las teclas y pantalla hay que vaciar la pieza. Lo haremos en dos partes. 
Primero la zona de pantalla más botones de menú.
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• Continuar vaciando-hundiendo. 
Continuamos hundiendo la pieza para alojar 
la pantalla. 
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• Perforar la pieza. 
Para hacer los vaciados sin creación de paredes (Piercing) se usa el icono de  
definición de zonas protegidas. El resultado son prismas que definen zonas a no 
invadir por costillas u otros elementos. 
Repetir con agujeros altavoz “HP Holes”
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• Reserva espacio para mecanismo. 
Repetimos las operaciones anteriores para reservar 2mm para el mecanismo. 
Ahora si consideramos ángulo de desmoldeo para este espacio.
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• Rigidificar con costillas sin invadir espacios reservados. 
Para que la pieza de plástico sea rígida se pueden añadir costillas en la dirección 
de desmoldeo sin invadir las zonas protegidas reservadas para otros elementos. 
Para los costillajes hay que tener en cuenta que no queremos que se marquen en 
la cara vista. Para ello hay que hacerlos de la mitad del espeso de la pieza (por lo 
menos en la base) y así evitar “rechupes”.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S08t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 39

• Aplicar superficie de diseño a resultado plano. 
Tal y como hemos realizado la pieza la superficie superior ha quedado plana y 
ahora la podemos modificar para que se ajuste a una superficie de diseño. 

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S08t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 40

• Acabar la pieza con redondeos. 
Para acabar la pieza hacemos los redondeos oportunos. 
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• Hacer pieza Lego pensando en molde. 
Para acabar haremos
la pieza Lego 
pensando en molde. 
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• Resumen.
 Introducción al módulo de definición de zonas para moldes y matrices con 
definición de zonas en las que es necesaria una deslizadera.

 Definición del tamaño mínimo de molde/matriz.

 Introducción a la creación de partes de molde con guías, placas de fijación, 
eyectores, puntos de inyección . . .

 Hemos viso como sellar “sew” una superficie a un sólido.

 Hemos introducido una forma de hacer piezas pensando en el molde.
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• Help sobre Moldes y matrices. 
En SW2010 hay dos tutoriales.
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• Ejercicio Molde. 
Vamos a realizar el molde de una pieza de lego 2x2.
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• Ángulo de desmolde. 
Primero vamos a realizar un análisis de ángulo de desmoldeo. Utilizamos la 
herramienta Draft Analysis.

Seleccionamos la cara superior y la dirección de desmoldeo hacia arriba.

Ponemos el ángulo de desmoldeo de 1º.
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• Ángulo de desmolde. 
Con el mapa de colores podemos ver las caras que necesitan modificaciones.  

Verde: Ángulo positivo

Amarillo: Requiere modificación

Rojo: Ángulo negativo

Azul: Straddle Faces.

Las Straddle faces son las caras que contienen tanto ángulo positivo como negativo. Es necesario 
separarlas en dos para prevenir que la pieza se quede atrapada en el moldeUniv
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ity
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• Ángulo de desmolde. 
Se les aplica un ángulo de desmoldeo a las caras que lo necesitan utilizando la 
herramienta Draft. Hay que tener en cuenta como va a desmoldearse la pieza 
para poner los ángulos correctamente.
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• Ángulo de desmolde. 
Si realizamos es análisis de ángulo de desmolde se puede ver que no tenemos 
ninguna cara que requiera alguna modificación.
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• Escalado. 
El escalado se utiliza para aplicar un factor de reducción para acomodar la 
cantidad de material que se va a contraer al enfriarse.

Realizamos escalado uniforme de 1.05 desde el centro de la figura.
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• Parting Line. 
Ésta herramienta analiza el ángulo de desmolde y añade las lineas que separan 
las dos partes del molde, core y cavity.
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• Parting Line. 
Realizamos el Draft Analysis y aceptamos.
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• Parting Surfaces. 
Esta herramienta crea una superficie a partir de las 
Parting Lines que servirá para separar el core y la cavity.

En Mold Parameters seleccionamos la opcion de 
Perpendicular to pull ya que la superficie que separa las 
dos mitades del molde es perpendicular a la dirección de 
desmolde.

La distancia que podemos modificar en Parting Surface 
es el ancho de la superficie.

En Smoothing podemos escoger entre si queremos una 
transición angulosa o suave. Selecionamos la transición 
suave y ponemos una distancia de 2.5mm. A mas 
distancia la transición entre los bordes será mas suave.
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• Parting Surfaces.
Podemos ver la superficie creada.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S08t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 55

• Tooling Split.
Utilizaremos esta herramienta para 
crear el molde

Lo primero que se debe hacer es 
crear una Sketch en el plano dónde 
hemos realizado la Parting Surface.

Realizamos un Convert Entities de 
la Parting Surface.
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• Tooling Split.
Cerramos el Sketch y se abre el Porperty Manager de Tooling Split.

Tenemos que poner las alturas que tendrán la Cavity y el Core del molde.
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• Mover molde y apariencia.
Movemos las dos partes del molde con la opción Move/Copy… (Insert -
>Features).

Cambiamos la apariencia.
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• Guardar Molde
En la carpeta Bodies del Feature Manager podemos ver que existen tres 
cuerpos: La pieza original y otros dos que son las dos partes del molde.

Para guardaras por separado con el botón secundario escogemos la opción 
Insert into New Part… 
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• Modificaciones
Si modificamos las medidas del Sketch1 (donde hay los valores de las variables), 
se modifica la pieza de lego.

Si miramos alguna de las dos partes guardadas por separado vemos que 
también se modifican.
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• Resumen.
 Realización de moldes con SW.

 Ángulos de demoldeo.
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• Lego.
Creamos el molde de una pieza de lego.
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• Proyecto.
Continuamos trabajando en el proyecto con roscas y revisando la documentación
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• Proyecto.
Activamos las roscas en los planos
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• Resumen de puntuación alcanzada.
0.10 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.20 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
0.40 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S).
0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.00 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.10 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
2.30 de 13.00 TotalUniv
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• Repaso última sesión.
 Construcción de moldes y matrices.

 Detección de zonas con problemas de desmoldeo.
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• Inyección de plástico.
Desde SolidWorks para cualquier pieza podemos hacer la simulación de la 
inyección de plástico.
Vamos a usar de ejemplo la 
carcasa de espejo del proyecto 
activando el complemento de 
SolidWorks Plastics.
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• Help.
Al activar la licencia accedemos a un menú de ayuda que nos puede guiar.
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• Simular inyección.
1.- Definir el sólido a simular en auto.

2.- Definir el polímero de la base de datos.

3.- Definir la máquina de inyección si la sabemos.

4.- Definir las temperaturas de flow.

5.- Definir los tiempos de presiones.
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• Simular inyección.
6.- Definir temperaturas de paredes.

7.- Definir zona calefactada.

8.- Añadir entrada de inyección.

9.- Ejecutar Flow
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• Postprocesar.
Mirar los tiempos de inyección, marcas de rechupes,… 
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• Imprimir con la impresora BFB 3000+. Dibujar 3D

Dibujar pieza con un programa de CAD

Guardar esta pieza en formato STL

Archivo -> Guardar Como… -> Tipo : *.stl

Asegurarse exportar en ASCII: 
ir a “Opciones” y seleccionar “ASCII” y tolerancia

Aceptar y Guardar.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S09t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 10

• Preparar pieza con Axon.
Iniciar la programa “Axon 2” y abrir el fichero 
“pieza.stl”. Para instalar Axon:
\\sdoc2\Asignaturas\Exp_Grafica\3DPrint\Impresora3D_
BitsFromBytes\PC-Software\Axon 2.0.1 Setup.msi

Posicionar bien la pieza para que se puede 
imprimir correctamente dentro de las zonas de 
la base y pensar en la orientación y escalado

Comprobar que los cabezales están configurados con 
los materiales que están montados en la impresora

Settings -> Printer Configuration
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Comprobar que los materiales están configurados con los parámetros correctos de 
impresión

Settings -> Material Profile Editor

(1, 2 y 3 se presentan luego en tabla parámetros FDM)
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Build

Escoger el grosor de capa 

Seleccionar materiales de Raft / Support / Part 
(“Support = None” si no quieres soporte)

Seleccionar “Fill density”, “Fill pattern” según el 
acabado deseado

Seleccionar “Speed multiplier” (4 = Velocidad 
en tabla parámetros FDM)

Build y comprobar tiempos y costes

Guardar pieza en formato BFBUniv
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• Imprimir sin Raft
Si no hace falta imprimir con raft, se puede usar la programa Chylld’s Derafter 
para quitarlo.
Abrir el programa, seleccionar la pieza y pulsar De-raft.
\\sdoc2\Asignaturas\Exp_Grafica\3DPrint\Impresora3D_BitsFromBytes\PC-
Software\Derap.zip
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• Imprimir con cama calefactable.
Introducir la tarjeta en la BFB

Si es necesario calentar la base entonces:

Poner la rueda en la raya

Encender el transformador-potenciómetro.

Encender el tester para controlar los 
amperios (opcional)

Ajustar la intensidad moviendo la rueda y 
mirando el amperímetro de potenciómetro
para tener la temperatura deseada. 

Con 7amperios se suelen conseguir 
100ºC Univ
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ity
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• Ajustar base.
Z-height y Tornillos

La distancia entre la base y las boquillas se puede 
cambiar directamente en el menú “Set Z-height” de la 
impresora.
En el caso de que la base no esté totalmente plana, 
se puede aplanar mediante los 3 tornillos que la 
sujetan. 

Kapton

En el caso de que la base esté sucia o rota sustituir el 
kapton (especie de celo). En algunos casos para 
mejorar la adherencia se recomienda aplicar laca al 
kapton.

Imprimir

Desde el menú de la BFB ejecutar RUN FILE  -> pieza Univ
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• Tabla de parámetros de FDM.
.
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• Proyecto.
Continuar trabajando en el proyecto.

Los diez minutos de trabajo del día los dedico a trabajo de los planos.
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• Resumen de puntuación alcanzada.
0.10 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.20 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
0.40 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S).
0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.00 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.60 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
3.30 de 13.00 Total
2.5 horas de dedicaciónUniv
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ity
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• Resumen.
 Inyección de plástico con SolidWorks

 Impresión en 3D con técnica FDM usando Axon, Derafter  e impresora BFB.
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• Repaso última sesión.
 Chapa doblada.
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• Realizar chapa doblada y optimizar. 
Realizar una pieza en U para unir dos paredes y en 
chapa doblada y optimizar para que el software 
calcule la distancia necesaria C.

Una vez se corren las optimizaciones dar el valor de 
X que es la distancia a la que se ha de hacer el 
agujero en la pared.

INPUT OUTPUT
L (mm) D (mm) W (mm) RD (mm) ESP (mm) AG (mm) C (mm) X (mm)

v1 200 100 60 10 1 7 44.507 25.507
v2 300 200 60 10 2 7 44.724 26.724
v3 400 300 60 10 4 7 45.623 29.623

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S10t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 4

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S10t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 5

• Realizar chapa doblada y optimizar. 
Repetir el proceso con SolidWorks.
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• Optimización de geometría para un parámetro.

Con la versión más simple de SolidWorks se entrega el 
módulo de cálculo de piezas CosmosExpress. Este 
módulo permite cálculos lineales y la optimización de 
un parámetro. Creamos una biga y le aplicamos el 
material AISI 304.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S10t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 7

• Cálculo.
Abrimos la aplicación SimluationXpress... Y seguimos los pasos, aplicamos una 
fuerza a tracción de 50000N.
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• Cálculo rápido.
Nos debería dar una tensión de 250[N/mm2] y un alargamiento de 0.13[mm]. 

No ha dado 250 ya que no dejamos encoger la sección.Univ
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• Cálculo rápido.
El factor de seguridad nos da 
0.598 (206/347) que es muy bajo.
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• Parámetros de optimización.
Vamos a optimizar el diseño para un 
parámetro. Ponemos los límites inferior a 
10mm y el superior a 50mm.

Después debemos editar la constraint, que 
es el factor que queremos cumplir, en este 
caso que el factor de sguridad sea mayor a 
1.
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• Parámetros de optimización.
Nos encuentra la solución de 42.5mm. Hay que tener en cuenta, como era de 
esperar, que el peso también ha aumentado. 
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• Optimización en SolidWorks 
simulation.
Para hacer una optimización de geometría más 
completa hay que correr SolidWorks Simulation 
activando desde complementos. 
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• Añadimos estudio.
Primero vamos añadir un estudio estático para hacer una tracción pura.
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• Comprobamos resultados.
Primero comprobamos los resultados obtenidos en tensión 2.5e8 [N/mm2] y 
desplazamiento 0.13[mm]. 
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• Factor de seguridad.
Dentro de resultados creamos el plot para comprobar el modelo (Factor de 
seguridad). Vemos que el factor es de 0.83.
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• Creamos optimización.
Añadimos el estudio de optimización con el menú Insert -> Desing Study -> Add…

Tenemos tres elementos a seleccionar:

1. Variables: los parámetros que variaremos para así conseguir un óptimo.

2. Restricciones: los parámetros que no queremos que varíen o que sólo varíen 
dentro de un rango determinado.

3. Objetivos: los parámetros que queremos optimizar.
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• Variables.
Vamos a realizar una optimización de la biga 
variando los dos parámetros de la sección.

Añadimos un parámetro al que le llamamos 
Ancho y seleccionamos la longitud de 20 mm.

Finalmente escogemos un valor mínimo, uno 
máximo y el intervalo de la optimización. Esto 
determina el número de estudios a realizar. 
Ponemos un Step de 5mm.
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• Variables.
Hacemos lo mismo para la longitud de 10, le ponemos de nombre Largo. 

Observamos que ahora en total tenemos 15 escenarios, como se puede intuir a 
mayor número de escenarios mayor tiempo de cálculo.
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• Restricciones.
Añadimos una restricción, en este caso es la tensión de von misses (VON) que 
queremos que esté comprendido entre 190 y 205 MPa.
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• Objetivo.
Finalmente pondremos que nuestro 
objetivo es minimizar la masa de la biga.

Clicamos en Run para que ejecute la 
optimización.
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• Resultados.
Nos ha encontrado un óptimo y pero el modelo tiene las dimensiones de el último 
estudio. Las deberíamos de modificar manualmente.

Podemos generar un informe sobre la optimización si lo deseamos.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S10t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 22

• Ejemplo optimización biela.
Como ejemplo se puede intentar optimizar una biela. Vamos al estudio estático y 
lanzamos el cálculo. 
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• Restricciones.
Una restricción avanzada en la cara cilíndrica con restricción en movimiento radial.
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• Restricciones.
Una restricción avanzada con geometría de referencia utilizando el Axis1 que ya 
está creado. La rotación y el movimiento axial lo restringimos a 0.
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• Cargas.
La carga es de 2500 N que viene de un cojinete, utilizamos el Coordinate System 
que ya esta creado. Definimos el material (AISI 304), mallamos y lanzamos el 
cálculo.
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• Optimización.
Vamos a realizar una optimización como antes. Las variables en este caso son las 
longitudes de extrusión: La de la parte central y la de los extremos. 

Como antes la restricción será la VON (menor de 100 MPa) e intentaremos 
minimizar la masa.
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• Resultados.
SW ha encontrado un óptimo para nuestras condiciones con una extrusión central 
de 4 mm y una de los extremos de 10 mm.
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• Proyecto.
Continuar con el proyecto con bola y cálculo varilla. 
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• Resumen de puntuación alcanzada.
0.10 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.35 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
0.40 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S).
0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.00 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
3.55 de 13.00 Total
2.7 horas de dedicaciónUniv
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ity
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• Resumen.
 Pieza chapa doblada y optimización. 
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S11t.- Rigidez estática con Catia y SW.
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• Repaso última sesión.
 Construcción de moldes y matrices.

 Detección de zonas con problemas de desmoldeo.
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• Análisis inicial básico de estructuras con Catia. 
Como complemento al diseño y fabricación que hemos visto hasta ahora vamos a 
ver que Catia nos permite hacer un primer acercamiento al comportamiento 
estructural. En esta sesión veremos el análisis estático de nuestras piezas ante 
cargas aplicadas.

Para empezar seguiremos los pasos del tutorial “Generative Structural Analysis”.

La manera clásica de trabajar es a partir del CAD de Catia exportar la geometría 
para que un programa genere la malla y otro genere el cálculo. Luego las mejoras 
que requiera el cálculo se han de introducir en 
el CAD en otro proceso de pasar información 
de CAE a CAD.
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• Modelos de referencia para comprobar nuestro 
procedimiento. 
Para comprobar que hacemos bien un cálculo podemos comparar nuestros 
resultados con ejercicios de referencia. El tutorial de Catia dispone de una sección 
para comprobar los cálculos de cada tipo. Por ejemplo el primer caso que se 
encuentra es el de barras (1D) y luego sigue con otros ejemplos de cargas 
aplicadas.
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• Casos de carga aceptados por esta versión de Catia. 
Como podemos comprobar en el manual los
casos de carga están limitados a los de la
figura adjunta. Además en el manual ya deja 
claro que tan sólo resuelve cálculos bajo las 
siguientes hipótesis:
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• Abrir fichero ejemplo. 
Vamos a usar como ejemplo el fichero “Horquilla” 
copiándolo en nuestra carpeta de trabajo. Una vez 
tenemos nuestra geometría con su material (en este 
caso aluminio) iniciamos la parte de análisis.
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• Fichero CATAnalysis. 
Cerrar el fichero con el CAD (CATPart) y desde “Save Management” guardar el 
análisis con el nombre que queramos. Vemos en el árbol del análisis que se han 
creado cuatro partes:
- Nodos y elementos para discretizar el CAD en elementos finitos.
- Propiedades relacionados con las piezas.
- Materiales para añadir las variables de material necesarias para el cálculo.
- Caso de carga estático pues hemos elegido este tipo de análisis con condiciones 
de contorno, cargas, resultados y sensores de resultados. 
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ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S11t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 8

• Condiciones de contorno “boundary conditions”. 
Una de las tareas más difíciles a la hora de definir cómo calcular una pieza es 
saber como se fija la pieza y cómo se aplican las cargas. Para simplificar el 
problema podemos simular tan sólo una parte de nuestro conjunto suponiendo que 
hay unos puntos fijos. Por ejemplo para simular el comportamiento de una puerta 
suponemos que nos se mueven los puntos de unión de las bisagras a la 
carrocería.

Comenzamos por definir condiciones de contorno de 
superficies que sólo pueden deslizar 
(similar a contacto). 
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• Crear carga distribuida. 
Una vez sabemos que nuestra pieza está sujeta pasamos a definir las cargas 
aplicadas. Como ejemplo vamos a aplicar una carga distribuida en una superficie. 

En los ejemplos teóricos se suele definir cargas 
puntuales pero en la realidad la carga hay que 
distribuirla sobre una superficie aunque esta 
sea pequeña. En los pliegos de condiciones de
automoción se suele escribir la fuerza a aplicar
y la superficie sobre la que se aplica.
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• Calcular la carga estática. 
Primero comprobamos que el modelo está correcto y es consistente.

Si no hay errores podemos pasar a calcular.
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• Evolución de creación de malla y cálculo. 
Podemos ver la evolución del cálculo. Tras un primer proceso nos da una 
estimación del tiempo de cálculo que será función del número de nodos y 
elementos generados. Finalmente el árbol aparece sin los símbolos de necesidad 
de actualización. 
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• Visualización de desplazamientos y Von Mises. 
Al finalizar el cálculo hay que hacer el postproceso en el que se pretende 
inicialmente saber si lo que hemos calculado es correcto. Lo primero es ver la 
pieza deformada. Si vemos que algún punto que no se debería mover se está 
moviendo tendremos que redefinir las “Boundary conditions”. Una vez nos parece 
correcto podemos pasar a evaluar la magnitud de desplazamientos y tensiones. Si 
los desplazamientos son grandes no sirve el cálculo lineal. Si las tensiones son 
altas no sirve el cálculo lineal.
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• Modos de visualización. 
Podemos jugar con los modos de visualización. Igualmente podemos editar la 
paleta haciendo doble-click sobre ella para cambiar la zona que nos interesa.
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• Resultados en una sección. 
Si en lugar de ver todo el 3D nos interesa ver los resultados en una sección en 
concreto. Podemos ajustar la posición del compás editándolo.
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• Buscar mínimos y máximos. 
Para localizar el valor mínimo y máximo tenemos otra herramienta de análisis. 
Para los presentar podemos crear películas animando las deformaciones.
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• Insertar nuevos casos de carga. 
Podemos ir insertando nuevos análisis. Para organizarse 
deberíamos poner nombre a cada análisis (-50N en Z cara 
interior por ejemplo). 

Podemos ver el método de análisis usado para resolver los 
elementos finitos haciendo doble-click en “Static Case Solution”

enormes sin contactos
grandes

pequeños
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• Añadir masas. 
Al haber activado las masas al crear el análisis vemos que podemos añadir masas 
en zonas, cosa que antes no era posible. Esta opción será muy importante para el 
tema de vibraciones y para los casos de carga gravitatoria. 
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• Exportar geometría para 
otros programas . 
Una vez hemos hecho una primera 
aproximación de nuestra geometría con 
Catia podemos exportarla para que otros 
programas comprueben de una manera 
más ajustada los pliegos de condiciones. 
Para exportar podemos ajustar parámetros 
desde “Tools” -> “Options”. 
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• Tracción. 
Como ejemplo sencillo y fácil de hacer analíticamente vamos a hacer la tracción de 
un barra rectangular de base “b”, altura “h” y longitud “l”. La barra la estiraremos 
con una fuerza “F”.

En principio si dejamos que la pieza “adelgace” tan sólo esperamos 
tensiones en la dirección de aplicación de la fuerza, digamos “z”.

Comprobaremos si z=Fz/bh

Comprobaremos si el desplazamiento es L’-L=L z=LFz/bhE.

Comprobaremos si el adelgazamiento es b’-b=b x=-LFz/bhE.

Comprobaremos si la energía es En=LFz
2/bhE2

Fz

h’

L’L

h

b’
b






















































z

y

x

z

y

x

E












1
1

1
1
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• Creación de barra y aplicación de material. 
Primero creamos la geometría de la barra y le aplicamos las propiedades de 
material y anotamos b, h, L, E y  que necesitamos para nuestras comprobaciones.

Al aplicar el material podemos editar las propiedades si accedemos a la parte de 
análisis. 
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• Análisis resultados. 
Los resultados de estas figuras son para dimensiones de 
la tabla siguiente:

Lo primero que hacemos es cambiar la escala de la 
deformación para que los errores no se vean tan 
exagerados.

b mm 50
h mm 100
L mm 20
E N/mm^2 200000
  0.26
Fz N 50000

z=F z /bh N/mm^2 10
L’-L=LF z /bhE . mm 0.001
b’-b =- bF z /bhE . mm -0.00065
En=LF z

2/bhE2 Nmm 25
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• Comprobación tensiones. 
Como podemos comprobar hay zonas (esquinas) en que el cálculo ha dado 
valores de tensiones 5 veces por encima del valor esperado. Podemos cambiar los 
valores de nuestra paleta para suavizar los resultados respecto al valor esperado. 

A pesar de ello vemos que las tensiones no son las esperadas. 
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• Comprobación deformaciones. 
Si miramos las deformaciones tampoco cuadran ya que esperamos tener un 
desplazamiento constante de 0,001 mm en dirección “z”. 

Tampoco se cumple el adelgazamiento en que esperábamos un desplazamiento 
de 0,00065mm.

Para ver la deformación en la esquina podemos añadir un sensor local.
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• Comprobación de energía. 
Tampoco cumple la energía pues esperamos 25 Nmm = 0,025 J.

En este número es donde el error ha sido el mínimo (sobre un 8%). 
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• Solucionar problema de distribución de cargas. 
Ya que Catia no ha sabido distribuir la carga en la cara lo mejor es aplicar 
directamente una presión y comprobar que todo cuadra. 

z

b-b’
L-L’ En 
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• Comprobación con sensores. 
Creamos un sensor para el desplazamiento de la esquina.

Exportamos valores a fichero de texto y lo editamos.
Values axis Global
x(mm) y(mm) z(mm) C1(mm) C2(mm) C3(mm)
-25 -50 20 6,65e-007  1,33e-006  1e-006 Univ
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• Comprobación de fuerzas de reacción. 
Repetimos el proceso de crear sensores pero para fuerzas de reacción. No 
podemos exportar los resultados desde este menú a fichero de texto pero si 
editarlos en pantalla.




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• Generar un informe del cálculo. 
Catia nos da la posibilidad de generar un informe del cálculo. 
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• Cálculos de superficies (shell). 
Es habitual simplificar los cálculos usando elementos de espesor constante tipo 
lámina para chapas delgadas. 

Creamos un ejemplo de una superficie y empezamos el análisis aplicando material, 
propiedades 2D y malla 2D. Al aplicar las propiedades 2D definimos el espesor de 
pieza.
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• Comprobación resultados. 
Repetimos las comprobaciones como en el caso de 
sólidos con las dimensiones de nuestra lámina (al 
espesor se le ha cambiado el nombre de “h” a “t” de 
thickness). 

b mm 50
t mm 1
L mm 100
E N/mm 2̂ 200000
  0.26
Fz N 50000

z=F z /bt N/mm 2̂ 1000
L’-L=LF z /btE . mm 0.5
b’-b =- bF z /btE . mm -0.065
En=LF z

2/btE2 Nmm 12500








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• Cálculo de curvas. 
Para simplificar mucho más el problema algunas estructuras se suelen dar como 
curvas a las que se les da una sección. Una vez definido el material definimos 
malla de barras (beam), propiedades 1D, boundary conditions, loads …
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• Comprobación de cálculos. 
Repetimos el mismo proceso para ver que 
controlamos el proceso. Para estos modelos Catia no 
nos da la tensión de Von Mises y tenemos que mirar 
las tensiones principales.

b mm 20

t mm 10
L mm 100

E N/mm2 200000

  0.26
Fz N 50000
z=F z /bt N/mm2 250
L’-L=LF z /btE. mm 0.125
b’-b=- bF z /btE. mm -0.0065
En=LF z

2 /btE2 Nmm 3125







?
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• Remallado para mejorar resultados. 
Una vez que dominamos el programa podemos empezar a discutir sobre la malla. 
Como ejemplo usaremos una placa con una agujero. Sabemos que la tensión en 
los cantos del agujero ha de ser tres veces la aplicada y nos centraremos en esa 
comprobación. El primer cálculo con una malla gruesa nos da un resultado de tan 
sólo 1,19 veces. Por supuesto podemos hacer toda la malla pequeña pero eso es 
una pérdida de tiempo de cálculo ya que hay zonas que no necesitan elementos 
tan pequeños.
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• Redefinir la zona. 
Para poder mallar una zona hay que crear alguna geometría de apoyo en la pieza 
para no remallar toda la pieza.
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• Ejercicios de examen de cursos anteriores.
El fichero EXF-Ej10.CATAnalysis no se calcula y puede ser que haya una pieza sin soldar. 
Detectar la pieza suelta, unirla como el resto y calcular sin modificar nada más:

FININICIO

Anotar aquí el desplazamiento máximo:

...... mmTiempo  ..min.Univ
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• Ejercicios de examen de cursos anteriores.
El fichero EXF-Ej10.CATAnalysis tiene un cálculo de frecuencia empotrado. Hacer una 
tracción de 100 MPa permitiendo que se encoja la sección:

FININICIO

Anotar aquí el desplazamiento máximo:
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• Ejercicios recipiente a presión.
Si hacemos un recipiente a presión consideramos...

El enunciado está en la parte de SolidWorks

input
output
P [MPa] 1 1
h [mm] 400 529.11
r [mm] 200 200
t [mm] 1 1
V [m3] 0.08378 0.10000
sx [MPa] 200 200
sz [MPa] 100 100
smises [MPa] 172.3 172.3
d [kg/m3 8000 8000
A [m2] 1.0 1.2
M [kg] 8.0 9.3
M/V [kg/m3 96.0 93.4
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• Resumen.
 Introducción al módulo de cálculo lineal de Catia para Sólidos, Shells y Beams.

 Comprobación de cálculos a tracción.

 Remallado de zonas de interés.
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• SimulationXpress
SimluationXpress es el 
módulo básico que viene 
con SW para realizar 
cáclulos. Hay tutoriales 
SW.
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• Herramientas de simulación. 

Para poder hacer cálculos completos hay que activar el complemento Simulation 
de SW.
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• SolidWorks Simulation
La herramienta Simulation también tiene su 
paquete de tutoriales. 
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• Estudios 
Se pueden realizar distintos estudios:

1. Estudios lineales estáticos.

2. Estudios frecuenciales.

3. Estudios de pandeo.

4. Estudios térmicos.

5. Estudios de caída.

6. Estudios de fatiga:

7. Estudios no lineales.

8. Estudios dinámicos.

9. Estudios de recipientes a presión.
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• Estudios lineales estáticos
Estudio de la tracción de un biga rectangular de base “b”, altura “h” y longitud “l”. 
La barra la estiraremos con una fuerza “F”.

En principio si dejamos que la pieza “adelgace” tan sólo esperamos 
tensiones en la dirección de aplicación de la fuerza, digamos “z”.

Comprobaremos si z=Fz/bh

Comprobaremos si el desplazamiento es L’-L=L z=LFz/bhE.

Comprobaremos si el adelgazamiento es b’-b=b x=-LFz/bhE.

Comprobaremos si la energía es En=LFz
2/bhE2
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• Creación de barra y aplicación de material. 
Anotamos b, h, L, E y  que necesitamos para nuestras comprobaciones y 
calculamos los parámetros σz, L’-L, b’-b y En.

Creamos la geometría de la barra y le aplicamos de material acero AISI 1020.

b mm 50
h mm 20
L mm 100
E N/mm^2 200000
ν ‐ 0,29
Fz N 50000

σz N/mm^2 50
L'‐L mm 0,0250
b'‐b mm 0,0036
En Nmm 625,00
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• Cálculo. 
Barra de herramientas Simulation -> Study...
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• Restricciones
Clicamos con el botón secundario en Fixtures y seleccionamos Roller/Slider. 
Seleccionamos ésta ya que si pusiéramos Fixed Geometry la biga no se contraería 
debido a la fuerza.
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• Cargas
Clicamos con el botón secundario en External Loads y seleccionamos Force… 
Ponemos una fuerza de 50000N a tracción.
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• Mallado
Para crear la malla clicamos encima de Mesh y seleccionamos Create Mesh… al 
tener un modelo tan simple podemos utilizar una malla con elementos grandes y 
así ahorramos tiempo de cálculo.

En Mesh Parameters  ponemos 
a 20 mm la dimensión del 
elemento y podemor ver que el 
Element grouth Ratio se pone a 
1 mm.

Éste último parámetro 
establece la relación entre el 
tamaño del elemento en una 
capa con el tamaño del 
elemento en la capa anterior.
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• Mallado y cálculo
Apretamos con el botón secundario Mesh y selecionamos Mesh and Run. El 
programa malla la biga y realiza los cálculos de estática.
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• Análisis resultados. 
Podemos ver en el árbol del Feature Manager del estudio que tenemos tres 
estudios:

• Strees (Von Mises)

• Displacement

• Strain
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• Stress (Von Mises). 
Tenemos distintas opciones:

• En Edit Definition… podemos modificar los parámetros 
del estudio.

• En Animate… podemos crear un video de la deformación 
de la viga.

• En Section Clipping… podemos ver los resultados en la 
sección que deseamos.

• En Iso Clipping… podemos ver los elementos que están 
por encima o por debajo de un valor de tensión.

• En Chart Options… podemos modificar la rotulación de 
los resultados.

• En Settings… podemos modificar qué i como queremos 
ver los resultados.Univ
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• Tensiones. 
Como se puede ver la tensión es 
constante en toda la biga, estos 
resultados eran los de esperar ya 
que con las restricciones de 
movimiento impuestas no podía dar 
otra cosa.

Podemos ver que el valor es de 50 
MPa, los mismos que habíamos 
calculado.
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• Deformaciones. 
La deformación L’-L, en el eje z es de 2.632e-2 mm igual que la calculada. Lo 
mismo pasa en la diercción x, el estrechamiento b’-b, que es de 3.62e-3 mm.
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• Energía. 
SW no calcula la Strain Energy por lo que la calcularemos nosotros con los datos 
obtenidos.

Ésta energía es liberada cuando los átomos de la pieza se reorganizan al variar la 
forma de ésta.

dz 2,50E‐02 mm
F 5,00E+04 N
En 6,25E+02 Nmm
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• Sensores. 
Los sensores es una herramienta muy útil si nos interesa conocer el valor de 
fuerza, tensión, elongación, etc. En un lugar concreto.

Vamos a ver distintas maneras de crear sensores.

Con un cálculo activado seleccionamos la herramienta Probe.
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• Sensores. 
Seleccionamos la opción On selected entities y seleccionamos cualquier parte de 
la pieza, una arista, una cara, etc. Apretamos en Update y aparece un listado de 
los nodo que hay en esta entidad, sus coordenadas y el valor de la propiedad. 
También aparece una tabla con la suma, la media, el máximo, el mínimo y el error 
residual medio.
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• Sensores. 
Si nos interesa el valor en un punto concreto podemos crear 
una geometría de referencia como sensor.

Apretamos la opción Add Sensor… en la carpeta Sensors y 
seleccionamos el punto creado.
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• Sensores. 
Vamos al análisis de desplazamiento lo visualizamos y seleccionamos la opción 
Probe. Seleccionamos que lea los resultados de los sensores y seleccionamos 
los sensores que hemos creado.

Los resultados de los 
sensores se pueden 
guardar en una hoja 

Excel para su 
posterior 

procesamiento.
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• Fuerzas de reacción. 
Para calcular las fuerzas de reacción clicamos con el botón secundario en la 
carpeta Restults y seleccionamos List Result Force… seleccionamos la cara 
dónde està fija la biga y apretamos Update.
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• Generar un informe del cálculo. 
SW tiene la posibilidad de crear un informe de 
cálculo.

Escojemos lo que quermos que aparezca en él 
y lo podemos publicar en HTML o Word.
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• Cálculos de superficies.
Es habitual simplificar los cálculos usando elementos de espesor constante tipo 
lámina para chapas delgadas.

Creamos una superficie de 50 mm de ancho y una longitud de 100 mm. 
Calculamos los resultados teóricos.

b mm 50
t mm 1
L mm 100
E N/mm^2 200000
ν ‐ 0,29
Fz N 50000

σz N/mm^2 1000
L'‐L mm 0,50
b'‐b mm 0,0725
En Nmm 12500,00
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• Grosor.
Antes de poder realizar ningún cálculo debemos definir el grosor de la superficie, 
en este caso 1mm.
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• Restricciones.
Las restricciones para superfícies son distintas. Se debe utilizar Advanced 
Fixtures…
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• Restricciones.
Realizamos otra Advanced geometry y una Roller/Slider para la que queda.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S11t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 66

• Mallado.
Creamos un mallado con 
elementos de 10mm.
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• Cargas.
Colocamos una fuerza de 50000N 
en la arista superior a tracción.
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• Tensiones.
En el análisis de tensiones vemos que 
no tenemos, como en el caso de la biga 
una distribución uniforme de la tensión 
pero vemos que el valor que está mas 
presente sería el que representa el 
valor de 1000MPa.

Una solución es realizar un mallado 
mas fino pero siempre tendremos 
problemas en las esquinas.

Esto nos indica que hay que ser críticos 
con los resultados.
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• Tensiones.
Realizamos otra vez el cálculo pero 
ésta vez con un mallado con elementos 
de 5mm.

Vemos que tenemos el mismo 
problema.
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• Deformaciones.
Vemos que los resultados para la deformaciones si que se pueden considerar 
correctos.
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• Energía. 
Para calcular la energía de deformación utilizamos la misma formula que antes.

dz 0,504 mm
F 50000 N
En 12600 Nmm
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• Modificaciones. 
Dependiendo de la geometría de la pieza o 
del interés que haya en los resultados en 
una zona concreta se puede modificar el 
mallado.

Creamos otra superficie igual pero le 
hacemos un agujero central en la superficie 
y volvemos a realizar el cálculo.

Sabemos que la tensión en los cantos del 
agujero ha de ser tres veces la aplicada, 
por tanto podemos comprobar los 
resultados.
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• Remallado para mejorar resultados. 
El primer cálculo con una malla gruesa nos da un resultado de tan sólo 2.8 veces. 
Por supuesto podemos hacer toda la malla pequeña pero eso es una pérdida de 
tiempo de cálculo ya que hay zonas que no necesitan elementos tan pequeños.
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• Redefinir la zona. 
Para poder mallar en concreto 
utilizamos la herramienta Apply 
Mesh Control…

Seleccionamos la zona que 
queremos remallar, en este caso el 
corte circular y ponemos elementos 
mas pequeños en esa zona.
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• Redefinir la zona. 
Remallamos y volvemos a lanzar el cálculo. Vemos que en la zona dónde hemos 
refinado la malla los elementos son mas pequeños pero en las zonas que no 
siguen igual. El programa se encarga de realizar la transición de elementos 
pequeños a grandes.
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• Redefinir la zona. 
Ahora vemos que los resultados son los esperados.
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• Biga en voladizo. 
Como ejemplo al tema de vibraciones empezaremos por simular una barra en 
voladizo.

Sabemos que la deformación en la punta
ha de ser:

Sabemos que la tensión máxima en los empotramientos ha de ser:

2maxmax
62

bh
FL

I

h

M 

3

33 4
3 Ebh

FL
EI

FLzL 

b 10 mm
h 20 mm
L 100 mm
E 200000 N/mm^2
v 0,29 ‐
Fz 500 N

σz 75 N/mm^2
Zl 0,125 mm
En 31,25 Nmm
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• Biga en voladizo. 
Creamos la biga y realizamos el cálculo estático para validar el modelo. Utilizamos 
el mismo material el AISI 1020 y un mallado con elementos de 5mm.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S11t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 79

• Biga en voladizo. 
Comprobamos los resultados y vemos que son correctos.
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• Ensamblajes
Se pueden realizar los mismos estudios en ensamblajes de la misma manera. 
Abrimos el ensamblaje "basketball_hoop_classe.sldasm".
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• Materiales
Primero vamos a asignar un material a cada parte. Para las dos partes vamos a 
asignarles una aleación de Alloy Steel (SS).
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• Connections
Las conexiones nos permiten realizar uniones entre 
distintas piezas de un ensamblaje utilizando la base de 
datos del SW sin tener que insertar una pieza nueva. 
Insertamos cuatro tornillos con una precarga axial de 100 
Nm.
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• Connections
Debemos definir un Contact Set… para indicar el contacto entre las dos piezas. 
Le indicamos que nos encuentre las conexiones automáticamente.
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• Fixtures
Ahora debemos restringir el movimiento de la canasta por lo que empotramos la 
canasta como si estuviera sujeta en el tablero.
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• External Loads
Colocamos un carga como si una persona de 80 kg. se colgara del aro. Por lo 
que colocamos su peso como carga.
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• Malla
Realizamos la malla que nos indica por defecto y realizamos el cálculo. El cálculo 
puede tardar unos minutos.
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• Resultados
El resultado mas interesante sería ver que factor de seguridad hay.

En el primer paso podemos seleccionar 
una pieza en concreto o todas, 
seguidamente seleccionamos Automatic 
ya que selecciona automáticamente el 
criterio de fallo mas adecuado.
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• Resultados
Podemos ver que el diseño de esta canasta no es el correcto ya que el factor de 
seguridad es muy bajo. Se debería o cambiar el material o mejorar al diseño.
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• DISEÑAR UN DEPÓSITO. 
Se ha de diseñar un depósito de capacidad 100 litros en AISI304 que soporte una presión 
interna de 1[MPa].

La tensión máxima admisible de VonMises no puede superar los 200[MPa]

El depósito no puede superar las dimensiones  Xmax=500[mm], Ymax=500[mm] 
(R<250[mm]) y Zmax=1000[mm]

Se considerará mejor solución la que menos pese justificando los resultados con una 
simulación de elementos finitos.
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• DIMENSIONAR EL DEPÓSITO. 
Si elegimos un modelo cilíndrico con caras semiesféricas a soportar una presión P con un 
radio R, altura H y espesor T tenemos para R>>T:

x=P2R(H)/(2T(H))=PR/T

y=P y por tanto <<x.

z=PR2/(2RT)=PR/(2T)

mises≈PR/T√(6/8)=0.866PR/T < max=200[MPa] 
no juega H

T>0.866PR/max.

El volumen de líquido se calcula:

V=R2H+4R3/3=R2 (H+4R/3)=100[litros]=1e8[mm3].

H=(V-4R3/3)/(R2);       H+2R+2T<Zmax

El peso o masa del depósito se estima:

M=T(2RH+4R2)=T2R(H+2R)

M=0.866PR/max)2R((V-4R3/3)/(R2)+2R), no tiene 
mínimo

CILINDRO
T R M H H+2R+2T
0.004 1.00 6.93 31830987.29 31830989.29
0.013 3.00 6.93 3536772.51 3536778.54
0.043 10.00 6.93 318296.55 318316.64
0.217 50.00 6.95 12665.73 12766.16
0.433 100.00 7.07 3049.77 3250.63
0.779 180.00 7.77 742.44 1104.00
0.823 190.00 7.92 628.41 1010.06
0.827 191.00 7.94 617.87 1001.52
0.829 191.50 7.95 612.65 997.31
0.831 192.00 7.95 607.47 993.13
0.866 200.00 8.09 529.11 930.84
1.212 280.00 10.11 32.67 595.10
1.256 290.00 10.47 ‐8.18 574.33
1.299 300.00 10.85 ‐46.32 556.28
1.732 400.00 16.21 ‐334.39 469.07
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• COMPROBACIONES GEOMÉTRICAS. 
Si ponemos las variables en el modelo comprobamos volumen de agua y peso de depósito
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• COMPROBACIONES TENSIONES. 
Si realizamos el cálculo de un cuarto de depósito veremos más fácil las tensiones.

sx 230.946882
sz 115.473441
smises 200

Membrana
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• COMPROBACIONES TENSIONES. 
Si además de la membrana y miramos capa exterior e interior y flexión vemos el problema de 
radios tangentes para elementos finitos.
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• EJEMPLO ESFERA. 
Si queremos hacer el modelo con una esfera podemos comparar pesos pero que no nos 
cabe dentro de nuestros requerimientos de espacio.

CILINDRO ESFERA
T R M H H+2R+2T R T M
0.004 1.00 6.93 31830987.29 31830989.29 287.94 0.720 6.00
0.013 3.00 6.93 3536772.51 3536778.54
0.043 10.00 6.93 318296.55 318316.64
0.217 50.00 6.95 12665.73 12766.16
0.433 100.00 7.07 3049.77 3250.63
0.779 180.00 7.77 742.44 1104.00
0.823 190.00 7.92 628.41 1010.06
0.827 191.00 7.94 617.87 1001.52
0.829 191.50 7.95 612.65 997.31
0.831 192.00 7.95 607.47 993.13
0.866 200.00 8.09 529.11 930.84
1.212 280.00 10.11 32.67 595.10
1.256 290.00 10.47 ‐8.18 574.33
1.299 300.00 10.85 ‐46.32 556.28
1.732 400.00 16.21 ‐334.39 469.07
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• Resumen.
 Introducción al módulo de cálculo lineal de SW para Sólidos y superficies.

 Comprobación de cálculos a tracción.

 Remallado de zonas de interés.
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• Proyecto.
Se realiza el fuelle, se exporta a stp, y se hace impacto medioambiental. 
Comparamos el impacto entre producir en Europa con Asia.
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• Resumen de puntuación alcanzada.
0.10 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.35 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
1.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.30 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
0.00 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S).
0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.00 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
4.15 de 13.00 Total
3.0 horas de dedicaciónUniv

ers
ity

 C
op

y F
or 

Lib
rar

y U
se



S12t.- Vibraciones con Catia y SW.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S12t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 2

• Repaso última sesión.
 Construcción de moldes y matrices.

 Detección de zonas con problemas de desmoldeo.
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• Introducción al tema de vibraciones. 
Para hacer simulaciones de vibraciones se ha de tener en cuenta la masa de la 
estructura que está vibrando.

Un soporte masa-muelle es fácil de estudiar:

De esta fórmula vemos que si queremos tener frecuencias de vibración muy altas 
tenemos que subir la rigidez del conjunto o disminuir la masa. Por lo tanto en el 
tema de vibraciones hay que optimizar la rigidez y el peso para evitar que las 
frecuencias propias de la estructura estén en un rango de frecuencias externas. 
Por ejemplo en automoción se pretende subir la 

m

x

k)cos(02

2

t
m
kAxkx

t
xm 



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• Primera frecuencia torsión en carrocerías de automóviles. 
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• Ejemplo de barra en voladizo. 
Como ejemplo al tema de vibraciones empezaremos por simular una barra en 
voladizo.

Sabemos que la deformación en la punta
ha de ser:

Sabemos que la tensión máxima en los empotramientos ha de ser:

Para evitar confusiones a la altura “h” le llamaremos espesor “t” pues se usa 
siempre esta nomenclatura en superficies.

L

F
h

b

2maxmax
62

bh
FL

I

h

M 

3

33 4
3 Ebh

FL
EI

FLzL 
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• Prontuario para verificaciones. 
Se recomienda para cualquier software
tener un prontuario de soluciones 
conocidas.
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• Comprobación voladizo. 
Si usamos el fichero de la sesión anterior podemos 
comprobar los siguientes valores antes de estudiar
vibraciones. Para ver bien tensiones usaremos una 
barra hecha con sólidos. Ahora la distribución de 
fuerzas no nos preocupa tanto pues miramos las 
tensiones en la otra punta donde necesitamos 
malla más fina.

b mm 10

t mm 20
L mm 100

E N/mm2 200000

  0,26
Fz N 500
z=6F zL/bt 2 N/mm2 75
z L =4L 3 F z /bt 3 E. mm 0,125
En=4L 3 F z

2 /2bt 3 E. Nmm 31,25

FLEXION





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• Inicio análisis vibraciones. 
Una vez confiamos que nuestro modelo es estable y rígido como prevemos 
pasamos a hacer el análisis de vibraciones. Primero lo vamos a hacer en un 
fichero a parte como una análisis de pieza sin condiciones de contorno.
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• Modos de vibración libre. 
Haciendo doble-click en la deformación podemos ir cambiando de modos. Los seis 
primeros son las 3 traslaciones y tres rotaciones que al estar el cuerpo libre 
deberían ser a frecuencia 0 (rigidez cero).

Modo 7.- Flexión por b Modo 10.- Flexión 2ª por bModo 8.- Flexión por t Modo 9.- Torsión por L
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• Modos de vibración en voladizo. 
Al insertar un nuevo caso de carga podemos decir que queremos hacer un análisis 
de vibraciones considerando las fijaciones. De esta manera las frecuencias a 0 Hz 
desaparecerán. Además el primer modo baja su frecuencia.

Voladizo

Libre
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• Análisis resultados. 
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• Comprobación resultados. 
En la literatura (“Applied Structural and Mechanical Vibrations”, Gatti, Paolo; 
Ferrari, Vittorio; E&FN Spon, (1999)) encontramos la solución a las vibraciones de 
una barra libre, apoyada, en voladizo. Escribimos aquí las soluciones para una 
barra en voladizo con un lado empotrado. 

Frecuencias:

Respuesta temporal:
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• Comprobación resultados. 
En http://www.abdn.ac.uk/physics/px3506/3506(02)cantilever.doc vemos una explicación 
de los modos de vibración a flexión que son los más complejos.
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• Modificación de frecuencias por densidad o módulo. 
Si un sistema muelle con masa era fácil de resolver analíticamente la vibración de 
una barra en voladizo es más complicada. A pesar de ello existen muchos estudios 
para longitudes, anchos, altos, densidades y módulos de Young. Lo primero que 
podemos hacer es ver como cambiamos las frecuencias al multiplicar el módulo x4 
o la densidad x 4.

Voladizo acero

m x4 f x0,5

f ~ √(k/m)

E x4 f x2
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• Modificación de frecuencias por cambio de geometría. 
Al cambiar la geometría, por ejemplo duplicando espesor (t x2), estamos 
cambiando la masa (m x2) y también la inercia (I x8) para flexión y el área (A x2) 
para tracción. Por lo tanto no todos los modos propios se van a cambiar en la 
misma escala.

Hay que ir con cuidado ya 
que pueden aparecer nuevos
modos que no existían en la 
geometría original.
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• Conclusiones a cambio dimensiones. 
Tras mirar las diferentes maneras de cambiar las frecuencias propias de nuestra 
estructura podemos ordenar todas las frecuencias en una tabla y ver lo que hemos 
conseguido con cada cambio respecto al modelo original. Además tenemos que 
tabular otros parámetros como el peso que también nos da Catia. En este ejemplo 
hemos visto que lo más efectivo es cambiar de material. Sin embargo es bastante 
difícil subir el módulo de Young sin subir la densidad que causa el efecto contrario. 
En este ejemplo lo mejor era subir la dimensión más débil, en este caso “b”.

E,d,L,b,t

Mode Frequency Frequency Factor Frequency Factor Frequency Factor Frequency Factor Frequency Factor
number Hz Hz Hz Hz Hz Hz

1-Fl.b 8,16E+02 1,63E+03 2,0 4,08E+02 0,5 8,22E+02 1,0 1,59E+03 2,0 2,04E+02 0,3
2-Fl.t 1,59E+03 3,18E+03 2,0 7,96E+02 0,5 2,95E+03 1,9 1,60E+03 1,0 4,06E+02 0,3
3-Fl.2b 4,90E+03 9,80E+03 2,0 2,45E+03 0,5 4,93E+03 1,0 8,62E+03 1,8 1,27E+03 0,3
4-To.L 6,04E+03 1,21E+04 2,0 3,02E+03 0,5 3,86E+03 0,6 7,32E+03 1,2 2,99E+03 0,5
5-Fl.2t 8,61E+03 1,72E+04 2,0 4,31E+03 0,5 1,25E+04 1,5 8,62E+03 1,0 2,43E+03 0,3
6-Tr.L 1,27E+04 2,53E+04 2,0 6,33E+03 0,5 1,25E+04 1,0 1,27E+04 1,0 6,32E+03 0,5
7.-Fl.3b 1,29E+04 2,59E+04 2,0 6,47E+03 0,5 1,30E+04 1,0 2,06E+04 1,6 3,49E+03 0,3

8-To.2L 1,82E+04 3,64E+04 2,0 9,10E+03 0,5 1,20E+04 0,7 2,20E+04 1,2 8,97E+03 0,5
9-Fl.3t 2,06E+04 4,12E+04 2,0 1,03E+04 0,5 0,0 2,06E+04 1,0 6,42E+03 0,3
10-Fl.4b 2,36E+04 4,72E+04 2,0 1,18E+04 0,5 2,37E+04 1,0 3,43E+04 1,5 6,67E+03 0,3
f.min 8,16E+02 1,63E+03 2,0 4,08E+02 0,5 8,22E+02 1,0 1,59E+03 2,0 2,04E+02 0,3
Peso 0,157 0,157 1,0 0,629 4,0 0,314 2,0 0,314 2,0 0,314 2,0

bx2Ex4 dx4 tx2 Lx2
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• Propuesta cambio geometría. 
Desde Catia podemos hacer propuestas que cambien la geometría sin perjudicar 
el peso de una manera tan clara. Por ejemplo podemos hacer una sección más 
grande pero hueca, un costillaje . . .

Pasamos por ejemplo de la sección de 20x10 sólida a una de 20X20 con espesor 
2,5mm para tener una masa de la barra ligeramente inferior a la original. El 
problema de este sólido es que necesitará muchos elementos para poder ser 
mallado y por tanto el tiempo de cálculo se disparará.
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• Mejoras. 
Tras este análisis hemos hecho una propuesta para mejorar la respuesta en 
frecuencia sin empeorar el peso como se observa en la tabla completa. Finalmente 
podemos exportar nuestro CAD a un formato estándar para que un software de 
cálculo valide nuestras conclusiones.

E,d,L,b,t

Mode Frequency Frequency Factor Frequency Factor Frequency Factor Frequency Factor Frequency Factor FrequencyFactor
number Hz Hz Hz Hz Hz Hz Hz

1-Fl.b 8,16E+02 1,63E+03 2,0 4,08E+02 0,5 8,22E+02 1,0 1,59E+03 2,0 2,04E+02 0,3 1,91E+03 2,3
2-Fl.t 1,59E+03 3,18E+03 2,0 7,96E+02 0,5 2,95E+03 1,9 1,60E+03 1,0 4,06E+02 0,3 1,91E+03 1,2
3-Fl.2b 4,90E+03 9,80E+03 2,0 2,45E+03 0,5 4,93E+03 1,0 8,62E+03 1,8 1,27E+03 0,3 8,90E+03 1,8
4-To.L 6,04E+03 1,21E+04 2,0 3,02E+03 0,5 3,86E+03 0,6 7,32E+03 1,2 2,99E+03 0,5 7,07E+03 1,2
5-Fl.2t 8,61E+03 1,72E+04 2,0 4,31E+03 0,5 1,25E+04 1,5 8,62E+03 1,0 2,43E+03 0,3 8,90E+03 1,0
6-Tr.L 1,27E+04 2,53E+04 2,0 6,33E+03 0,5 1,25E+04 1,0 1,27E+04 1,0 6,32E+03 0,5 1,26E+04 1,0
7.-Fl.3b 1,29E+04 2,59E+04 2,0 6,47E+03 0,5 1,30E+04 1,0 2,06E+04 1,6 3,49E+03 0,3 1,89E+04 1,5

8-To.2L 1,82E+04 3,64E+04 2,0 9,10E+03 0,5 1,20E+04 0,7 2,20E+04 1,2 8,97E+03 0,5 0,0
9-Fl.3t 2,06E+04 4,12E+04 2,0 1,03E+04 0,5 0,0 2,06E+04 1,0 6,42E+03 0,3 0,0
10-Fl.4b 2,36E+04 4,72E+04 2,0 1,18E+04 0,5 2,37E+04 1,0 3,43E+04 1,5 6,67E+03 0,3 0,0
f.min 8,16E+02 1,63E+03 2,0 4,08E+02 0,5 8,22E+02 1,0 1,59E+03 2,0 2,04E+02 0,3 1,91E+03 2,3
Peso 0,157 0,157 1,0 0,629 4,0 0,314 2,0 0,314 2,0 0,314 2,0 0,138 0,9

bx2Ex4 bx2 vacio-pared 2,5dx4 tx2 Lx2
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• Comparativa teórica de secciones. 
En la siguiente tabla se comparan secciones huecas de mismo peso a secciones 
sólidas circulares comparando los beneficios a flexión y torsión. 

Todas las columnas excepto d/g,b/g en %.
Ejemplo círculo d/g=4 d=4g
Area=do

2/4=d2/4-(d-2g)2/4)
d/do=√(4/3)=1.15 , r/ro=1.15
Inercia: (r4/4-r-g)4/4) / ro

4/4 = (1-
0.54)*1.154=1.66 
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• Ejercicio clase 1314.
Realizamos una chapa barriendo dos curvas para en 
el futuro hacer el refuerzo. Chapa sola 
EC Peso Primera frecuencia
20mm 31.7kg 161Hz.
10mm 16.0kg 116Hz. (que no es 161/2 new mode) 
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• Resumen.
 Introducción al módulo de vibraciones.

 Comparativa de varias formas de modificar las frecuencias propias de una 
estructura usando Catia.
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• Análisis de vibraciones. 
Una vez verificado nuestro método 
vamos a realizar el estudio de 
vibraciones. Realizamos un nuevo 
estudio pero esta vez escogemos 
Frequency. El primer estudio va a ser de 
frecuencias libres por lo que no ponemos 
ninguna restricción a la biga.
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• Análisis de vibraciones. 
Antes de realizar el cálculo vamos a las propiedades del estudio para así indicar 
que queremos estudiar 10 frecuencias.

Realizamos el cálculo.
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• Análisis de vibraciones. 
En el la carpeta Results del árbol en el Property Manager vemos que nos ha 
realizado diez cálculos. Los tres primeros corresponden a la al las traslaciones en 
un eje (el primero en X, el segundo en Y y el tercero en Z. La biga al no estar 
sujeta no vibra.
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• Análisis de vibraciones. 
Los tres siguientes se puede observar que son las rotaciones en el eje X (estudio 
4), eje Y (estudio 5) y eje Z (estudio 6)
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• Análisis de vibraciones. 
Los siguientes tres estudios son las flexiones: en X (estudio 7), en Y (estudio 8) y 
en Z, que es la torsión (estudio 9).
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• Análisis de vibraciones. 
Por último tenemos el estudio 10 que 
corresponde a la segunda flexión por el 
eje X.

Si no se sabe a que movimiento 
corresponde un estudio, se utiliza la 
herramienta Animate… y se puede 
visualizar.   
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• Modos de vibración. 
Un modo de vibración es un patrón o forma característica en el que vibrará un 
sistema mecánico. Para poder conocer las frecuencias de resonancia (modos) 
utilizamos el List Resonant Frequencies…
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• Modos de vibración. 
Como era de esperar las frecuencias de los seis primeros modos, al estar la biga 
libre, no tienes frecuencia de resonancia, los otros cuatro sí.

Mode No. Frequency(Rad/sec) Frequency(Hertz) Period(Seconds)
1 0 0 1.00E+32
2 0 0 1.00E+32
3 0 0 1.00E+32
4 0.01555 0.00247 404.21
5 0.01697 0.00270 370.37
6 0.03010 0.00479 208.72
7 31345 4988.7 0.00020045
8 57494 9150.5 0.00010928
9 72045 11466 8.72E‐01
10 81632 12992 7.70E‐01
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• Biga en voladizo. 
Vamos a realizar el mismo estudio 
pero con la biga empotrada.
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• Resultados.
1. Flexión en X (estudio 1).

2. Flexión en Y (estudio 2).

3. Segunda flexión por X (estudio 3).
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• Resultados. 
1. Torsión Z (estudio 4)

2. Segunda flexión por Y (estudio 5)

3. Tracción Z (estudio 6)
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• Resultados. 
1. Tercera flexión en X (estudio 7)

2. Segunda torsión en Z (estudio 8)

3. Tercera flexión en Y (estudio 9)
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• Resultados.
Cuarta flexión por X (estudio 9)
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• Modos de vibración. 
Las frecuencias de resonancia son las siguientes.

Mode No. Frequency(Rad/sec) Frequency(Hertz) Period(Seconds)
1 5113.1 813.77 0.0012289
2 9970.2 1586.8 0.0006302
3 30627 4874.4 0.00020515
4 36773 5852.6 0.00017086
5 53790 8561 0.00011681
6 79358 12630 7.92E‐01
7 80607 12829 7.79E‐01
8 1.11E+09 17610 5.68E‐01
9 1.28E+09 20415 4.90E‐01
10 1.46E+09 23296 4.29E‐01
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• Modos de vibración. 
Podemos comparar las frecuencias de resonancia de los dos casos.

Libre Voladizo
Flexión X 4988.7 813.77
Flexión Y 9150.5 1586.8
Torsión 11466 5852.6

2º Flexión X 12992 4874.4
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• Modificación por modulo o densidad. 
Sabemos que la frecuencia es proporcional a la raíz de k/m. Vamos a estudiar 
como afecta variar el modulo de Young y la densidad.

Abrimos un nuevo estudio de vibraciones y aplicamos un nuevo material al estudio 
modificando el modulo de Young por 2 (400000 MPa) y realizamos el cálculo.
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• Resultados. 
Comparamos las frecuencias de los 
modos de vibración.

Podemos ver que al multiplicar por dos el 
modulo elástico las frecuencias 
disminuyen raíz de 2 y al aumentar la 
densidad por dos las frecuencias 
aumentan raíz de 2.

Ex2 Empotrada dx2
575.42 813.77 1150.8
1122 1586.8 2244.1
3446.8 4874.4 6893.5
4138.4 5852.6 8276.8
6053.5 8561 12107
8930.9 12630 17862
9071.5 12829 18143
12452 17610 24905
14436 20415 28872
16473 23296 32945
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• Modificación de frecuencias por geometría.
Vamos a realizar distintos estudios modificando la geometría de la biga. 
Haremos tres estudios mas: cada uno duplicando una de las tres dimensiones y 
dejando las otras como estaban inicialmente. Compararemos las frecuencias, y 
el peso. 

Estudio Empotrada
Modo Freq/Hz Freq/Hz Δ Freq/Hz Δ Freq/Hz Δ Freq/Hz Δ Freq/Hz Δ

Flexión X 813.77 575.42 1.414219179 1150.8 0.707134168 1590.1 0.511772844 820.34 0.991991126 203.74 3.994159223
Flexión Y 1586.8 1122 1.41426025 2244.1 0.707098614 1591 0.997360151 2937.2 0.540242408 404.49 3.922964721
2Flexión X 4874.4 3446.8 1.41418127 6893.5 0.707100892 7144.9 0.682220885 3787 1.287140217 1261.9 3.862746652
Torsión Z 5852.6 4138.4 1.414218055 8276.8 0.707109028 8572 0.682757816 4903.2 1.193628651 2425.9 2.41254792
2Flexión Y 8561 6053.5 1.414223177 12107 0.707111588 8576.2 0.998227653 11712 0.730959699 2892.5 2.959723423
Tracción Z 12630 8930.9 1.414191179 17862 0.707087672 12618 1.000951022 12417 1.017153902 3470.9 3.638825665
3Flexión X 12829 9071.5 1.414209337 18143 0.707104668 20414 0.628441266 12646 1.014470979 6302.8 2.035444564
2Torsión Z 17610 12452 1.414230646 24905 0.70708693 20426 0.862136493 12907 1.36437592 6387.7 2.756860842
3Flexion Y 20415 14436 1.414172901 28872 0.707086451 21388 0.9545072 20637 0.989242622 6637.1 3.075891579
4Flexión Z 23296 16473 1.414192922 32945 0.707117924 33896 0.687278735 23368 0.996918863 8691.8 2.680227341

Fmin 813.77 575.42 ‐ 1150.8 ‐ 1590.1 ‐ 820.34 ‐ 203.74 ‐
Peso 0.158 0.158 1 0.316 0.5 0.316 0.5 0.316 0.5 0.316 0.5

Ex2 dx2 bx2 hx2 Lx2
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• Propuesta cambio geometría.
Vamos a comprobar como variaran los 
resultados si hacemos la misma barra pero 
vacía con un espesor de pared de 2mm. Hay 
que tener en cuenta que el elemento de 
malla debe ser inferior (al menos 2mm) cosa 
que incrementará el tiempo de cálculo.
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• Propuesta cambio geometría.
Si realizamos el cálculo podemos ver que las frecuencias han aumentado un poco 
pero que el peso ha disminuido a casi la mitad.

Estudio Empotrada Vacía Δ
Modo Freq/Hz Freq/Hz Freq/Hz

Flexión X 813.77 997.01 0.816210469
Flexión Y 1586.8 1798.1 0.88248707
2Flexión X 4874.4 5332.2 0.914144256
Torsión Z 5852.6 5916.6 0.989182977
2Flexión Y 8561 9122.7 0.938428316
Tracción Z 12630 12326 1.024663313
3Flexión X 12829 12606 1.017689989
2Torsión Z 17610 14525 1.212392427
3Flexion Y 20415 19327 1.056294303
4Flexión Z 23296 19525 1.193137004

Peso 0.158 0.082 1.926829268Univ
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• Resumen.
 Introducción al módulo de vibraciones.
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• X.
x.
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• Repaso última sesión.
 Introducción a cálculos estáticos.
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CINEMATICA

•Las cinemáticas se 
generan a nivel de 
PRODUCT
• El Workbench 
necesario es DMU 
KINEMATICS
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Definición de mecanismo

Piezas (CatParts)

Joints (relaciones entre piezas)

Commands (control por 
nuestra parte de alguno de los 
Joints)

•Control Directo

•Control por Leyes. 
Posición en función del 
tiempo

Una de las piezas 
es Fija (Part Fix).

Cinema

Outputs de análisis:
- Análisis de interferencias, trazas, envolventes, distancias, velocidades, ....

Outputs de simulación:
- Simulaciones, Replays, Secuencias, películas, ....
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•Los elementos que definen una pieza a mover se 
definen a nivel de Part. Cada Part una pieza.

•Cada join define un nº de grados de libertad entre 
dos piezas (PARTs). DOF

•Mecanismo simulable: DOF=0
•Mecanismo no simulable DOF > 0
•Se disminuye el grado de libertad

•Aplicando Joins
•Aplicando Commands

Conceptos Básicos
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•Nº de grados de libertad al final de la definición 
de   JOINTs > 0

•Se necesitan tantos COMMANDs como DOF al 
final de la definición de JOINTs

•Se define un COMMAND en un JOINT 
•Los motores pueden ser de translación o 
rotación. 
•La translación puede ser a lo largo de una 
curva 3D.

Conceptos Básicos
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• Un JOINT define el movimiento relativo permitido 
entre dos piezas (PARTS)
•Cada JOINT define el grado de libertad entre dos 
piezas
•Entre dos piezas se pueden definir más de un JOINT 
si no restringen el mismo grado de libertad 

Toolbar DMU Kinematics
Joints
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Diferenciamos 4 tipos de Joints:
- Joints que utilizan el WB Assembly Dessing
- Joints que utilizan la geometría exacta

Joints

- Joints compuestos 
- Joints a partir de ejes e coordenadas
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-Joints que utilizan el WB Assembly Dessing
Cuando de definen estos Joint se crean condiciones y las piezas es 
ensamblan automáticamente

- Joints que utilizan la geometría exacta
Deben estar posicionados correctamente antes de definir el joint

-Joints compuestos 
En verdad son dos Joints con una parte común. La ventaja que tienen 
es que añaden un parámetro (Ratio) que nos permite controlarlos más 
cómodamente.

- Joints a partir de ejes e coordenadas.
Se pueden utilizar ejes para posicionar y definir el Joint.
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Joints
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Joints
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Joints
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Revolute

1 DOF = 1 Rotación 
Comand = Angle
Definición: 2 líneas y 2 
planos Normales al eje 
de rotación

Joints
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Prismatic
1 DOF = 1 Translación 
Comand = Length
Definición: 2 líneas y 2 
planos (líneas de  
translación contenidas en 
los planos)

Joints
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Cilindrical

2 DOF = 1 Translación y 
1 Rotación
Comand = Length y/o 
Angle
Definición: 2 líneas

Joints
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Joints

Pitch = Paso de rosca

P.E un Pitch de 2 mm 
significa que  a cada vuelta el 
tornillo sube 2 mm

1 DOF = 1 Translación y 
1 Rotación vinculadas por 
un parámetro (Pitch)
Comand = Length y/o 
Angle
Definición: 2 líneas

Screw
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3 DOF = 2 Translaciones 
y 1 Rotación
Comand = NO
Definición: 2 Planos

PlanarJoints
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3 DOF = 3 Rotaciones
Comand = NO
Definición: 2 Puntos

SphericalJoints
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0 DOF 
Comand = NO
Definición: 2 Piezas

RigidJoints
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U Joint (junta cardan)
2 DOF = 2 Rotaciones
Comand = NO
Definición: 2 líneas “Spin” 
(Opcional 2 líneas de las 
Cross-Pin Axis)Spin

Cross-pin 
axis

Joints
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CV Joint (doble junta cardan)Joints
Caso Especial: El ángulo entre Spins debe ser igual.
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Joint compuesto de dos 
joints revolutes con la misma 
base. Entre ellas hay una 
relación de Ratio.
Por defecto es la relación de 
radios.

GearJoints
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Joint compuesto de un join   
revolute y un joint  prismatic 
con la misma base. Entre 
ellos hay una relación de 
Ratio.

RackJoints

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S13t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 24

Joint compuesto de dos 
joints prismatic con la misma 
base. Entre ellas hay una 
relación de Ratio.

CableJoints
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4 DOF = 3 Rotaciones y 1 
translación
Comand = Leng
Definición: 1 punto y una 
curva 3D

Point CurveJoints
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Point Surface

5 DOF = 3 Rotaciones y 2 
translaciones
Comand = No
Definición: 1 punto y una 
superficie

Joints
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2 DOF = 1 Rotación y1 
translación
Comand = Length
Definición: 2 curvas 
No hay deslizamiento

Roll CurveJoints
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3 DOF = 2 Rotaciones y1 
translación
Comand = NO
Definición: 2 curvas 
Hay deslizamiento

Slide CurveJoints
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Parte Fija (FIX PART)

•Cualquiera de las PARTS puede ser la parte fija.
•Solo hay una FIX PART por mecanismo
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Motores
Los motores se definen directamente 
en los Joints, aunque luego aparecen 
el árbol, en Commands 
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Motores
Simulación con incrementos 
de posición o leyes (posición 
en función del tiempo)

Monocomand

Multicomand

Mediante una formula. Se indica la posición en función del tiempo.
Para simular con leyes todos los motores deben estar en función del tiempo F(t).Univ

ers
ity
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Motores - law
A partir de la R15 se pueden generar leyes 
importándolas de un Sketch. Sin necesidad 
de hacer formulas. Es necesario editar el 
command para acceder al menú.

El eje H del Sketch es la ordenada tiempo y 
el origen del sketch es el cero de la law

También 
se pueden 
importar 
de otra 
cinemática 
existenteUniv

ers
ity
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Outputs
Sensores Al activar los sensores podemos medir 

en cada incremento de posición del 
mecanismo los valores de los parámetros 
seleccionados

Parámetros:
Todos los parámetros internos del 
mecanismo.
Todos los parámetros definidos en 
applications (distancias, velocidades, ...)Univ
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ity
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1- Activar los parámetros que 
quieres observar

2- Simular la cinemática (mejor con 
la opción “On Request”)

3- Outputs “Graphics” o File. (p.e. 
en EXCEL)1

2

3

Outputs
Sensores
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Outputs
Trazas: Posición de un elemento respecto a otro durante el 

movimiento realizado

- Se selecciona la cinemática, 
simulación o Replay deseado

- Seleccionamos el elemento para 
generar la traza.

- Seleccionamos respecto a que 
pieza queremos generar la traza

- Finalmente decidimos donde se 
guardara la traza
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1º Seleccionar la simulation o replay  del cual queremos que nos 
haga la envolvente.

2º Hacer un preview para visualizar el resultado.
3º Guardar el resultado.

Nota: Es importante que antes de 
realizar la envolvente realicemos 
la simulación previa del 
movimiento, 

Outputs
Envolventes
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Toolbar DMU Kinematics

Simulación con motores o leyes
Dressup
Joints
Parte fija
Convertir assembly en joints
Medir velocidades y aceleraciones
Análisis del cinema

Iconos de interés
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Simulación con incrementos 
de posición o leyes (posición 
en función del tiempo)

Dressup: Asociar parts no implicadas a las diferentes parts implicadas 
en el mecanismo

Iconos de interés
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Análisis del mecanismo

Iconos de interés
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Generar Simulation
Generar Replay
Play Replay
Detectar interferencias 
Generar envolventes
Generar trazas

Toolbar DMU Generic Animations

Iconos de interés
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Toolbar Kinematics Update

Toolbar DMU Space Analysis

Uptate
Importar mecanismos de subproductos
Reset mecanismo

Análisis de interferencias
Análisis de band

Iconos de interés
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Conversión cinemáticas Catia V4 a Catia 
V5
Proceso
• Crear Product nuevo y Abrir Model con la 

cinemática desde Catia V5
• Copy del SET cinemático de Catia V4
• Paste en Applications en el Product

Notas:
No convierte límites definidos en 
Catia V4
Hay que redefinir commands y 
joints en algunos casos 
particulares

Model V4
Set Cinemático

Product V5
AplicationsCopy 

Past
e
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Esquema Mecanismo

Culata

Pistón

Biela

Cigüeñal

Prismatic

Revolute

Revolute

Revolute

Fix Part

COMMAND

Ejemplo cinema motor
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Definir Relaciones entre piezas (JOINTS)

Ejemplo cinema motor
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Definir Motores (COMMANDS)

Ejemplo cinema motor
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Definir Parte Fija (FIX PART)

•Cualquiera de las 
PARTS puede ser la 
parte fija.
• Solo hay una FIX 
PART por mecanismo

Ejemplo cinema motor
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Simulando el mecanismo

Ejemplo cinema motor
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Sensores
Ejemplo cinema motor
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Trazas

Ejemplo cinema motor
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Volumen de Barrido (Sweep Volumen)

Ejemplo cinema motor
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• Resumen.
 Introducción a módulo de cinemática de Catia.
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• Cargas dinámicas.
Uno de los problemas al dimensionar una 
pieza es conocer las cargas dinámicas. 
Para ello podemos usar el SW Motion un 
complemento que junto al SW Simluation 
nos servirá para hacer los cálculos. Es 
necesario tener activados los dos 
complementos.
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• Cargas dinámicas.
Uno de los problemas al dimensionar una pieza es conocer las cargas 
dinámicas. Para ello podemos usar CosmosMotion. En un ensamblaje en 
movimiento nos puede dar la magnitud de la s fuerzas dinámicas como en 
el ejemplo de Beer 16_155.

Clicamos sobre la pestaña de Motion Study 1
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• Cargas dinámicas.
Nos fijamos que ahora podemos realizar el Motion Analysis. Con el que 
podremos graficar distintas variables.

Apretamos Calculate y podemos ver el movimiento del ensamblaje.
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• Cargas dinámicas.
Una vez realizado el cálculo podemos graficar distintos resultados.

Vamos a realizar distintos graficos que nos den las magnitudes de las 
fuerzas..
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• Grafico de fuerzas dinámicas.
Vamos a crear dos graficos, los dos nos van a enseñar la evolución de la 
fuerza de reacción en X y en Y.
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• Grafico de fuerzas dinámicas.
Si apretamos el botón de animar, podemos ver en qué momento se dan las 
fuerzas del grafico.
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• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0. (L=100 mm)

Por energías de la barra que cae: 
mgL/2=0.5m(2L/2)2+0.5*m*L2/12*2

2=m*L2*2
2/6

 2=√(3g/L) 

 vA2= 2*L=√(3gL)
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Estudiamos el impacto entre A y C:
vc3+va3=e(vc2+va2)

 vc3 =e(0+√(3gL)) + 3L

• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0. (L=100 mm)
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Estudiamos momentos respecto a B de impulsos en momento de impacto:
mvGab2L/2+mL2/12*2= mvGab3L/2+mL2/12*3 + mvc3L

 m2L2/3= m3L2/3 + mvc3L 

 m√(3g/L)*L2/3 - m*e(0+√(3g/L))L2 = m3L2/3 +m3L2

3=(1-3e)/4*√(3g/L)

vc3=(1+e)/4*√(3gL)

• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0. (L=100 mm)
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• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0.

Las soluciones analíticas son las siguientes.

(a)vC(e=1)=0.866√gL=857.7mm/s

(b) vC(e=0.4)=0.606√gL=600.2mm/s

(c) vC(e=0)=0.433√gL=428.86mm/s

Vamos a comprobar el resultado en SW.

• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0. (L=100 mm)
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• Ejercicio impacto Beer 17_111.
Una barra AB se libera e impacta en CD. Dar la velocidad de CD después 
del impacto si (a) e=1, (b) e=0.4, (c) e=0.
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• Ejercicio impacto Beer 17_111.
Ahora si abrimos el Motion Study 1 lo que tenemos que hacer es crear le 
movimiento de la barra y el contacto.

El movimiento viene dado por la graveada por lo primero que haremos 
serà crearla.

En este estudio la fuerza de la gravedad esta aplicada en la dirección del 
eje Y.
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• Ejercicio impacto Beer 17_111.
En el contacto podemos elegir el coeficiente de 
reconstitución (e).

El contacto de da entre las dos 
partes móviles. Ponemos que el 
Restitution coefficient es de 1 en 
este caso.
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• Ejercicio impacto Beer 17_111.
Ahora ya podemos calcular el movimiento. Una vez calculado podemos 
graficar la velocidad de la barra para ver el resultado.
vC(e=1)=857.7mm/s,  vC(e=0.4)=600.2mm/s, vC(e=0)=428.86mm/s 

Los resultados de la simulación concuerdan con lo analíticos si (a) e=1, 
(b) e=0.4, (c) e=0.Univ
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• Ejercicio equilibrado Beer 18_063.
Un disco de 4 [kg] está montado con un ángulo de 20º y 
gira a 10[rad/s]. Dar reacciones en apoyos.

Las inercias respecto ejes xyz' son: Iy'=Iz'=mr2/4, Ix'=mr2/2

La velocidad angular es: =(cos,-sin,0) [rad/s]

x'

y'

Se calcula HGxyz'=(Ix'x', Iy'y', Iz'z')=(0.5mr2cos,-0.25mr2sin,0) [kg·m2/s] 

Se calcula H'Gxyz'=0+(cos,-sin,0)x(0.5mr2cos,-0.25mr2sin,0)=
(0,0, 0.25mr22sincos) [N·m] 

Como el centro de gravedad está en el eje vg=0, ag=0
F=ma  (Ax,Ay,Az)+(Bx,By,Bz)=0, 
Mg=H'G
 (-a,0,0)x(Ax,Ay,Az)+(a,0,0)x(-Ax,-Ay,-Az)=(0,2aAz,-2aAy)=(0,0, 0.25mr22sincos)
 A=(0,1.9,0), B=(0,1.9,0) [N] que rotan con el disco y por lo tanto oscilan en A y B.
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• Ejercicio equilibrado Beer 18_063.
Abrimos el archivo Beer_18_063.SLDASM y empezamos el Motion Study 1.

Lo primero que debemos hacer es poner un motor que gire a 10 rad/s (95.5 
rpm).
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• Ejercicio equilibrado Beer 18_063.
Calculamos y graficamos las fuerzas de reacción en el eje Y en el apoyo A y 
B.

Los resultados calculados analíticamente y los simulados concuerdan.
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• Resumen.
 Optimización geometría.

 Uso SW Motion para calcular velocidades, energía y fuerzas de reacción.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S13t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 73

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S13t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 74

• Proyecto.
Continuar con el proyecto. 
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• Repaso última sesión.
 Cinemática y cinética con SolidWorks.
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• Calcular expansión térmica. 
Al introducir el tema de deformaciones térmicas éstas se suman a las mecánicas. 
Lo primero a definir son las propiedades térmicas del material. Si usamos un 
prisma sólido y le aplicamos las propiedades de acero vemos el coeficiente de 
expansión térmico definido. El resto de propiedades las definimos dentro de la 
solución estática.
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• Aplicar temperatura. 
Una vez que tenemos definidas las propiedades del material 
podemos pasar a definir las condiciones de temperatura inicial 
desde “Environment”. Por defecto la temperatura ambiente es de 20 
ºC (293,16 K). Para hacer un caso sencillo aplicaremos una 
expansión libre y luego evitaremos que expanda en su longitud.

h’

L’L

h

b’
b

TLLL  '
Libre

TEz  
Restringido
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• Comprobación dilatación libre y restringida. 
Comprobamos que el cálculo coincide con la teoría.

R
es

tri
ng

id
o

Li
br

e 





?

T i K 293,16

b mm 20
t mm 10

L mm 100
E N/mm2 200000
 kg/m3 7860
T K 100

 kJ/(kg K) 1,11
 K-1 1,17E-05
z= ET N/mm2 234

L’-L= TL mm 1,17E-01
t’-t=Tt mm 1,17E-02
b’-b=Tb mm 2,34E-02
En=m T Nmm 17449,2

Dilatación acero


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• Cálculo compuesto de carga a temperatura. 
Si a la carga de temperatura le añadimos una carga 
estática el resultado de deformaciones y energías 
ha de ser la suma de los dos casos.

T i K 293,16

b mm 20
t mm 10

L mm 100
E N/mm2 200000
 kg/m3 7860
T K 100

 kJ/(kg K) 1,11
 K-1 1,17E-05
z= ET N/mm2 234

L’-L=TL mm 1,17E-01
t’-t=Tt mm 1,17E-02
b’-b=Tb mm 2,34E-02
En=m T Nmm 17449,2

Dilatación acero

b mm 20

t mm 10
L mm 100

E N/mm2 200000

  0,26
Fz N 50000
z=F z /bt N/mm2 250
L’-L=LF z /btE. mm 0,125
b’-b=- bF z /btE. mm -0,0065
En=LF z

2 /btE2 Nmm 3125

TRACCION





La energía la calcula mal ya que 
está multiplicando la fuerza por la 
deformación total y la deformación 

térmica ya considerada.Univ
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• Cálculo de ensamblajes. 
Como ejemplo práctico vamos a ver un ensamblaje de dos materiales. Si no 
ponemos una restricción entre caras dentro del cálculo los materiales se ignorarán 
penetrando uno en el otro libremente.

ac
er

o
al

um
in

io

L a
’

L a

L s
’

L s

T i K 293,16 T i K 293,16

b mm 20 b mm 20
t mm 10 t mm 10

L mm 100 L mm 100
E N/mm2 200000 E N/mm2 70000
 kg/m3 7860  kg/m3 2710
T K 100 T K 100

 kJ/(kg K) 1,11  kJ/(kg K) 1,11
 K-1 1,17E-05  K-1 2,36E-05
z= ET N/mm2 234 z= ET N/mm2 165,2

L’-L=TL mm 1,17E-01 L’-L=TL mm 2,36E-01
t’-t=Tt mm 1,17E-02 t’-t=Tt mm 2,36E-02
b’-b=Tb mm 2,34E-02 b’-b=Tb mm 4,72E-02
En=mT Nmm 17449,2 En=m T Nmm 6016,2

Dilatación acero Dilatación aluminio
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• Hacer conexiones.
Para evitar que una pieza se expanda evitando otra hay que definir las conexiones 
entre piezas dentro del cálculo y no sólo en el ensamblaje. 

 

 













































































ss

a

as

s

ss

saass
ss

a

a

s

s

aass
s

as

aass

a
z

a
a

s
s

s
s

TL

E
LE

E
LE

TLLLL

E
L

E
L

TLL

LL

T
E

T
E













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• Explosión de imágenes de resultados.
Podemos explosionar todas las imágenes activas para ver los resultados 
obtenidos. 
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• Posibilidades de uniones en Catia.
Hay muchas posibilidades a la hora de definir las uniones y se ha de dedicar 
mucho tiempo a hacer las uniones de la manera más realista. 
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• Ejemplo de dilataciones en parachoques.
Como hemos visto el problema de dilataciones es más visible en piezas grandes. 
Un ejemplo en automoción son los parachoques, piezas muy largas de un material 
que se dilata mucho más que el acero provocando desenrases en caliente. 

pl
ás

tic
o

ac
er

o

Hay que jugar con las fijaciones

para disminuir desenrases 

en extremos.
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• Fijaciones con coliso.
Si las fijaciones del parachoques las hacemos con un coliso para permitir que se 
dilaten evitaremos que se abombe el parachoques en la zona central. 

D
es

pl
az

am
ie

nt
os

 x
10

 p
ar
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se

r v
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ib
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• Resumen.
 Dilataciones térmicas.

 Uniones soldadas.
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• Expansión Térmica.
Un cuerpo al expandirse o dilatarse genera unas tensiones que 
dependen de la temperatura a la que se encuentra el material, la 
del ambiente y, por supuesto, del material de ésta.

Ti K 298
b mm 10
h mm 20
L mm 100
E N/mm^2 200000
δ kg/m^3 7.9
m kg 1.58E‐01
ΔT K 100
β J/(kgK) 420
α K‐1 1.50E‐05
Fz N 50000

σz N/mm^2 300.00
L'‐L mm 1.50E‐01
h'‐h mm 3.00E‐02
b'‐b mm 1.50E‐02
En Nmm 19775.28
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• Expansión Térmica. 
Al introducir la temperatura las tensiones generadas por ésta se suman a las 
mecánicas.

Para realizar estos estudios en SW es necesario primero hacer un estudio térmico 
y posteriormente uno de tensiones.

Primero realizamos el estudio térmico con una temperatura de 125ºC.
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• Expansión Térmica. 
Ahora al realizar el nuevo cálculo de estática, no ponemos ninguna carga pero en 
las propiedades del estudio si que ponemos que la Temperatura la lea del estudio 
térmico hecho anteriormente. Fijaros que la temperatura de referencia es de 
25ºC, por eso hemos puesto en el estudio anterior una temperatura de 125ºC.
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• Resultados dilatación libre. 
Las tensiones deberían dar 0 pero con una α de 5e-5 el error es aceptable..
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• Resultados dilatación libre. 
Las deformaciones se puede ver que dan prácticamente exactas.

b’-b=1.5e-2 h’-h=3.0e-2 L’-L=1.5e-1
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• Fuerza y temperatura. 
Si añadimos una fuerza las deformaciones resultantes han de ser la suma de 
los dos efectos. Al realizar la tracción la biga se comprime por lo que en la 
dirección de b y de h es una resta y no una suma.

Temp Fuerza Total
L'‐L mm 0.15 0.125 0.275
h'‐h mm 0.03 0.00725 0.02275
b'‐b mm 0.015 0.003625 0.011375
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• Resultados dilatación restringida. 
Realizamos un mismo estudio pero esta vez restringiendo la dilatación en el 
la dirección de L. Podemos ver que al no dejar dilatarla biga se generan 
tensiones,
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• Ensamblaje. 
Vamos a realizar el mismo estudio de dilatación térmica pero en un 
ensamblaje con dos bigas de distintos material. Una de AISI 1020 y la otra 
de aluminio 1060.
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• Ensamblaje. 
Los resultados analíticos vienen dados por este sistema de ecuaciones.
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• Ensamblaje. 
Los resultados son los siguientes.

AISI 1020 1060 Alloy
Ti K
b mm
h mm
L mm
E N/mm^2 200000 69000
δ kg/m^3 7900 2700
ΔT K
β J/(kgK) 420 900
α K‐1 1.50E‐05 2.40E‐05

298
10
20
100

100

num1 0.39
σ1020 ‐200.07
σ1060 200.07

L1020'‐L1020 5.00E‐02
L1060'‐L1060 ‐5.00E‐02
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• Ensamblaje. 
Abrimos un estudio térmico y, dentro de él, asignamos a una de las dos 
bigas la aleación de aluminio 1060 Alloy.

Debemos definir conexiones ya que sino las dos bigas se ignorarán.
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• Ensamblaje. 
Utilizamos la opción Automatically find contact
sets dónde sólo debemos seleccionar los 
componentes y clicar en Find Faces.

Una vez encontrada la conexión la añadimos.
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• Ensamblaje. 
Ponemos la carga que, como antes es una temperatura de 125ºC en todas las 
caras. Mallamos y lanzamos el cálculo.
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• Ensamblaje. 
Ahora creamos otro estudio estático, ponemos en cada viga el mismo material 
que en el estudio anterior. 
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• Ensamblaje. 
Ponemos las restricciones para cada viga y la carga térmica del estudio 
anterior. 
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• Ensamblaje
Aquí, como antes, también debemos definir el contacto o conexión entre las dos 
bigas. Ésta vez debemos poner una conexión rígida para que así las dos bigas se 
hacen rígidas y están forzadas a moverse conjuntamente.
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• Cálculo.
Ya podemos mallar y lanzar el cálculo.
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• Resultados.
Vemos que los resultados concuerdan con los calculados.
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• ESTUDIO TÉRMICO. 
Se pretende estudiar el efecto de juntar un material a una temperatura con otro y ver como se 
intercambian el calor.

Primero se estudiará el caso en que la temperatura de aire en un lado es superior al toro con 
convección y conducción. En un segundo caso se añadirá la resistencia térmica de contacto 
entre sólidos. En un tercer caso se plantea un transitorio en que el material caliente se enfría 
calentando al otro. Finalmente se intentará refrigerar el molde con agua fría para evacuar 
calor. Para el problema se estudia el material de botellas de detergente HDPE a la 
temperatura de transformación de 186ºC y el material para hacer el molde en la impresora 3D 
denominado ULTEM que es un PEI que de inicio está a temperatura ambiente de 21ºC.

El aire en el lado HDPE está a Ti=186º y el aire en zona ULTEM a To=21º (T=165ºC)

Las dimensiones de area son 0.1x01=0.01m2.

Los espesores de HDPE son L1=0.003[m] y de PEI-ULTEM L2=0.020[m].
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• CONDUCCIÓN + CONVECCIÓN. 
El flujo de calor es q’=A(Ti-To)/(1/hi+L1/k1+R12+L2/k2+...+1/ho)
Como sabemos que:
A=area 0.01m2.
hi, ho son el coeficiente de convección del aire en reposo puede variar entre 3 y 23 W/(m2ºC) 
según su humedad los valores mas elevados corresponde a las mayores humedades. El del 
aire en movimiento puede variar entre 10 y 100 W/(m2ºC). Pondré en la cara caliente 5 y en la 
fría 20
L1 es la longitud del HDPE que es de 3mm
k1 es la conductividad de HDPE que es de 0.461 W/(mºC)
L2 es la longitud del ULTEM de 20mm
k2 es la conductividad de HDPE que es de 0.220 W/(mºC)
Se resuelve q'=4.791W
Cada tramo se resuelve 
q'=A(Ti-T1i)hi por lo que T1i es 91.01[ºC]
q'=A(T1i-T12)k1/L1 por lo que la temperatura en el HDPE cae a 87.9[ºC]
q'=A(T21-T2o)k2/L2 por lo que la temperatura en el ULTEM cae a 44.74[ºC]
q'=A(T2o-To)ho por lo que se comprueba que la temperatura de aire da 21[ºC] como supuesto 
inicialmente

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S14t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 35

• CONDUCCIÓN + CONVECCIÓN. 
INPUTS in‐entrada Ti [ºC] 186

hi [W/(m^2K)] 5
out‐salida To [ºC] 21

ho [W/(m^2K)] 20
area A [m^2] 0.01
1‐HDPE L1 [m] 0.003

k1 [W/(mK)] 0.461
12‐resistenciR12 [(m^2K)/W] 0
2‐ULTEM‐PEI L2 [m] 0.02

k2 [W/(mK)] 0.22

OUTPUTS q' [W] 4.74934014
X[m] T_sin_R[ºC]

‐0.003 186
‐0.002 186
‐0.001 186

0 q'=A(Ti-T1i) T1i [ºC] 91.0131971
0.003 q'=A(T1i-T12T12 [ºC] 87.9225202

0.00301 q'=A(T12-T2T21 [ºC] 87.9225202
0.023 q'=A(T21-T2T2o [ºC] 44.7467007

Check 0.024 q'=A(T2o-ToTo [ºC] 21
0.025 21
0.026 21
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• CONDUCCIÓN + CONVECCIÓN. 
INPUTS in‐entrada Ti [ºC] 186

hi [W/(m^2K)] 5
out‐salida To [ºC] 21

ho [W/(m^2K)] 20
area A [m^2] 0.01
1‐HDPE L1 [m] 0.003

k1 [W/(mK)] 0.461
12‐resistenciR12 [(m^2K)/W] 0
2‐ULTEM‐PEI L2 [m] 0.02

k2 [W/(mK)] 0.22

OUTPUTS q' [W] 4.74934014
X[m] T_sin_R[ºC]

‐0.003 186
‐0.002 186
‐0.001 186

0 q'=A(Ti-T1i) T1i [ºC] 91.0131971
0.003 q'=A(T1i-T12T12 [ºC] 87.9225202

0.00301 q'=A(T12-T2T21 [ºC] 87.9225202
0.023 q'=A(T21-T2T2o [ºC] 44.7467007

Check 0.024 q'=A(T2o-ToTo [ºC] 21
0.025 21
0.026 21
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• CONDUCCIÓN + CONVECCIÓN+RESISTENCIA. 
Si añadimos una resistencia de contacto térmico podemos ver como varían los perfiles de 
temperatura. El problema es encontrar el valor de esta resistencia térmica. 

En la literatura se encuentran valores para circuitos electrónicos de 0.02 [m²K/W] hasta 
pequeñas resistencias de 0.0001 [m²K/W].

Si hacemos el número teórico y la simulación con el valor más alto de resistencia mayorado a 
0.05 [m²K/W] tenemos:  INPUTS in‐entrada Ti [ºC] 186 186

hi [W/(m^2K)] 5 5
out‐salida To [ºC] 21 21

ho [W/(m^2K)] 20 20
area A [m^2] 0.01 0.01
1‐HDPE L1 [m] 0.003 0.003

k1 [W/(mK)] 0.461 0.461
12‐resistenciR12 [(m^2K)/W] 0 0.05
2‐ULTEM‐PEI L2 [m] 0.02 0.02

k2 [W/(mK)] 0.22 0.22

OUTPUTS q' [W] 4.74934014 4.15181363
X[m] T_sin_R[ºC] T_con_R[ºC]

‐0.003 186 186
‐0.002 186 186
‐0.001 186 186

0 q'=A(Ti-T1i)hT1i [ºC] 91.0131971 102.963727
0.003 q'=A(T1i-T12T12 [ºC] 87.9225202 100.261896

0.00301 q'=A(T12-T2T21 [ºC] 87.9225202 79.5028284
0.023 q'=A(T21-T2T2o [ºC] 44.7467007 41.7590681

Check 0.024 q'=A(T2o-ToTo [ºC] 21 21
0.025 21 21
0.026 21 21
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• CONDUCCIÓN + CONVECCIÓN+RESISTENCIA. 

INPUTS in‐entrada Ti [ºC] 186 186
hi [W/(m^2K)] 5 5

out‐salida To [ºC] 21 21
ho [W/(m^2K)] 20 20

area A [m^2] 0.01 0.01
1‐HDPE L1 [m] 0.003 0.003

k1 [W/(mK)] 0.461 0.461
12‐resistenciR12 [(m^2K)/W] 0 0.05
2‐ULTEM‐PEI L2 [m] 0.02 0.02

k2 [W/(mK)] 0.22 0.22

OUTPUTS q' [W] 4.74934014 4.15181363
X[m] T_sin_R[ºC] T_con_R[ºC]

‐0.003 186 186
‐0.002 186 186
‐0.001 186 186

0 q'=A(Ti-T1i)hT1i [ºC] 91.0131971 102.963727
0.003 q'=A(T1i-T12T12 [ºC] 87.9225202 100.261896

0.00301 q'=A(T12-T2T21 [ºC] 87.9225202 79.5028284
0.023 q'=A(T21-T2T2o [ºC] 44.7467007 41.7590681

Check 0.024 q'=A(T2o-ToTo [ºC] 21 21
0.025 21 21
0.026 21 21
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• TRANSITORIO. 
Antes de iniciar el transitorio vamos a simplificar para una pieza.
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• TRANSITORIO. 
Si resolvemos la integral tenemos una expresión siguiente.

q’=2A(T-To)/(1/h)= -cp*m*T/t  ln((T-To)/(Tini-To))=-2Aht/(mcp) 

T=To +(Tini-To)exp(-2Aht/(mcp))

A los 320 segundos (5minutos y 20 segundos) tenemos una temperatura de 109.4ºC.
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• TRANSITORIO. 
Antes de iniciar el transitorio se va a poner cada pieza a su temperatura.
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• TRANSITORIO. 
Si realizamos el transitorio vemos que en 320[segundos] la temperatura ha bajado unos 
110ºC grados en el HDPE con thermal resistance 0.05 y unos 135 ºC con thermal resistance
5e-7[m²K/W]. Queda pendiente elaborar estrategia para verificar.
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• FOTOS DE ENSAYOS REALES. 
.
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• Resumen.
 Distribución de temperaturas.

 Cálculo de las tensiones en dilataciones.

 Cálculo de ensamblajes y utilización de conexiones.

 Cálculo de conducción y convección con transitorios.
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• X.
x.
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Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S15t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 2

• Repaso última sesión.
 Dilataciones térmicas.
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• Help CosmosWorks online.
Si activamos la licencia de SolidWorks Simulation podemos acceder a sus 
tutoriales. En este caso los que nos interesa son los Nonlinear.
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• No linealidades.
Hay tres tipos principales de no linealidades:

 Largos desplazamientos: La geometría varía y por tanto F=k*x se ha de recalcular 
con una nueva matriz de rigidez "k" ya que ha variado la forma.

 No linealidad de material:

• No lineal elástico en que el material sigue un comportamiento como por 
ejemplo F=k*x2 pero al retirar la fuerza no hay deformaciones permanentes. 

• No lineal con deformación permanente. La deformación permanente puede ser 
origen de plasticidad o defromación de fluencia a temperatura (creep).

 Contactos. Al iniciar el contacto se generan unas fuerzas que no existían con 
anterioridad.

En todos los casos es necesario ir iterando para rehacer la matriz de rigidez en cada 
nueva situación.
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• Pequeños desplazamientos
Creamos una biga de 10x20mm de sección y la 
extruimos 100mm. Le aplicamos el material AISI 
1010 Steel, hot rolled bar.
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• Pequeños desplazamientos
Le aplicamos un desplazamiento de 10 mm 
a la cara superior y lanzamos el cálculo.

Nos aparece un Warning que nos dice que 
hay desplazamientos excesivos por lo que 
recomienda utilizar el cálculo con largos 
desplazamientos le decimos que no para 
seguir con el estudio con desplazamientos 
pequeños.
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• Pequeños desplazamientos
Con éste calculo los resultados que nos da son los siguientes:

=U/L=10/100=0.1 OK=E=2.e5*0.1=2e4MPa OK F=A=2.e4*200=4e6N OKUniv
ers

ity
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• Largas deformaciones.
Activamos las grandes deformaciones en las propiedades del estudio estático. 
Podemos ver que el resultado es diferente debido a que la deformación de la 
biga es muy grande. Aplicando esta fuerza la biga se alarga 10 mm por lo que la 
longitud final es de 110mm (un aumento de un 10%) al haber este aumento la 
sección varia y por lo tanto F/A también ha variado.
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• Largas deformaciones.
Con éste calculo los resultados que nos da varían de los anteriores, debido a la 
matriz de rigidez. 

=ln(1+U/L)=ln(1+10/100)
=0.0953 OK

=E=2.e5*0.0953
=1.906e4MPa OK

F=A*(1-z)2 =1.906e4*200*
(1-0.29*0.0953)2=3.461e6N OKUniv

ers
ity
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• Plasticidad.
Lo primero que vamos a hacer es comprobar el cálculo no lineal de una barra a 
tracción. Primero hacemos un cálculo lineal aplicando 0.131[mm] de 
desplazamiento para comprobar que las tensiones están por encima de fluencia.
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• Plasticidad.
Realizamos un estudio no lineal sobre la misma biga pero esta vez editaremos el 
material.
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• Plasticidad
Editamos el 
material.
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• Plasticidad
Realizamos un cálculo aplicando 0.1mm de desplazamiento, o sea, 0.1% de 
deformación.

2=1+E2*(2-1/E1)=180+20000*(0.001-180/200000)=182[MPa]
F=A=182*200=3.64e4[N]
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• Plasticidad.
Lo repetimos con 10mm (10%) el resultado esperado es (sin largos 
desplazamientos, hay que desactivar el cálculo en propiedades): 
2=1+E2*(2-1/E1)=180+20000*(0.1-180/200000)=2162[MPa]
F=A=2162*200=4.32e5[N]
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• Plasticidad.
Con largos desplazamientos
2=1+E2*(2-1/E1)=180+20000*(ln(1+10/100)-180/200000)=2068[MPa] 
y la fuerza F=A=2068*200/(1+U/L)=3.76e5[N] Ahora el error es mayor.
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• Plasticidad.
Para mejorar los resultados modificamos 
las las propiedades del calculo..
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• Plasticidad.
Ahora los resultados si que son correctos.

2=1+E2*(2-1/E1)=2068[MPa] F=A=3.76e5[N] Univ
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• Plasticidad.
Podemos graficar los resultados.
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• Incluir caso no lineal por 
plasticidad.
Editamos el material y le damos la 
parte plástica. Por ejemplo podemos 
dar una segunda pendiente 
E2=0.9e11 N/m2.
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• Incluir caso no lineal por plasticidad.
Por lo tanto ahora al aplicar el mismo desplazamiento 2=0.131/100=1.31e-3 se 
obtendrá la siguiente tensión:
2-1=E2*(2-1)  2=1+E2*(2-1/E1)=180e6+0.9e11*(1.31e-3 -180e6/2e11)=
2.16e8 N/m2.
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• Introducir curva material.
Otra posibilidad es introducir la curva de material para ver mejor el comportamiento.
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• Introducir curva material.
Otra posibilidad es introducir la curva de material para ver mejor el comportamiento.

Plástico-pendiente Plástico-curvaUniv
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• Cálculos sencillos de fluidos
Con SolidWorks tenemos la posibilidad de usar FloXpress… Primero abrimos el 
arhchivo tubo_tapa.SLDPRT del cual haremos el estudio de dinámica de fluidos.
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• Cálculos sencillos de fluidos
FloXpress nos pide que el elemento a estudiar tenga la entrada y la salida tapadas 
por lo que las taparemos. Posteriormente pondremos la pieza transparente para 
así poder visualizar mejor los resultados.
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• Cálculos sencillos de fluidos
Activamos la herramienta FlowXpress y seguimos los pasos.

Se ha impuesto un caudal de 0.1 m3/s en una sección de diámetro 50mm. La 
velocidad media de entrada es: 0.1/(π*0.0502/4)=50.92[m/s].

La salida tiene un diámetro de 25mm por lo que se espera cuadriplicar la velocidad 
hasta 203.70[m/s]. 
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• Cálculos sencillos de fluidos
El resultado se puede considerar correcto ya que con esta herramienta solo 
podemos hacer pequeñas aproximaciones.
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• Cálculos de fluidos
Para realizar cálculos buenos de fluidos utilizaremos la herramienta SolidWorks 
Flow Simulation 2010 que hay que activar.

Si hay algún problema con la licencia seguid los pasos que hay en el link siguiente: 

http://symsolutions.com/wordpress/2010/04/network-solidworks-flow-simulation/
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• Cálculos de fluidos
Abrimos un nuevo proyecto pero utilizaremos el Wizard.. Que nos ayudará a 
preparar el càlculo. Seguimos los pasos para configurar el cálculo.
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• Cálculos de fluidos
Unidades, tipo de cálculo, fluido, etc…
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• Cálculos sencillos de fluidos
Una vez realizado el Wizard debemos poner lar condiciones de entrada y salida.
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• Cálculos sencillos de fluidos
Ejecutamos el cálculo. Podemos ver graficas mientras se va ejecutando el cálculo.
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• Resumen.
 Cálculos no lineales con CosmosWorks.

 Cálculo de fluidos con FlowExpress y FlowWorks.
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• Entregable.
Realizar el refuerzo de espesor ER si disponemos de un espacio H para la chapa y 
el refuerzo. El refuerzo tiene en la aleta soldada unos 50mm y la zona inferior unos 
100 a los bordes de la chapa. Calcular las frecuencias libres y empotrando la 
chapa en el extremo con el que se hizo el barrido.
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• Proyecto.
Continuar con el proyecto modificando ligeramente la varilla para poder hacer la 
rótula. 
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S16t.- Ergonomía con Catia.
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• Repaso última sesión.
 Estudios de simulación no lineal y de fluidos con SolidWorks.
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• Ergonomía. 
Una herramienta básica en diseño es la comprobación de que el producto es 
adecuado para el consumo humano. Por ello vamos a ver una introducción a 
temas de ergonomía.
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• Crear un modelo humano “manikin”. 
Lo primero que haremos al empezar el módulo es crear nuestro modelo. 
Como es un ensamblaje hay que seleccionar el “Product” en que 
insertamos el “manikin”.
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• Visualización de los modelos humanos “manikin”. 
Es importante saber cambiar la visualización para no cargar la tarjeta gráfica.
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• Guardar el “manikin”. 
Para guardar el modelo humano basta con guardar el producto.
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• Ensamblar modelos. 
Una vez guardados los modelos podemos montarlos en un “product” como en un 
ensamblaje de piezas.
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• Árbol de un “manikin”. 
Podemos abrir el árbol de un modelo humano para entender sus partes y luego 
poder manipularlas.
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• Visión del “manikin”. 
Una de las cosas que se suele comprobar es el campo de visión del “manikin”. 
Para ello hacemos doble click en “vision” en el árbol del “manikin”. Por ejemplo se 
suele comprobar al diseñar un parabrisas que se puede ver un semáforo´colocado 
a una altura determinada.
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• Cambio dimensiones “manikin” respecto percentil. 
Una posibilidad es diseñar un producto para cumplir con parámetros de persona no 
Standard. Para ello podemos editar algunas variables.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S16t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 11

• Modificar la postura. 
Por defecto el modelo se crea de pie. La primera modificación es sentar el modelo.
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• Mover partes del modelo. 
Podemos editar la postura con “Foreward Kinematics” para por ejemplo poner las 
manos en el volante o coger un objeto.
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• Usar ajuste de posición “reach”. 
Una manera rápida de conseguir una posición es con el comando “reach”. Para 
este ejemplo usaremos el tutorial : “Reach.CATProduct” (usa los ficheros 
“box.CATPart” y “ManReach.CATProduct”.
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• Posiciones comunes. 
Hay posiciones comunes guardadas en el programa.
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• Análisis de los modelos. 
Algo muy común es mirar a que distancia a quedado nuestro modelo de algún 
componente. Por ejemplo en automoción se mira la distancia de la cabeza del 95 
percentil al techo, de las rodillas al tablero, del hombro a los montantes . . .
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• Detección de interferencias. 
Algo muy común es mirar si cabe la mano en un hueco. Para mirar si el modelo 
está bien ubicado se mira si hay penetraciones “clash”.
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• Informe sobre nuestro “manikin”. 
Podemos crear un informe “report” sobre nuestro modelo.
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• Realizar ejercicio examen febrero curso 2007-2008. 
Completar el fichero EXF-Ej09.CATProduct para sentar un hombre 50% francés de manera 
que toquen los pies el suelo, se apoye en la base y respaldo de silla de manera que si 
detectamos penetraciones "clash" todas estén por debajo de 5mm:

FININICIO

Anotar la distancia del punto H al suelo aquí:

...... mmTiempo  ..min.Univ
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• Realizar ejercicio examen septiembre curso 2007-2008. 
Completar el fichero EXJ-Ej09.CATProduct para coger 
el vaso con una mano sin tener "clash", tan sólo 
contacto entre dedos y vaso.

FININICIO

Anotar la distancia entre pulgar e índice aquí:
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• Resumen.
 Introducción al módulo de ergonomía.

 Creación de modelos humanos de diferentes tamaños y en diferentes 
posiciones.
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• Entregable.
Diseñar una butaca de metro 
para sentar un hombre del 95% 
y mujer del 5% americano de 
manera que toquen los pies en 
el suelo y tengan una 
interferencia de 5mm con culo y 
respaldo.
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• Proyecto.
Continuar con el proyecto haciendo ergonomía y molde. 
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• Proyecto.
Para el molde lo hacemos sencillo. 
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• Resumen de puntuación alcanzada.
0.20 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.35 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
1.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.50 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.30 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
0.50 de 1.00 0.5 Moldes de carcasa anterior + 0.5 costing (S).
0.50 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.50 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
5.45 de 13.00 Total
3.5 horas de dedicaciónUniv
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S17t.- Costes CNC y doblado chapa con SW.
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• Repaso última sesión.
 Estudios de ergonomía en Catia.
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• Exportar chapa y molde de Catia a SolidWorks.
Para poder hacer el análisis en SolidWorks vamos a exportar la chapa y el molde 
desde Catia usando el fichero de intercambio STEP. En el caso de no tener el 
molde hecho exportamos la carcasa y hacemos el molde en SolidWorks.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S17t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 4

• Trabajar el informe de la chapa doblada.
Importamos la chapa y analizamos que la podemos 
desdoblar. Pasamos a realizar el informe de costes 
siguiendo el tutorial de costes de chapa doblada para 
intentar ahorrar costes tomando alguna decisión.
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• Informe comparando costes al cambiar un parámetro.
Realizamos un informe de costes cambiando un parámetro como material.
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• Informe comparando costes al cambiar un parámetro.
.
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• Trabajar el informe de la molde.
Importamos el molde o el caso de no tenerlo la carcasa 
y le hacemos el molde. Analizamos los costes con el 
tutorial de costes de mecanizado para intentar tomar 
alguna decisión de ahorre de costes en nuestro diseño.
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• Informe costes molde cambiando un parámetro.
Necesitamos fabricar un solo molde para inyectar 50000 piezas (100000 chapas 
pues es la misma chapa izquierda que derech)a. Podemos hacer el coste molde 
por pieza.
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• Informe costes molde cambiando un parámetro.
Repetimos para la otra mitad de molde.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S17t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 10

• Resumen.
 Introducción al tema costing en SolidWorks realizando el tutorial tanto de moldes 
como de doblado de chapa usando para ejemplo las piezas de proyecto.
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• Entregable.
A partir de fichero “Carcasa_anterior_new.stp” realizar el molde en solidWorks y los 
costes de las dos mitades suponiendo tamaños siguientes. 
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• Proyecto.
Continuar con el proyecto. Se aprovecha el tema de haber hecho los moldes y el 
costing de molde y doblado de chapa para el proyecto. Con lo aprendido en la 
clase anterior se monta un ensamblaje de la moto a escala. 
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• Resumen de puntuación alcanzada.
0.20 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.35 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
1.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
0.50 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.50 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
1.00 de 1.00 0.5 Moldes de carcasa anterior ó espejo + 0.5 costing (S).
1.00 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.50 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
6.65 de 13.00 Total
4.0 horas de dedicaciónUniv

ers
ity

 C
op

y F
or 

Lib
rar

y U
se



S18t.- Impacto medioambiental con SW.
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• Repaso última sesión.
 Estudios de costes de CNC y doblado de chapa con SW.
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• Impacto ambiental.
Un estudio cada vez más necesario de un producto es el de su impacto 
medioambiental bajo el concepto de diseño sostenible. Para ello realizaremos el 
estudio en SolidWorks. Compararemos lo que se pide en el proyecto que es la 
goma utilizando varias localizaciones de producción y venta. Luego usaremos un 
ensamblaje para analizar como es el impacto ambiental.
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• Letras SW.
Para acabar el temario se presenta la 
posibilidad de adjuntar un logo o 
calcomanía al 3D. En SolidWorks además 
podemos escribir el nombre de manera 
fácil en las piezas.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S18t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 5

• Letras Catia.
En Catia el proceso es complejo.

1.- Escribir texto en un drawing y guardar 
como DXF.
2.- Abrir DXF y seleccionar texto copiar.
3.- Pegar el texto en el croquis de pieza a 
cortar.
4.- Crear offset de superficie a cortar.
5.- Cortar hasta esa superficie.
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• Logo SW.
Para el tema de calcomonía en SolidWorks hay que activar PhotoView e ir a 
Render Tools.

Univ
ers

ity
 C

op
y F

or 
Lib

rar
y U

se



IPAO S18t

Andrés García, andres.garcia@iqs.url.edu ,Vía Augusta, 390 – 08017. Barcelona. (+34) 932 672 000-ext.283 F. (+34)932 056 266 P. 7

• Logo Catia.
Para el tema de calcomonía en Catia si no 
recuerdas el Workbench pero recuerdas la orden 
la puedes teclear en la ventana inferior. El 
problema es que has de estar en un ensamblaje 
para poder hacerlo.
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• Proceso mecanizado SW.
Finalmente para tener todos los puntos de proyecto explicamos el proceso de 
mecanizado.
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• Proceso mecanizado Catia.
En Catia se puede hacer con BODIES copiados con link para ir definiendo el 
proceso. La dificultad es ponerlo en el plano. Se puede hacer bloqueando vistas de 
bodies o haciendo piezas extra de cada operación.
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• Resumen.
 Introducción al tema de impacto medioambiental con SolidWorks.
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• Entregable.
Realizar una superficie de espesor 10mm y colocar por un lado una foto de un logo 
y por el otro un grabado de texto. 
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• Proyecto.
Continuar con el proyecto. Se procede a hacer la simulación de inyección de 
plástico de la carcasa y a hacer el proceso de mecanizado de la varilla. 
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• Proyecto.
Continuar con el proyecto. Se procede a hacer la simulación de inyección de 
plástico de la carcasa y luego el proceso de mecanizado de la varilla. 
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• Resumen de puntuación alcanzada.
0.20 de 1.00 CD y papel presentación del documento con poster en A3.
0.50 de 0.50 Espejo como croquis.
0.50 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta.
1.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S).
1.00 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S)..
0.50 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo
1.00 de 1.00 0.5 Moldes de carcasa anterior ó espejo + 0.5 costing (S).
1.00 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S).
0.50 de 0.50 Ergonomía (C)
0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones.
0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones.
0.00 de 0.50 Logo empresa moto pegado en carcasa.
0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas. 
0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado.
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
0.00 de 0.50 Módulo extra no explicado en clase 
7.30 de 13.00 Total
5.5 horas de dedicaciónUniv
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S19t.-(SW) y S20t.-(Catia) Ejercicios de repaso. 
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• Repaso última sesión. 

 Estudios de impacto medioambiental con SW, creación de logos y renderizados, 

letras de marcado y proceso de mecanizado para finalizar el temario. 

 

 

Estas diapositivas son para dos sesiones resolviendo es un examen de años 

anteriores en que se realiza en la primera sesión con SolidWorks y en la segunda 

con Catia. 
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Ojo! Puede ser que con Catia no sepáis dar el par máximo! Univ
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• Resumen. 

 Ejercicios de repaso. 
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• Proyecto. 

Continuar con el proyecto.  
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• Resumen de puntuación alcanzada. 
0.20 de 1.00 CD y papel presentación del documento con poster en A3. 

0.50 de 0.50  Espejo como croquis. 

0.50 de 0.50 0.2 Varilla con 0.15 proceso mecanizado y 0.15 cálculo fuerza en la punta. 

1.00 de 1.00 0.5 Goma tipo fuelle + 0.5 estudio medioambiental(S). 

1.00 de 1.00 0.5 Carcasa espejo con desmoldeo + 0.5 inyección(S).. 

0.50 de 1.00 0.5 Carcasa anterior + 0.5 como nube de puntos y desmoldeo 

1.00 de 1.00 0.5 Moldes de carcasa anterior ó espejo + 0.5 costing (S). 

1.00 de 1.00 0.5 Chapa doblada y desdoblada + 0.5 costing (S). 

0.50 de 0.50 Ergonomía (C)  

0.20 de 0.50 Tornillos, tuercas y piezas normalizadas para las uniones. 

0.00 de 1.50 Cálculo 0.5 aerodinámica, 0.5 vibraciones y 0.5 dilataciones. 

0.00 de 0.50 Logo empresa moto pegado en carcasa. 

0.20 de 0.50 Ensamblaje sin interferencias excepto elementos deformables/roscas cosméticas.  

0.70 de 1.00 0.5 Planos de todas las piezas, 0.25 lista materiales y 0.25 explosionado. 

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

0.00 de 0.50 Módulo extra no explicado en clase  

7.30 de 13.00 Total 

5.5 horas de dedicación 
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